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Title Page

Rosemount™ 3308 Series Wireless
Guided Wave Radar Level Transmitter

NOTICE

Read this manual before working with the product. For personal and system safety, and for optimum
product performance, make sure you thoroughly understand the contents before installing, using, or
maintaining this product.

For technical assistance, contacts are listed below:
Customer Central

Technical support, quoting, and order-related questions.
United States - 1-800-999-9307 (7:00 am to 7:00 pm CST)
Asia Pacific- 65 777 8211

Europe [ Middle East | Africa-49 (8153) 9390

North American Response Center

Equipment service needs.

1-800-654-7768 (24 hours a day — includes Canada)
Outside of these areas, contact your local Emerson™ representative.
Power Module Considerations.

Each Power Module contains two "C" size primary lithium/thionyl chloride batteries. Each battery
contains approximately 2.5 grams of lithium, for a total of 5 grams in each pack. Under normal
conditions, the battery materials are self-contained and are not reactive as long as the batteries and the
pack integrity are maintained. Care should be taken to prevent thermal, electrical or mechanical
damage. Contacts should be protected to prevent premature discharge.

Battery hazards remain when cells are discharged.

Power modules should be stored in a clean and dry area. For maximum battery life, storage temperature
should not exceed 30 °C.

The Power Module may be replaced in a hazardous area. The Power Module has surface resistivity
greater than one gigaohm and must be properly installed in the wireless device enclosure. Care must be
taken during transportation to and from the point of installation to prevent electrostatic charge
build-up.

Shipping considerations for wireless products.

The unit was shipped to you without the Power Module installed. Please remove the Power Module prior
to shipping the unit.

Each Power Module contains two "C" size primary lithium/thionyl chloride batteries. Primary lithium
batteries (charged or discharged) are regulated during transportation by the U.S. Department of
Transportation. They are also covered by IATA (International Air Transport Association), ICAO
(International Civil Aviation Organization), and ARD (European Ground Transportation of Dangerous
Goods). It is the responsibility of the shipper to ensure compliance with these or any other local
requirements. Consult current regulations and requirements before shipping.
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Explosions could result in death or serious injury.

Verify that the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

Installation of device in an explosive environment must be in accordance with appropriate local,
national and international standards, codes, and practices.

Ensure device is installed in accordance with intrinsically safe or non-incendive field practices.

Electrical shock can result in death or serious injury.

Ground device on non-metallic tanks (e.qg. fiberglass tanks) to prevent electrostatic charge build-up.
Single lead probes are sensitive for strong electromagnetic fields and therefore not suitable for
non-metallic tanks.

Care must be taken during transportation of power module to prevent electrostatic charge build-up.
Device must be installed to ensure a minimum antenna separation distance of 8 in. (20 cm) from all
persons.

Probes covered with plastic and/or with plastic discs may generate an ignition-capable level of
electrostatic charge under certain extreme conditions. Therefore, when the probe is used in a
potentially explosive atmosphere, appropriate measures must be taken to prevent electrostatic
discharge.

Process leaks could result in death or serious injury.

Only qualified personnel should install the equipment.

Install transmitter prior to process start-up.

Install and tighten process connectors before applying pressure.
Handle the transmitter carefully.

Do not remove the transmitter while in operation.

If the process seal is damaged, gas could escape from the tank when removing the transmitter head
from the probe.

Failure to follow safe installation guidelines could result in death or serious injury.

Verify that the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

Make sure the transmitter is installed by qualified personnel and in accordance with applicable code
of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the protection
provided by the equipment.

Title Page
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Electronic boards are electrostatically sensitive. Failure to observe proper handling precautions for
static-sensitive components can result in damage to the electronic components. Do not remove the
electronic boards from the Rosemount 3308 Series Transmitter.

To ensure long life for your radar transmitter, and to comply with hazardous location installation
requirements, tighten covers on both sides of the electronics housing.

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution of components
etc., may also jeopardize safety and is under no circumstances allowed.

ACAUTION

This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: This
device may not cause harmful interference. This device must accept any interference received, including
interference that may cause undesired operation. This device must be installed to ensure a minimum
antenna separation distance of 20 cm (8 in.) from all persons.

The products described in this document are NOT designed for nuclear-qualified applications.

Using non-nuclear qualified products in applications that require nuclear-qualified hardware or
products may cause inaccurate readings.

For information on Rosemount nuclear-qualified products, contact your local Emerson Sales
Representative.

Individuals who handle products exposed to a hazardous substance can avoid injury if they are informed
of and understand the hazard. If the product being returned was exposed to a hazardous substance as
defined by Occupational Safety and Health Administration (OSHA), a copy of the required Safety Data
Sheet (SDS) for each hazardous substance identified must be included with the returned goods.

Use caution when handling the Power Module. The Power Module may be damaged if dropped from
heights in excess of 20 ft. (6 m).

Changes or modifications to the equipment not expressly approved by Rosemount Inc. could void the
user’s authority to operate the equipment.

Xi
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Section 1 Introduction

1.1

1.2

Introduction

Using this manual

The sections in this manual provide information on installing, configuring, operating, and maintaining
the Rosemount™ 3308 Series Transmitter. The sections are organized as follows:

Section 2: Transmitter Overview provides an introduction to theory of operation and description of the
transmitter. Information on applications and a probe selection guide are also included.

Section 3: Installation contains mechanical and electrical installation instructions.

Section 4: Configuration provides instructions on how to configure and make the transmitter join the
wireless network.

Section 5: Operation contains operation techniques such as viewing measurement data and display
functionality.

Section 6: Service and Troubleshooting provides troubleshooting techniques for the most common
operating problems, as well as diagnostic and error messages, and service instructions.

Appendix A: Specifications and Reference Data supplies reference and specification data, as well as ordering
information.

Appendix B: Product Certifications contains hazardous locations certifications and approval drawings.

Appendix C: High Gain Remote Antenna Option contains specification and installation information of the high
gain remote antenna option.

Appendix D: Configuration Parameters provides a menu overview for the Device Descriptor in AMS Wireless
Configurator and the Field Communicator. Description of the configuration parameters is also included.

Appendix E: Alert Message Mapping outlines the most important alerts in the HART® command 48
Additional Status Field for Rosemount 3308 Series.

Product recycling/disposal

Recycling of equipment and packaging should be taken into consideration and disposed in accordance
with local and national legislation/regulations.
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Section 2 Transmitter Overview

Theory of Operation . ... ... e et e e page 3

Wireless by EMErsOn ™ ...ttt et et e e e page 7

Application characteristics . ...ttt e e e page 7

ApPlication EXamMIPlES ... page 9

Components of the transmitter. . ... ..o i e page 10

Probe selection quide . ....... ..ot e page 11
2.1 Theory of operation

Transmitter Overview

The Rosemount™ 3308 Series is the first true wireless level transmitter that is based on the Time Domain
Reflectometry (TDR) principle. Low power nano-second-pulses are guided along a probe submerged in
the process media. When a pulse reaches the surface of the material it is measuring, part of the energy is
reflected back to the transmitter, and the time difference between the generated and reflected pulse is
converted into a distance from which the total level or interface level is calculated (see Figure 2-1). See
Figure 2-2 for a schematic overview of the signal processing.

The reflectivity of the product is a key parameter for measurement performance. A high dielectric
constant of the media gives better reflection and a longer measuring range.

Figure 2-1. Guided Wave Radar Operating Principle
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Figure 2-2. Flowchart of the Signal Processing
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Reference peak

This peak is caused by the transition between transmitter and the tank vapor space or air. It is used by the
transmitter as a starting reference point for distance to the level surface.

Product surface peak
This peak indicates the product level and is caused by a reflection from the product surface.
Interface peak

This peak indicates the interface level. The peak is caused by reflection from the interface between an
upper product and a bottom product with a relatively high dielectric constant. This peak is identified
when the Measurement Mode is set to Product Level and Interface Level or Interface Level with
Submerged Probe.

Probe end peak

It is caused by reflection from the probe end. If the probe is grounded, the peak will be positive. If the
probe end is submerged in a high dielectric media, such as water, it will not be visible.

Upper reference point

The Upper Reference Point is located at the underside of the threaded adapter, transmitter flange, or Tri
Clamp, as illustrated in Figure 2-3 on page 5.

Transmitter Overview
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Transmitter Overview

Figure 2-3. Upper Reference Point

NPT BSPP(G) Flange TriClamp

A. Upper Reference Point
B. Probe Length

Zero reference point

The Zero Reference Point is selected by the user and is usually located close to or at the bottom of the
tank. The Zero Reference Point can be set to any position in the tank by adjusting the Tank Height.

Tank height

The Tank Height is the distance from the Upper Reference Point to the Zero Reference Point. The
transmitter measures the distance to the product surface and subtracts this value from the Tank Height
to determine the level.

Probe length

The probe length is the distance between the Upper Reference Point and the end of the probe. If a
weight is used at the end of the probe it shall be included.

Blind zones

The measuring range depends on probe type, dielectric constant of the product and installation
environment, and is limited by the Blind Zones at the very top and bottom of the probe. In the Blind
Zones, the accuracy exceeds +1.18 in. (30 mm), and measurements may not be possible. Measurements
close to the Blind Zones will have reduced accuracy.

Figure 2-4 illustrates how the measuring range is related to the Blind Zones and the areas with reduced
accuracy. Values for different probe types and dielectric constants are presented in section “Accuracy
over measuring range” on page 114.
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Figure 2-4. Blind Zones

A. UpperBlind Zone D. Reduced Accuracy
B. Reduced Accuracy E. LowerBlind Zone
C. Recommended Measuring Range

Note
Measurements may not be possible in the Blind Zones, and measurements close to the Blind Zones will
have reduced accuracy. Therefore, the alarm points should be configured outside these zones.

6 Transmitter Overview
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2.2

2.3
2.3.1

Transmitter Overview

Wireless by Emerson™

The Emerson Wireless network is a self-organizing solution. Wireless field instruments send data to a
Gateway, directly or routed through any of the wireless devices in the network, as illustrated in
Figure 2-5. Multiple communication paths are managed and analyzed in parallel to assure optimal
communication and sustained network reliability even if obstructions are introduced.

Figure 2-5. Emerson Wireless Network
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Gateways interface with existing host systems using industry standard protocols, and native integration
into DeltaV™ and Ovation™ is transparent and seamless.

Interference from other radios, Wi-Fi®, and EMC sources is avoided through Time Synchronized Channel
Hopping and Direct Sequence Spread Spectrum (DSSS). Also, a layered security implementing industry
standard Encryption, Authentication, Verification, Anti-Jamming, and Key Management ensures that
data transmissions are secure and received only by the Gateway.

Application characteristics

Tank shape

The guided wave radar transmitter is insensitive to the tank shape. Since the radar signal travels along a
probe, the shape of the tank bottom has no effect on the measurement performance. The transmitter
handles flat or dish-bottom tanks equally well.
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2.3.2

2.3.3

In-tank obstructions

The Rosemount 3308 Series Transmitter is relatively insensitive to objects in the tank since the radar
signal is transmitted along a probe.

Avoid physical contact between probes and agitators as well as applications with strong fluid movement
unless the probe is anchored. If the probe can move within 1 ft. (30 cm) away from any object, such as an
agitator, during operation then probe tie-down is recommended.

In order to stabilize the probe for side forces, you have the option to either hang a weight at the probe
end (flexible probes only) or fix/guide the probe to the tank bottom.

Interface level measurement

Rosemount 3308 Series Transmitter is well suited for measuring the interface of oil and water, or other
liquids with significant dielectric differences.

Figure 2-6. Interface Level Measurement

\

/

A. Product Level
B. Interface Level

All probes can be used for measuring interfaces. Single probes are the preferred choice in almost all
applications but depending on the application and installation geometries a coaxial probe or a flexible
twin probe may be a better fit.

For measuring the interface level, the transmitter uses the residual wave of the first reflection. Part of the
wave, which was not reflected at the upper product surface, continues until it is reflected at the lower
product surface. The speed of this wave depends fully on the dielectric constant of the upper product.

The maximum allowable upper product thickness/measuring range is primarily determined by the
dielectric constants of the two liquids. Target applications include interfaces between oil/oil-like and
water/water-like liquids. For such applications the upper product dielectric constant is low (<3) and the
lower product dielectric constant is high (>20). Refer to “Interface measurements” on page 119 for
further interface application guidelines.

Emulsion layers

Sometimes there is an emulsion layer (mix of the products) between the two products which, depending
on its characteristics, will affect interface measurements. Please consult factory for guidelines on how to
handle emulsion layers.

Transmitter Overview
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2.4

Application examples

The Rosemount 3308 Series Transmitter is suited for aggregate (total) level measurements on a wide
range of liquids, semi-liquids, and liquid to liquid interfaces.

Moreover, the reliable and accurate guided wave radar technology offers a versatile solution that is
virtually unaffected by process conditions such as temperature, pressure, vapor gas mixtures, density,
turbulence, bubbling/boiling, varying dielectric media, pH, and viscosity.

underground tanks, such as sump pits.

Storage and buffer | The Rosemount 3308 Series Transmitter is
tanks ideal for storage or buffer tanks for almost 3‘ #
any liquid, such as oil, gas condensate, - -
water, or chemicals. ;
Low pressure The Rosemount 3308 Series Transmitter
separators can measure both level and interface level, ~ # g;
such as for separator applications. Tt T T ~
pS
Oil
oil
Water
iy
Waste tanks and The Rosemount 3308 Series Transmitter is ﬁ
sump pits a good choice for waste tanks and "

Open applications—
ponds, basins,
sumps

The Rosemount 3308 Series Transmitter
can be installed in open air to measure
liquids not contained in a tank.

Chamber
applications

The Rosemount 3308 Series Transmitter is
a good choice for both chamber and pipe
installations.

]
K]

T

|

(

Transmitter Overview
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2.5 Components of the transmitter

The Rosemount 3308 Series transmitter housing contains advanced electronics for signal processing.
The transmitter housing is made of aluminum or stainless steel, depending on specified option code.

The radar electronics produces an electromagnetic pulse which is guided by the probe.

There are different probe types available for various applications: Flexible Single Lead, Rigid Single Lead,
Flexible Twin Lead, and Coaxial.

Figure 2-7. Transmitter Components

I
B

A. Radar Electronics G. NPT

B. Flanged Process Connections H. Flexible Single Lead with weight
C. Probe I.  Rigid Single Lead

D. Dual Compartment Housing J. Flexible Twin Lead with weight

E. Threaded Process Connections K. Coaxial

F.  BSPP(G) L. Segmented rigid single lead probe

10 Transmitter Overview
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2.6 Probe selection guide

Use the following guidelines to choose appropriate probe for your Rosemount 3308 Series transmitter:

Table 2-1. Probe Selection Guide. G=Good, NR=Not Recommended, AD=Application Dependent (consult factory)

Flexible single | Rigid singlelead, | Flexibletwin Coaxial
lead segmented rigid lead
single lead
Measurements
Level G G G G
Interface (liquid/liquid) G G G G
Process medium characteristics
Changing density G G G G
Changing dielectric® G G G G
Wide pH variations G G G G
Pressure changes G G G G
Temperature changes G G G G
Condensing vapors G G G G
Bubbling/boiling surfaces G G G G
Foam (mechanical avoidance) NR NR NR AD
Foam (top of foam measurement) AD AD AD NR
Foam (foam and liquid measurement) AD AD AD NR
Clean liquids G G G G
Liquid with dielectric<2.00) AD AD AD AD
Coating liquids® G G NR NR
Viscous liquids® G G AD NR
Crystallizing liquids AD AD NR NR
Solids/Powders NR NR NR NR
Fibrous liquids G G NR NR
Tank environment considerations
Probe is close (<12 in./30 cm) to disturbing objects NR NR AD
Tall and narrow mounting nozzles AD AD AD
(diameter <6in./15 cm and height>diameter + 4 in./10 cm)
Probe might touch nozzle [ disturbing object NR NR NR
Liquid or vapor spray might touch probe NR NR NR
High turbulence AD®) G AD®) G
Turbulent conditions causing breaking forces AD NR AD NR
Non-metallic tanks or open atmosphere applications AD®) AD(®) AD(®) G
1. Notin fully submerged applications.
2. Foroveralllevel applications a changing dielectric has no effect on the measurement. For interface measurements a changing dielectric of the top fluid will degrade the
accuracy of the interface measurement.

3. SeeTable A-1 on page 113 for more information.
4. See Table A-2 on page 113 for more information.
5. Oklf probeis anchored.
6. Notsuitable in applications with disturbing EMC from nearby equipment.

Transmitter Overview 11
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Section 3 Installation

Sl Y MBS AGES . . vttt ettt e e e page 13
INStallation ProCeAUIE . ...ttt e e e e et e e page 15
Review mounting considerations . ..........c.eiiiit it e page 16
Review Mounting preparations .. .........iiuititttnt i e page 22
ANChOrthe Probe .. . page 33
Mountdevice ONTaNK .. ... e page 36
Ground the deviCe .. ..o e page 54
Install the power module . ... i e e e page 55
Position the antenna . ... e page 55
Utilize the device display . .. ...t page 56
3.1 Safety messages

Procedures and instructions in this section may require special precautions to ensure the safety of the
personnel performing the operations. Information that raises potential safety issues is indicated by a

warning symbol (A\). Refer to the following safety messages before performing an operation preceded
by this symbol.

Failure to follow safe installation guidelines could result in death or serious injury.

m Verify that the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

= Make sure the transmitter is installed by qualified personnel and in accordance with applicable code
of practice.

m Use the equipment only as specified in this manual. Failure to do so may impair the protection
provided by the equipment.

Explosions could result in death or serious injury.

= Verify that the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

m Installation of device in an explosive environment must be in accordance with appropriate local,
national and international standards, codes, and practices.

= Ensure device is installed in accordance with intrinsically safe or non-incendive field practices.

Installation 13
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14

Electrical shock can result in death or serious injury.
= Ground device on non-metallic tanks (e.g. fiberglass tanks) to prevent electrostatic charge build-up.

= Single lead probes are sensitive for strong electromagnetic fields and therefore not suitable for
non-metallic tanks.

= Care must be taken during transportation of power module to prevent electrostatic charge build-up.

= Device must be installed to ensure a minimum antenna separation distance of 8 in. (20 cm) from all
persons.

= Probes covered with plastic and/or with plastic discs may generate an ignition-capable level of
electrostatic charge under certain extreme conditions. Therefore, when the probe is used in a
potentially explosive atmosphere, appropriate measures must be taken to prevent electrostatic
discharge.

Process leaks could result in death or serious injury.

= Only qualified personnel should install the equipment.

m Install transmitter prior to process start-up.

= Install and tighten process connectors before applying pressure.
m Handle the transmitter carefully.

= Do not remove the transmitter while in operation.

m If the process seal is damaged, gas could escape from the tank when removing the transmitter head
from the probe.

Electronic boards are electrostatically sensitive. Failure to observe proper handling precautions for
static-sensitive components can result in damage to the electronic components. Do not remove the
electronic boards from the Rosemount™ 3308 Series Transmitter.

To ensure long life for your radar transmitter, and to comply with hazardous location installation
requirements, tighten covers on both sides of the electronics housing.

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution of components
etc., may also jeopardize safety and is under no circumstances allowed.

ACAUTION

Use caution when handling the Power Module. The Power Module may be damaged if dropped from
heights in excess of 20 ft. (6 m).

This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: This
device may not cause harmful interference. This device must accept any interference received, including
interference that may cause undesired operation. This device must be installed to ensure a minimum
antenna separation distance of 20 cm (8 in.) from all persons.
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3.2

Installation

Installation procedure

Follow these steps for proper installation:

Review mounting
considerations

v

Recommended
mounting position

Flange connection on
nozzles

Installation in still
pipe/chamber

v

‘ Non-metallic tanks ‘

v

Review mounting
preparations

r

| Measure tank height |

:_Mama ce_nteﬁ1gmsc—I

L for pipe installations

Anchor the probe

R S

Mount device on rank

Optional
L — — 1

v

v

v

v

Threaded tank
connection

Tank connection
with flange

Tank connection
with loose flange

Tank connection
with Tri Clamp

Segmented probe

(“plate design”)

Ground the device

Install the power
module

A 4

Position the antenna

A
Utilize the display
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3.3

3.3.1

16

Review mounting considerations

Before installing the Rosemount 3308 Series Transmitter, consider recommendations for sufficient free
space, mounting position and special needs for non-metallic tanks.

Recommended mounting position

When finding an appropriate mounting position for the transmitter, the conditions of the tank must be
carefully considered. The transmitter should be mounted so that the influence of disturbing objects is
reduced to a minimum. For easy access to the transmitter make sure that it is mounted with sufficient
service space.

Figure 3-1. Mounting Position

A. Inlet pipe
B. Agitator
C. Heating coils

The following guidelines should be considered when mounting the transmitter:
= Do not mount close to inlet pipes.

= Do not mount close to agitators. If the probe can move to within 12 in. (30 cm) away from an agitator,
the probe should be anchored. See “Anchor the probe” on page 33 for more information.

m If the probe tends to sway due to turbulent conditions in the tank, the probe should be anchored. See
“Anchor the probe” on page 33 for more information.

= Avoid mounting close to heating coils.
m Position the probe such that it is subject to a minimum of lateral force.
= Make sure the probe does not come into contact with the nozzle or other objects in the tank.

Installation
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m Make sure the nozzle does not extend into the tank.

Note

Violent fluid movements causing high sideway forces may break rigid probes.

If the probe is mounted close to a wall, nozzle or other tank obstruction, noise might appear in the level
signal. Therefore the following minimum clearance, according to Table 3-1, must be maintained.

Figure 3-2. Free Space Requirement

H

A. Clearance to tank wall

Table 3-1. Recommended Minimum Free Space to Tank Wall or Other Objects in the Tank

Probe type

Condition

Minimum clearance (A)

Rigid single/Flexible single/
Segmented rigid single Tead

Smooth metal wall

4in. (100 mm)

Disturbing objects such as pipes and
beams, or rugged metal tank walls

16in. (400 mm)

Smooth metal wall

4in. (100 mm)

Flexible twin . . . .
Disturbing objects such as pipes and ;
beams, or rugged metal tank walls 16in. (400 mm)
Coaxial N/A 0in. (0 mm)

Installation
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3.3.2

Flange connection on nozzles

Figure 3-3. Mounting in Nozzles

A. Maximum nozzle height
B. Minimum nozzle diameter

The transmitter can be mounted in nozzles by using an appropriate flange. It is recommended that the
nozzle size is within the dimensions given in Table 3-2.

Note

The probe must not be in contact with the nozzle (except for the coaxial probe).

Table 3-2. Nozzle Considerations

Description

Flexible single
lead probe

Rigid single lead
probe/Segmented
rigid single lead

Flexible twin
lead probe

Coaxial probe

Recommended
nozzle diameter

4in. (100 mm) or
more

4in. (100 mm) or
more

4in. (100 mm) or
more

> probe diameter

1.5in. (38 mm) for

height(?

+ nozzle diameter3)

+ nozzle diameter

L probe type 4A
Minimum nozzle | 4 5 in. (38 mm) 2in. (50 mm) > probe diameter
2in. (50 mm) for
probe type 4B and 4S
Maximum nozzle 4in. (100 mm) 4in. (100 mm) 4in. (100 mm)

+ nozzle diameter

N/A

1. The Trim Near Zone (TNZ) function may be necessary or an Upper Null Zone (UNZ) setup may be required to mask the nozzle.
2. Recommended maximum nozzle height. For coaxial probes there is no limitation on nozzle height.
3. Fornozzlestaller than 4in. (100 mm), the Long Stud version is recommended (option code LS) to prevent the flexible portion from touching

the edge of the nozzle.

18
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3.3.3 Installation in non-metallic tanks and open-air applications

Avoid major sources of electrical disturbance in proximity of the installation, e.g. electrical motors,
stirrers, servo mechanisms.

Figure 3-4. Avoid Electromagnetic Disturbances

For clean liquids, use a coaxial probe to reduce effect of potential electrical disturbances.

Figure 3-5. Coaxial Probe in an Open-Air Application

For optimal single lead probe performance in non-metallic tanks, the probe must be mounted with a
metal flange, or screwed in to a metal sheet (d > 14 in./350 mm) if a threaded version is used.

Figure 3-6. Mounting in Non-Metallic Tanks

Metal flange Metal sheet
(d>14in./350 mm)

Installation 19
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3.34

20

Installation in still pipe/chamber

General chamber considerations

A chamber or pipe installation is the preferred option due to the increase in stability and performance of
the transmitter. When selecting a smaller diameter chamber or pipe (such as 2-in.) a flexible probe is not
suitable due to the chance of it coming into contact with the walls, and relatively large side inlets may
interfere with the signal.

When gas lift and/or turbulence may occur (e.g. boiling hydrocarbons), a 3- or 4-in. chamber/pipe
diameter is recommended for maximum measurement reliability. This is especially true in high pressure
and high temperature installations.

Rosemount 9901 Chamber

Rosemount 9901 allows external mounting of process level instrumentation. It supports a variety of
process connections, and optional drain and vent connections. The Rosemount 9901 chamber is
designed to the ASME B31.3 standard, and is Pressure Equipment Directive (PED) compliant. Use option
code XC to order together with the Rosemount 3308 Series Transmitters.

Figure 3-7. Side-and-Side and Side-and-Bottom Chambers

Side-and-side Side-and-bottom
dimension dimension

>
>

Centre-to-centre

Centre-to-centre

<+

Y

= =S |

The probe length to use for a Rosemount 9901 chamber can be calculated with this formula:
Side-and-side dimension:

Probe length=Centre-to-centre dimension + 19 in. (48 cm)

Side-and-bottom dimension:

Probe length=Centre-to-centre dimension + 4 in. (10 cm)

Use a centering disc the same diameter as the chamber if the probe length >3.3 ft. (1 m). See Table 3-5
on page 28 for which disc to use.

For additional information, see the Rosemount 9901 Chamber for Process Level Instrumentation Product
Data Sheet.

Installation


http://www.emerson.com/catalog/en-us/rosemount-9901
http://www.emerson.com/catalog/en-us/rosemount-9901

Reference Manual Installation
00809-0100-4308, Rev CB January 2018

Installation

Existing chamber

A Rosemount 3308 Series Transmitter is the perfect replacement in an existing displacer chamber.
Proprietary flanges are offered, enabling use of existing chambers to make installation easy.

Figure 3-8. Existing Displacer Chamber

=N

—
I '
I————

[H &
i

=

A. Replace chamber flange
B. Probe length
C. DisplacerLength

Considerations when changing to Rosemount 3308 Series:

m The 3308 Series flange choice and probe length must be correctly matched to the chamber. Both
standard ANSI and EN (DIN), as well as proprietary chamber flanges, are available. See Table A-19 on
page 146 to identify the proprietary flanges.

m See Table 3-5 on page 28 for guidelines on which disc size to use.
m See Table 3-3 for guidelines on the required probe length.

Table 3-3. Required Probe Length in Chambers

Chamber manufacturer Probe length(")

Major torque-tube manufacture (249B, 249C, 249K, 249N, 259B) | Displacer +9in. (229 mm)

Masoneilan™ (Torque tube operated), proprietary flange Displacer + 8 in. (203 mm)
Other - torque tube( Displacer + 8 in. (203 mm)
. Displacer + between 7.8 in. (195 mm) to 15
Magnetrol® (spring operated)®) in. (383 mm)
Others - spring operated? Displacer +19.7 in. (500 mm)

1. If flushing ring is used, add the ring height to the probe length.
2. For other manufacturers, there are small variations. This is an approximate value, actual length should be verified.
3. Lengths vary depending on model, SG and rating, and should be verified.

For additional information, see the Replacing Displacers with Guided Wave Radar Technical Note.
Probe type in chamber considerations

When installing a Rosemount 3308 in a chamber, the single lead probe is recommended. The probe
length determines if a single rigid or single flexible probe should be used:

m Less than 19.7 ft. (6.0 m): Rigid single probe is recommended. Use a centering disc for probe > 3.3 ft.
(1 m). When mounting space is limited, use a flexible single probe with a weight and centering disc.

= More than 19.7 ft. (6.0 m): Use flexible single probe with a weight and centering disc.

PTFE covered probes are not recommended for chamber/pipe installations.

21
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3.4 Review mounting preparations
3.4.1 Measure tank height

The Tank Height is defined as the measured distance from the Upper Reference Point to the Zero
Reference Point.

Figure 3-9. Measure Tank Height

Y

A —
A

.~

A. Upper Reference Point
B. Tank Height
C. Zero Reference Point
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3.4.2 Shorten the probe

In order to leave some clearance distance between the probe end and the tank bottom, the probe might
have to be shortened. The goal is to have the probe hang straight so that it does not touch the wall. 2 in.
(5 cm) is a suggested value. The probe can be shortened in field. Use the following form to calculate the
probe length:

Probe Length = Tank height - 2 in. (5 cm)

After shortening the probe make sure to update the transmitter configuration to the new probe length,
see “Probe length” on page 162.

Figure 3-10. Calculate Probe Length

ANel ~

A. Probe Length
B. 2in.(5cm)clearance
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Flexible single/twin lead probe

Note
The PTFE covered probes must not be cut in field.

1. Mark where to cut the probe.

3.
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4. Slide the weight up.

6. Fasten the weight with the following torque:
= Small weight (W1): 5Nm
m Short weight (W2): 5 Nm
m Heavy weight (W3): 5Nm
= Weight, flexible twin: 6 Nm
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Rigid single lead probe

Note
The PTFE covered probes must not be cut in field.

Note
Make sure the lead is fixed while cutting.

1. Mark where to cut the probe.
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Coaxial probe

1. Mark where to cut the probe.

2. Insert the centering piece.
(The centering piece is delivered from factory and
should be used to prevent the spacers centering
the rod from coming loose).

3. Cut the tube to the desired length.
4. Move the centering piece.

5. Cut the rod inside the tube. Make sure the rod is
fixed with the centering piece while cutting.

m Pipes longer than 49in. (1250 mm) can be
shortened by as much as 23.6 in. (600 mm).

m Pipes shorter than 49 in. (1250 mm) can be cut
as long as the remaining length is not less than
15.7 in. (400 mm).

Installation

>49in.
(1250 mm)

<49in.
(1250 mm)

Maximum shortening 23.6
in. (600 mm)

Minimum probe length
15.7in. (400 mm)
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3.4.3 Mount a centering disc for pipe installations
To prevent the probe from contacting the chamber or pipe wall, centering discs are available for flexible
single, rigid single, and flexible twin lead probes. The disc is attached to the end of the probe. Discs are
made of stainless steel, Alloy C-276, Duplex 2205, or PTFE.
When mounting a centering disc, it is important that it fits correctly in the chamber/pipe. See Table 3-4
for Dimension D. Table 3-5 shows which centering disc diameter to choose for a particular pipe.
Figure 3-11. Dimension D for Centering Discs
Table 3-4. Centering Discs Dimensions
Disc size Actual disc diameter (D)
2-in. 1.8in. (45 mm)
3-in. 2.7in. (68 mm)
4-in. 3.6in.(92 mm)
6-in. 5.55in. (141 mm)
8-in. 7.40in. (188 mm)
Table 3-5. Centering Disc Size Recommendation for Different Pipe Schedules
Pipe size Pipe schedule
5s,5and 10s,10 | 40s, 40 and 80s, 80 120 160
2-in. 2-in. 2-in. N/AM N/A®@
3-in. 3-in. 3-in. N/AM 2-in
4-in. 4-in. 4-in. 4-in. 3-in
5-in. 4-in. 4-in. 4-in. 4-in
6-in. 6-in. 6-in. 4-in. 4-in
7-in. N/AM 6-in. N/AM N/AM
8-in. 8-in. 8-in. 6-in. 6-in.
1. Schedule is not available for pipe size.
2. No centering disc is available.
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Flexible single/twin lead probe

1. Mount the centering disc at the end of the weight.

—

13 mm

2. Secure the bolt by folding the tab washer.

Installation
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Rigid single lead probe (8 mm)

Note
Centering discs shall not be used with PTFE covered probes.

1. Drill one hole using the drilling fixture (included in your shipment).

A. Drilling fixture
B. Probe

2. Mount the bushing, centering disc, and washer at the probe end.

Note
Do not mount the washer if the centering disc material is PTFE.

A. Washer
B. Centering disc
C. Bushing

3. Insert the split pin through the bushing and the probe.
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4. Secure the split pin.

o

Rigid single lead probe (13 mm)

1. Drill two holes using the drilling fixture (included in your shipment).

B

A. Drilling fixture
B. Probe

2. Mount the bushings and centering disc at the probe end.
@

I

A

I
A

AN

A. Bushing
B. Centering disc

Installation
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3. Adjust distance by shifting hole for split pin in lower bushing.

0.16in. (4 mm)

i

0.08in. (2 mm)

o
{

4. Insert the split pins through the bushings and the probe.

5. Secure the split pins.

7
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3.5 Anchor the probe

In turbulent tanks it may be necessary to fix the probe. Depending on the probe type, different methods
can be used to guide the probe to the tank bottom. This may be needed in order to prevent the probe
from hitting the tank wall or other objects in the tank, as well as preventing a probe from breaking.

3.5.1 Flexible single/twin lead probe

The flexible single lead probe itself can be used for anchoring. Pull the probe rope through a suitable
anchoring point, e.g. a welded eye, and fasten it with a chuck.

The length of the loop will add to the Blind Zone. The location of the chuck will determine the beginning
of the Blind Zone. See “Accuracy over measuring range” on page 114 for further information on Blind
Zones.

The Probe Length should be configured as the distance from the Upper Reference Point to the top of the
chuck.

Figure 3-12. Flexible Single Lead Probe with Chuck

Aring (customer supplied) can be attached to the weight in a threaded (M8x14) hole at the end of the
weight. Attach the ring to a suitable anchoring point.

Figure 3-13. Flexible Twin/Single Lead Probe with Weight and Ring

A. Weight with internal threads M8x14
B. Ring

A magnet (customer supplied) can be fastened in a threaded (M8x14) hole at the end of the weight. The
probe can then be guided by placing a suitable metal plate beneath the magnet.
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Figure 3-14. Flexible Twin/Single Lead Probe with Weight and Magnet

———

A. Magnet

3.5.2 Rigid single lead probe

The rigid single lead probe can be guided by a tube welded on the tank bottom. Tubes are customer
supplied. Make sure that the probe can move freely in order to handle thermal expansion. The
measurement accuracy will be reduced close to the tube opening.

Figure 3-15. Rigid Single Lead Probe with Tube

A. Drain
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3.5.3

Installation

Coaxial probe

The coaxial probe can be secured to the tank wall by fixtures fastened to the tank wall. Fixtures are
customer supplied. Make sure the probe can move freely due to thermal expansion without getting
stuck in the fixture.

Figure 3-16. Coaxial Probe Secured to the Tank Wall

A. 1.7in.(28 mm)

The coaxial probe can be guided by a tube welded on the tank bottom. Tubes are customer supplied.
Make sure that the probe can move freely in order to handle thermal expansion. The measurement
accuracy will be reduced close to the tube opening.

Figure 3-17. Coaxial Probe with Tube

A. Drain

35



Installation Reference Manual
January 2018 00809-0100-4308, Rev CB

3.6 Mount device on tank

Mount the transmitter with flange on a nozzle on top of the tank. The transmitter can also be mounted
on a threaded connection. Make sure only qualified personnel perform the installation.

Note

If the transmitter head must be removed from the probe, make sure that the process seal is carefully
protected from dust and water. See “Transmitter head replacement” on page 108 for further
information.

Note
PTFE covered probes must be handled carefully to prevent damage to the coating.

3.6.1 Threaded tank connection
1. For adapters with BSPP (G) threads, place a gasket on top of the tank flange.
&>« Gasket

%

2. For adapters with NPT threads, use anti-seize paste or PTFE tape according to your site procedures.

3.
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4. Loosen the nut that connects the transmitter head to the probe slightly.
52 mm [ 60 mm
6. Rotate the transmitter head so the device display faces the desired direction.
q@ Torque 30 Lbft (40 Nm)
60 mm
8. Continue with the grounding step.
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3.6.2 Tank connection with flange

1. Place a gasket on top of the tank flange.

&>~ Gasket
=t=

Q

Note
Gasket should not be used for PTFE covered probe with protective plate.

\ PTFE covered probe with protective plate

2. Lower the transmitter and probe with flange into the tank.

-
=
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4. Loosen the nut that connects the transmitter head to the probe slightly.
7. Continue with the grounding step.
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3.6.3 Tank connection with loose flange (“plate design”)

The transmitter is delivered with head, flange and probe assembled into one unit. If, for some reason,
these parts have been disassembled, mount the transmitter as described below:

1. Mount the flange on the probe and tighten the flange nut.

2. Place a gasket on top of the tank flange.

&>~ Gasket
==

Q

3. Lower the probe with flange into the tank.

4. Tighten bolts and nuts with sufficient torque for the flange and gasket choice.

N
=
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5. Mount the transmitter head.
(> Torque 30 Lbft (40 Nm)
60 mm
6. Continue with the grounding step.
3.64 Tank connection with Tri Clamp
1. Place a gasket on top of the tank flange.
—__—»~— Gasket
2. Lower the transmitter and probe into the tank.
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4. Loosen the nut that connects the transmitter head to the probe slightly.

@ Torque 30 Lbft (40 Nm)

60 mm

7. Continue with the grounding step.
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3.6.5 Segmented probe

Figure 3-18. Segmented Probe Parts

=E
=F
=F
15.2 C
(385) %
—D 315 G

H
——D
Il &—p
= |
[ D
Dimensions are in inches (mm).
. Safety ring
Screw
. Top segment
. Split pin

. PTFE washer (optional)

Centering disc in PTFE (optional)

. Middle segment

. Bottom segment (length varies depending on total probe length)
Bushing (for the centering disc at the probe end)

Bottom centering disc in PTFE or stainless steel (optional)

—rCIomMmMoNw>
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Verify probe length

Segmented probe ordered with model code 4S

Before installation, verify the probe length (L) on the label. If the probe length needs to be adjusted, see
“Adjusting the probe length” on page 51.

Probe length

- >

Probe segments box

Segmented probe ordered as spare part kit

Before installation, the number of segments that add up to the desired probe length must be

determined. Also, the bottom segment may need to be shortened. See “Adjusting the probe length” on
page 51.

Assemble the segmented probe

Note
If there is enough space beside the tank, the probe can be assembled before inserting it into the tank.

1. Insert the stop screw to the top segment. Tighten approximately two turns.

Top Segment

1

~Two turns
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2. Pre-assemble the safety ring.

I

=

3. Optional: If ordered, mount the centering disc on the bottom segment of the probe.

Bottom Segment

4. Insert the support tool.

Bottom Segment
==

Z oo

<4
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5. Optional: If ordered, mount the centering disc.

Note
= Maximum five pcs/probe

= Minimum two segments between each centering disc

6. Mount a middle segment.

i

Hand tighten
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Installation

7. Secure the split pin.

8.

i

Insert the second support tool.

=

i
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9. Remove the first support tool and lower the probe into the tank.

L F

10. Repeat steps 5 to 9 until all segments are mounted. Make sure to finish with the top segment of the
probe.

11. Seal and protect threads.

& Only for NPT threaded tank connection.

Use anti-seize paste or PTFE tape
according to your site procedures.
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Installation

12. Attach the probe to the device.
Flange|Tri Clamp Threaded

Note
For safety reasons, at least two people are needed when mounting the device.
Make sure to hold the device above the tank. High loads can break the support tool.

13. Tighten the stop screw and slide the safety ring into the groove.
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14. Remove the support tool.
15. Mount the device on the tank.
Flange Tri Clamp Threaded
(" Torque 30 Lbft (40 Nm)
60 mm
18. Continue with the grounding step.
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Adjusting the probe length

1. Determine L, the desired probe length.

L, desired probe length:

L

2. Determine n, the number of middle segments needed for the desired probe length. See Table 3-6 on
page 53.

n, number of middle segments:

3. Calculate Y, the length of the bottom segment. See Table 3-6 on page 53.

Y, length of bottom segment:

= P g Pl SN AV)
Y
4. Continue as follows:
Length of bottom segment (Y) Action
=3 m Continue with step (7).
ke Do not use the bottom segment.

Y<0.4in. (10 mm)

:T *‘ m Continue with step (5) and cut the bottom segment.

Y=0.4in. (10 mm)

= = 1. Add one extra middle segment to the calculated n.

\ \
Y=31.5in. (800 mm) 2. Continue with step (7).
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5. Mark where to cut the bottom segment.
- f

6. Cutthe bottom segment at the mark.

Note
Make sure the bottom segment is fixed while cutting.

””? ,,,,,,,,,,,,,,

7. Optional: If a bottom centering disc is ordered, then drill two holes on the bottom segment using
the drilling fixture.

Drilling fixture
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Table 3-6. Determination of Probe Segments for Standard Seal

Desired probe length (L)(")

Number of middle
segments (n)

Length of bottom segment (Y)

in. mm in. mm
15.8<L=47.2 400=<L <1200 0pc Y=L-15.8 Y=L-400
47.2<L=<78.7 1200<L <2000 1pc Y=L-47.2 Y=L-1200
78.7<L<110.2 2000<L <2800 2 pcs Y=L-78.7 Y=L-2000
110.2<L<141.7 2800<L <3600 3 pcs Y=L-110.2 Y=L-2800
141.7<L<173.2 3600<L <4400 4 pcs Y=L-141.7 Y=L-3600
173.2<L=<204.7 4400<L <5200 5 pcs Y=L-173.2 Y =1L1-4400
204.7<L=236.2 5200<L =6000 6 pcs Y=L-204.7 Y=L-5200
236.2<L=267.7 6000<L=6800 7 pcs Y=L-236.2 Y=L-6000
267.7<L=299.2 6800<L <7600 8 pcs Y=L-267.7 Y=L-6800
299.2<1<330.7 7600 <L < 8400 9 pcs Y=1-299.2 Y=L-7600
330.7<L<362.2 8400<L <9200 10 pcs Y=L-330.7 Y=L-8400
362.2<L=393.7 9200<L<10000 11 pcs Y=L-362.2 Y=L1-9200

1.

Maximum probe length is 32 ft. 9 in. (10 m) for the Rosemount 3308 Series.
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3.7 Ground the device

The Rosemount 3308 Series Wireless Guided Wave Radar transmitter operates with the housing
grounded or floating. Floating systems can cause extra noise that may affect many types of readout
devices. If the signal appears noisy or erratic, grounding at a single point may solve the problem.

Grounding of the electronics enclosure should be done in accordance with local and national installation
codes. Grounding is accomplished by using the external case grounding terminal.

Non-metallic tanks

Ground device on non-metallic tanks (e.g. fiberglass tanks) to prevent electrostatic charge build-up.

There is one grounding screw connection provided, located on the housing, see Figure 3-19. The ground
screw is identified by a ground symbol: D

Figure 3-19. Ground Screw

1

=
(&
Lol

S
T

A. Ground screw

Note
Always use facility recommended wiring practices.

Note

Flexible twin lead probe or coaxial probe are the recommended choice for non-metallic tanks. Single
lead probes are not suited for non-metallic tanks or open atmosphere applications, due to high
susceptibility to strong electromagnetic fields.
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3.8 Install the power module
Note
Use caution when handling the power module, it may be damaged if dropped from heights in excess of
20 ft. (6 m).

1. Install the Black Power Module, SmartPower™ Solutions model number 701PBKKF into the
transmitter.

2. Close the housing cover and tighten to site or safety specifications. Always ensure a proper seal by
tightening the electronics housing covers so that metal touches metal, but do not over tighten.

Keep cover tight

3.9 Position the antenna

The antenna should be positioned vertically, either straight up or straight down, and it should be
approximately 3 ft. (1 m) from any large structure, building, or conductive surface to allow for clear
communication to other devices.
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3.10

3.10.1

3.10.2

56

Figure 3-20. Antenna Positioned Vertically
) :%

Utilize the device display

If a device display is ordered, it will be shipped attached to the transmitter. The display is ordered in the
transmitter model number, option code M5.

Rotate the device display

To rotate the display in 90-degree increments:

1. Squeeze the two black tabs on opposite sides of the display. Refer to Figure 3-21.
2. Gently pull out the display.

3. Rotate the display to the desired orientation, and snap the display into place.

Figure 3-21. Device Display

Display Pins
Black tabs
Display
Cover

oNnw>

Note

If the device display four-pin connector is inadvertently removed from the interface board, carefully
re-insert the connector before snapping the device display back into place.

Retrofitting

If an existing transmitter with no display (flat electronics cover) is to be retrofitted with a new display,
order spare part kit number 00753-9004-0001(aluminum display kit) or 00753-9004-0004 (stainless
steel display kit). These kits contain an extended cover with a display viewing window, a display board,
and a display pin connector. Replace the flat cover with the extended display and tighten.
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Section 4 Configuration

OV IV B . ettt e e e e page 57
SaAfEtY MBS SAGES . o vttt ettt e page 58
Configuration ProCedUre ... .. ..ttt e e e e e e page 59
SYSEEM TEAAINESS . . vttt ettt ettt ettt e ettt e et e e e page 60
Get started with your preferred configurationtool .............. ... ... page 61
Join device to wireless NEtWOrK ... ... i e page 64
Configure device using guided SEtUP .. ... iii ittt e page 72
VErify LOVEL . .. page 74
4.1 Overview

Configuration

This chapter provides information about configuration, configuration tools, and configuration
parameters.

m For a proper configuration, follow the steps listed in the section “Configuration procedure” on
page 59.

» The configuration can be performed using one of the described configuration tools: AMS Wireless
Configurator or a Field Communicator. The section “Get started with your preferred configuration
tool” on page 61 describes what preparations must be done in order to use the configuration tool.

= Appendix D: Configuration Parameters provides extended information about the configuration
parameters. An overview of Device Descriptor (DD) menu is presented in the section “Menu overview
of the Device Descriptor (DD)” on page 160. All configuration parameters are described in section
“Configuration parameters” on page 161.
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4.2
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Safety messages

Instructions and procedures in this section may require special precautions to ensure the safety of the
personnel performing the operations. Information that potentially raises safety issues is indicated by a

warning symbol (A\). Refer to the following safety messages before performing an operation preceded
by this symbol.

Explosions could result in death or serious injury.

= Verify that the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

= Installation of device in an explosive environment must be in accordance with appropriate local,
national and international standards, codes, and practices.

m Ensure device is installed in accordance with intrinsically safe or non-incendive field practices.

Electrical shock can result in death or serious injury.
= Ground device on non-metallic tanks (e.g. fiberglass tanks) to prevent electrostatic charge build-up.

= Single lead probes are sensitive for strong electromagnetic fields and therefore not suitable for
non-metallic tanks.

= Care must be taken during transportation of power module to prevent electrostatic charge build-up.

m Device must be installed to ensure a minimum antenna separation distance of 8 in. (20 cm) from all
persons.

Process leaks could result in death or serious injury.
= Only qualified personnel should install the equipment.
m Handle the transmitter carefully.

= If the process seal is damaged, gas could escape from the tank when removing the transmitter head
from the probe.

To ensure long life for your radar transmitter, and to comply with hazardous location installation
requirements, tighten covers on both sides of the electronics housing.

ACAUTION

Use caution when handling the Power Module. The Power Module may be damaged if dropped from
heights in excess of 20 ft. (6 m).

This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: This
device may not cause harmful interference. This device must accept any interference received, including
interference that may cause undesired operation. This device must be installed to ensure a minimum
antenna separation distance of 20 cm (8 in.) from all persons.

Configuration



Reference Manual
00809-0100-4308, Rev CB

Configuration
January 2018

4.3

Configuration

Configuration procedure

Follow these steps for proper configuration:

Get started

v

Join device to
wireless network

| Insert power module |

v

| Connect to device |

v

| Configure update rate |

Obtain networkID and
join key

Enter network ID and
joinkey

v

Verify device joins
Network

A4

Configure device

v

| Connect to device |

v

| Basic setup |

v

| Optional setup |

A4

Verify level
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4.4
4.4.1

Table 4-1. Identification and Compatibility According to NAMUR NE 53

System readiness

Confirm correct device driver

Verify the latest Device Descriptor (DD) is loaded on your systems to ensure proper communication.

1. Within Table 4-1, use the HART® Universal Revision and Device Revision numbers to find the correct

DD.

2. Download the latest DD at EmersonProcess.com/DeviceFiles.

Release date

Device identification

DD identification

Review
instructions

Review functionality

NAMUR NAMUR HART HART universal Device | Manual document Change description
hardware | software | software revision revision number
revision(!) | revision(") | revision(®
December-15 1.0.xx 1.0.xx 2 7 1 00809-0100-4308 Extended length and added
probe support
January-18 1.7.xx 1.7.xx 3 7 2 High accuracy output and

Rosemount™ VeriCase support

1. NAMUR revision is located on the transmitter label. Differences in level 3 changes, signified above by xx, represent minor product changes as defined per NE53.

Compatibility and functionality are preserved and product can be used interchangeably.
2. HART software revision can be read using a HART capable configuration tool (select Overview > Device Information > Revisions).

60

Configuration



www.www.EmersonProcess.com/DeviceFiles

Reference Manual Configuration

00809-0100-4308, Rev CB January 2018
4.5 Get started with your preferred configuration tool
4.5.1 AMS Wireless Configurator (version 12.0 or later is required)

The AMS Wireless Configurator is the recommended software tool for the wireless network devices, and
is supplied with the Emerson™ Wireless Gateway. Refer to the AMS Wireless Configurator Manual
Supplement for further information.

Configuration can be done by connecting to the wireless network devices either point-to-point using a
HART modem as shown in Figure 4-1, or wirelessly through the Gateway as shown in Figure 4-2. Initial
configuration to join a device to the wireless network must be done point-to-point.

Figure 4-1. Connect Point-to-Point using HART Modem

A. Communication terminals

Figure 4-2. Connect Wirelessly through the Wireless Gateway

A. Wireless Gateway
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Get the latest Device Descriptor (DD)
The Device Descriptor (DD) is a configuration tool that is developed to assist the user through the
configuration.
The Rosemount 3308 Series DD is typically installed together with AMS Wireless Configurator. To
download the latest HART DD, visit the Emerson Device Install Kit site at:
EmersonProcess.com/Devicefiles
After downloading, add the DD to AMS Wireless Configurator:
1. Close AMS Wireless Configurator.
2. Go to Start > Programs > AMS Device Manager and select Add Device Type.
3. Browse to the downloaded DD files and select Ok.
In the Add Device Type application, select the Help button for more information on how to complete this
operation.
Configure the HART modem interface
Before connecting to the device using a HART modem, the HART modem interface must be configured
in AMS Wireless Configurator:
1. Close AMS Wireless Configurator.
2. Go to Start > Programs > AMS Device Manager and select Network Configuration.
3. Select Add.
4. Inthe drop down list, select HART modem and then select Install.
5. Follow the on-screen instructions.
In the Network Configuration application, select the Help button for more information on how to
complete this operation.
Configure the wireless network interface
Before connecting to the device wirelessly using a Wireless Gateway, the wireless network must be
configured in AMS Wireless Configurator:
1. Close AMS Wireless Configurator.
2. Go to Start > Programs > AMS Device Manager and select Network Configuration.
3. Select Add.
4. In the drop down list select Wireless Network and then select Install.
5. Follow the on-screen instructions.
In the Network Configuration application, select the Help button for more information on how to
complete this operation.
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4.5.2

Configuration

Field Communicator

This section describes how to prepare the Field Communicator to communicate with a Rosemount 3308
Series Transmitter. The Field Communicator can be used to configure the device with a point-to-point
connection. Connect the leads on the Field Communicator to the communication terminals of the
device as shown in Figure 4-3.

Figure 4-3. Connect Point-to-Point using a Field Communicator

A

A. Communication terminals

Get the latest Device Descriptor (DD)

If the DD is not installed in your Field Communicator, see the appropriate Field Communicator User’s
Manual available at Emerson.com/FieldCommunicator for instructions on how to update the Field
Communicator with the latest DD.
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4.6
4.6.1
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Join device to wireless network

Power up the wireless device

Make sure that the Wireless Gateway is installed and functioning properly before any wireless field
devices are powered. See “Install the power module” on page 55 for further information on how to
install the power module.

Wireless devices should be powered up in order of proximity from the Gateway, beginning with the
closest. This will result in a simpler and faster network installation.

Enable Active Advertising on the Gateway to ensure that new devices join the network faster. For more
information, see the Gateway Reference Manual.

Startup screen sequence

The following screens will be displayed in sequence when the power module is first connected to the
Rosemount 3308 Series Transmitter.

Figure 4-4. Startup Screen Sequence

oy o o N
W T T
VN ) 1 b

W 0 N 5
O 2 A A

1. All Segments ON 2. Device Identification 3. Device Information: Tag
Used tovisually determineifthere  Identification string used to User entered tag, 8 characters
are any bad segments on the determine the Device Type. long. This screen will not display if
device display. all characters are blank.

4, Software Revision 5. Device Information: Status 6. Primary Variable
Used to determine Device This screen will only appear if there Measurement value of mapped
Software Revision. is a critical error which may prevent ~ Primary Variable.

the device from operating correctly.
Check additional status screens for
more information about failure
source, refer to “Diagnostic button
screen sequence” on page 78.
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7. Secondary Variable 8. Electronics Temperature 9. Supply Voltage
Measurement value of mapped Temperature value of device Voltage reading of the Power
Second Variable. electronics. Module.

>6V Good
52V-6.0V | Low
<5.2V Very low

10. Percent of Range 11. Active Alert Present
Level value in percent of total This screen will only appear if there
measurement range. is at least one Active Alert present.

For detailed information of the
failure source and recommended
actions, go to the Active Alerts
screen in AMS Wireless
Configurator or Field
Communicator. Refer to “Check
device status” on page 81.

Some Active Alerts will be displayed
on the LCD display as part of the
diagnostic button screen sequence,
refer to “Diagnostic button screen
sequence” on page 78.
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Connect to device

Connect a Field Communicator or a HART modem to the communication terminals as shown in
Figure 4-5.

Figure 4-5. Connect to Device

A. Communication terminals
B. Field Communicator
C. HART Modem

AMS Wireless Configurator: Field Communicator:
a. Start AMS Wireless Configurator. m Turn on the Field Communicator and connect to the
b. Select View > Device Connection View. device.

c. Double click the device under the HART modem.

For more information on how to connect to device refer to “Get started with your preferred
configuration tool” on page 61.
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4.6.3

4.6.4

Configuration

Configure update rate

The Update Rate is the frequency at which a new measurement is transmitted over the wireless network.
The default update rate is 1 minute. This may be changed at commissioning, or at any time via AMS
Wireless Configurator or a Field Communicator. The Update Rate is user selectable from 4 seconds to 60
minutes.

1. Select Configure > Guided Setup > Wireless Setup.

2. Select Configure Update Rate, and follow the instructions.

Note
Make sure to set the Update Rate so that there is enough safety margin in the system for high/low alerts.
If the time between each update is too long, the high/low alerts may be triggered too late.

Run Check Level Response to make sure that configured Update Rate is sufficient for the application,
refer to section “Optional setup” on page 73.

Obtain network ID and join key

In order to communicate with the Wireless Gateway, and ultimately the host system, the transmitter
must be configured to communicate on the wireless network. This step is the wireless equivalent of
connecting wires from a transmitter to the host system.

The Network ID and Join Key may be obtained from the Wireless Gateway's integrated web interface on
the Setup > Network > Settings page, as shown in Figure 4-6.

Figure 4-6. Gateway Network Settings

Network Settings
Network name [ryNet
Netwark ID 5485
Security mode in key O Access control list )
Join key L | Y=Y | e | L
Show join key @ v
Generate random join key
Zaethemt protocal Ratate netwaork key? OYes ®No
@ security s 1O
Key rot period (days)  |° ]
O Tim Change networkkey now?  OYes ®No
1 sSystem Backup
@ Page options
{3 Restart Apps
{3 Firmware Upgrade
3 Firmware Optians
" HART
{3 changes
gy Trends
e Feedback e
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4.6.6
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Enter network ID and join key

The devices must be configured with the same Network ID and Join Key as the Gateway in order to join
the network. Use a Field Communicator or AMS Wireless Configurator to enter the Network ID and Join
Key so they match the Network ID and Join Key of the Gateway.

1. Select Configure > Guided Setup > Wireless Setup.
2. Select Join Device to Network, and follow the instructions.

If the device is not to be commissioned yet, remove the power module and fasten the housing cover. This
is to conserve power module life and to ensure safe transmitter transportation. The power module
should be inserted only when the device is ready to be commissioned.

Verify device joins network

Network connection can be verified in four ways, further described in this section:
1. Atthe device display

2. Using the AMS Wireless Configurator

3. Inthe Wireless Gateway's integrated web interface

4. Using the Field Communicator

If the Rosemount 3308 Series was configured with the Network ID and Join Key, and sufficient time has
passed, the transmitter should be connected to the network. It usually takes a few minutes for the device
to join the network. If the device has not joined the network, please see “Wireless network troubleshoot-
ing” on page 92.

Verify by device display

To verify that the device is connected to the network by the display, press the DIAG button. The display
will show: the Tag, Device Serial Number, Software Revision, Network ID, Network Connection Status,
and Device Status screens. Refer to “Diagnostic button screen sequence” on page 78.

When the network diagnostic status is displayed as “NETWK OK”, the device has successfully joined the
network. When joining the wireless network, the status displayed will be changed through the sequence
until the device finally has joined the network. Figure 4-7 on page 69 presents the different network
connection status screens.
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Figure 4-7. Network Connection Status Screens

Network Unknown Network Restarted Network Idle
The device is still in the process of ~ The device has just restarted. The device is starting to join the
being activated. process.

Disconnected from Network  Searching for Network Joining the Network
The device is in a disconnected The device is searching for the The device is attempting to join
state and requires a “Force Join” network. the network.

command to join the network.

Connected butina Connected with Limited Connected

“quarantined” state Bandwidth

The device is connected to the The device is joined and The device has successfully joined
network, butisina “quarantined”  operational, but is running with the network.

state. limited bandwidth for sending

periodic data.
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Verify with AMS Wireless Configurator

Start the AMS Wireless Configurator. When the device has joined the network, it will appear in the AMS
Wireless Configurator window as illustrated in Figure 4-8.

Figure 4-8. AMS Wireless Configurator Screen

i AMS Wireless Configurator - [Device Explorer] M=(E3
x

" File View Tools Window Help
=3 o]

Current Device

=1L AMS Device Manager Ta | Manufacturer [ Device Type [Device Rev_| Protacol | ProtocolRev ||
=I-gig Physical Matworks 102/03(2009 11:20:00,937  Rossmount 30515 WirglessHART 1 HART 7
E‘- USRTC & 02/03/2009 11:32:35.873  Rosemount 648 WirelessHART 1 HART 7

5 Wireless Metwark
=8 Smart Wircless Gateway
gk et

-F05/11/2011 02:00:15.377  Rosemount 70z Discrete Transmitker 3 HART 7

Figure 4-9 presents the different network connection status images that are shown in the AMS Wireless
Configurator Overview screen.

Figure 4-9. Network Connection Status Images

Communications: Communications: Communications:
=)
~ Cretails | G N w
Not Connected Searching Joining
Comrmunications: Communications:
= =
a a
Limited Bandwidth Connected
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Verify by Gateway

To use the Wireless Gateway's integrated web interface, navigate to the Explorer > Status page as shown
in Figure 4-10. This page shows whether the device has joined the network and if it is communicating

properly.

Locate the device in question and verify all status indicators are good (green). It may take several
minutes for the device to join the network and be seen on the Gateway's integrated web interface.

Figure 4-10. Wireless Gateway Explorer Status Page

EMERSON. Smart Wireless Gateway
"’ 192.168.1.10
(7 Disgnostics HART Tag HART ) ost update PV sv ™v Qv Burst
@ monitar status -
EXe oo 2160 Level o L 0.000 ® 13544831z @ 23.000 Degc @ 75020 @ 8
set
i 30815 Pressure ) 0201 go27neo sor® 22,750 0egc @ 22.750 Dege @ sv® e
6081 Conductivity. ° . 0.795 1 @ 23,322 pegc @ 7253v @ 16
sos1pH Y o 0803pH @ 22,822 000 @ -165.002 my @ 7257v @ 16
648 Temperature ) e 22.859 pegc @ nan Dege & 22,500 pege @ 15v® 8
4320 Position (] e 1000 % @ 1000 @ 0000 ®  23000000c @ 4
702 Discrete Y e 1000 @ 0.000 @ 23250 pegc @ 70s3v @ 8
248 Temperature ) . c2os00s0c @ czoeeoegc @ czozeoegc @ cassioegc @ 32
9420 Vibration o . 0023is @ 002295 @ 2501y @ 7.143 v @ o1:00:00
248 Tempersture ° OFEL 22959 00oc @ nawpegc & 22,550 pegc @ 7150 @ 18
708 Acoustic [} oL 6378 counts @ 24.559 Degc @ 22,550 pegc @ samv @ 16
I | s 7 —

Verify with Field Communicator

Connect the Field Communicator as shown in Figure 4-5 on page 66. Do not remove the power module.

Removing the power module may cause the device to drop off the network.

Note

In order to communicate with a Field Communicator, the device must be powered by the power module.

To verify the device has joined the network:

1. Select Service Tools > Communications.

2. Select Join Status.
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4.7 Configure device using guided setup
4.7.1 Connect to device
Connect to the device using your preferred configuration tool, as shown in Figure 4-11 and Figure 4-12.
AMS Wireless Configurator: Field Communicator:
a. Start AMS Wireless Configurator. m Turn on the Field Communicator and connect to the
b. Select View > Device Connection View. device.

c. Double click the device under the HART modem.

Figure 4-11. Connect to Device - Point-to-Point

A. Communication terminals C. HART Modem
B. Field Communicator

Figure 4-12. Connect to Device - Wirelessly

A. Wireless Gateway
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4.7.2

4.7.3

Configuration

Basic setup

All Basic Setup parameters are described in the section “Configuration parameters” on page 161.

Figure 4-13. Guided Setup Screen

551_ 012972013 15:49:01.050 [3308 Guided Wave Radar Level and Interface Transmitter Rew

File Actions Help
%
Guided Set
Configure  a
= @ Configure
Initial St
= Guided Setup IETE ST
o Manual Setup Basic Setup
------- Alert Setup
Verify Level ‘
Wireless Setup
Join Device to Mebwark ‘
Corfigure Update Rate ‘
Cptional Setup
Yalume Setup ‘
Display Setup ‘
m Overview Echo Tuning ‘
Configure Check Level Response ‘
x Service Tools
Time: | Current j
Device last synchronized: 2013-01-30 11:42:16

1. Select Configure.
2. Select Guided Setup > Initial Setup.

3. Select Basic Setup, and follow the instructions.

Optional setup

Consider Optional Setup such as Volume, Device Display, Echo Tuning, and Check Level Response, found
in the Guided Setup. Run Check Level Response to review the maximum level change between updates
with the current configuration.

1. Select Configure.
2. Select Guided Setup > Optional Setup.
3. Select the desired Optional Setup, and follow the instructions.

Additional configuration parameters are available in the Manual Setup menu. For further information
about the parameters see “Configuration parameters” on page 161.
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Verify level

Run the Verify Level tool to match the product level reported by the device to a reference measurement
(measured by using for example handgauging). If any difference, the Calibration Offset parameter will be
adjusted as shown in Figure 4-14.

A minor adjustment using Calibration Offset is normal. There may, for example be a deviation between
the actual tank height and the configured value.

Non-metallic (e.g. plastic) vessels and installation geometry may introduce an offset for the Upper
Reference Point. This offset may be up to + 2 in. (50 mm). The offset can be compensated for using
Calibration Offset.

Note
Before running Verify Level, make sure the product surface is calm, the tank is not being filled or
emptied, and the actual level is well above the probe end.

To run Verify Level:
1. Select Configure.
2. Select Guided Setup > Initial Setup.

3. Select Verify Level to check your level measurement, and follow the instructions.

Figure 4-14. Calibration Offset

dihvain

Positive Calibration Offset value
Negative Calibration Offset value
Reported level

Actual level

oONnw>
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Section 5 Operation
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Check device status

5.1

Operation

Safety messages

Instructions and procedures in this section may require special precautions to ensure the safety of the
personnel performing the operations. Information that potentially raises safety issues is indicated by a

warning symbol (A\). Refer to the following safety messages before performing an operation preceded
by this symbol.

Explosions could result in death or serious injury.

= Verify that the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

= Installation of device in an explosive environment must be in accordance with appropriate local,
national and international standards, codes, and practices.

m Ensure device is installed in accordance with intrinsically safe or non-incendive field practices.

Electrical shock can result in death or serious injury.
= Ground device on non-metallic tanks (e.g. fiberglass tanks) to prevent electrostatic charge build-up.

= Single lead probes are sensitive for strong electromagnetic fields and therefore not suitable for
non-metallic tanks.

= Care must be taken during transportation of power module to prevent electrostatic charge build-up.

m Device must be installed to ensure a minimum antenna separation distance of 8 in. (20 cm) from all
persons.

Process leaks could result in death or serious injury.
= Handle the transmitter carefully.

m If the process seal is damaged, gas could escape from the tank when removing the transmitter head
from the probe.

= Only qualified personnel should install the equipment.
= Do not remove the transmitter while in operation.
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To ensure long life for your radar transmitter, and to comply with hazardous location installation
requirements, tighten covers on both sides of the electronics housing.

ACAUTION

This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: This
device may not cause harmful interference. This device must accept any interference received, including
interference that may cause undesired operation. This device must be installed to ensure a minimum
antenna separation distance of 20 cm (8 in.) from all persons.

Operation
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5.2.1

Operation

Device display screen messages

The device display can be used to present different variables and a diagnostic screen sequence.

Variable screens

If the Display Mode is set to Periodic, the device display shows a periodic sequence of user-chosen
variables during operation. A new screen appears according to configured wireless update rate. The
device display will also show ALERT PRESNT if at least one alert is present. For information on how to
configure the device display, see “Device display” on page 165.

The Rosemount™ 3308 Series Transmitter can display the following variables:

Figure 5-1. LCD Display Variables

Percent of Range Level Distance
Total Volume Interface Distance Interface Level

Upper Product Thickness Electronics Temperature Supply Voltage

Signal Quality

77



Operation Reference Manual
January 2018 00809-0100-4308, Rev CB

5.2.2 Diagnostic button screen sequence

The diagnostic button screen sequence on the device display can be used to obtain detailed diagnostic
information.

1. Unscrew the device display cover.

2. Press and hold the DIAG button until the first diagnostic button screen appears on the device display.
Release the DIAG button.

The device display will now automatically show the diagnostic screens as illustrated in Figure 5-2.
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Figure 5-2. Diagnostic Button Screen Sequence

1. Device Information: Tag

User entered tag which is 8
characters long. This screen will
not display if all characters are
blank.

4. Network ID

Used to determine the entered
Network ID in the device.

7.Variable Screens

At the end of the sequence, the
device display shows all selected
variable screens.

2. Device Serial Number 3. Software Revision
Used to determine Device Serial Used to determine Device
Number. Software Revision.

5. Network Connection Status 6. Active Alert Screens

(if present)
The screen displayed is dependent See “Device display alerts” on
on the progress of the device in page 84 for a full list of Active
joining the wireless network. See Alerts that may appear on this
Figure 4-7 on page 69 for more position of the sequence.

information.

8. Active Alert Present

This screen will only appear if there
is at least one Active Alert present.
For detailed information of the
failure source and recommended
actions, go to the Active Alerts
screen in AMS Wireless
Configurator or Field
Communicator. Refer to “Check
device status” on page 81.
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5.3

5.3.1

5.3.2

5.3.3

80

View measurement values

Measurement values can be viewed using AMS Wireless Configurator and Field Communicator.

View current measurement values

Current measurement data of the Primary Variable (PV) and Secondary Variable (SV) are presented on
the Overview screen. To view all current measurement values:

1. Select Service Tools > Variables.

2. Select the desired group of measurement values to view.

= Toview gauges for the Primary Variable (PV), Secondary Variable (SV), Third Variable (TV) and
Fourth variable (QV), select Mapped Variables.

= To view process values such as Level, Distance, Percent of Range, select Process.
= To view device values such as Electronics Temperature, Supply Voltage, select Device.
= To view Signal Quality, select Signal Quality.

View trends

1. Select Service Tools > Trends.

2. Select to log measurement values eitherin a graph or a table.
= Tolog Level and Interface Level values in a graph, select Level.
m To log Distance values in a graph, select Distance.
= To log Total Volume in a graph, select Volume.
m To log Signal Quality in a graph, select Signal Quality.

= Tolog the trend of 12 data points shown in a table, select Data History, and then select View
Data History. See “Configure data history” on page 166 for information on how to configure
device variable for recording and time between samples.

Note
Values are logged in the trend graphs only as long as the Trends item is selected.

Interpret measurement status bars

A “Good” or “Bad” status next to a value is an indication of the reliability or integrity of the data being
received, not an indication of whether or not the value is within the configured upper or lower ranges. A
value that triggers an alert, such as a high or low temperature indication, will change the overall status of
the device, but the measurement might still be indicated as “Good” if the reliability of the data is good.

Figure 5-3. Measurement Status Bars

L Bad
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Check device status

The overall device status is presented in AMS Wireless Configurator and Field Communicator under the
Overview screen. The Rosemount 3308 Series reports diagnostic alerts when there is a device

malfunction. Forinformation on these alerts, see “Alert messages in AMS Wireless Configurator and Field
Communicator” on page 86. The device can also be configured to report user defined alerts based on the
measured variables, see “Alert setup” on page 172 for more information.

To check device status and see whether there are any Active Alerts reported, do one of the following:

m The overall device status is presented in the Overview screen. If status is anything than Good, select the
button in the device status image to open a window with Active Alerts. The different device status
images can be found in Table 5-1.

m Active Alerts can also be obtained via Service Tools > Alerts > Active Alerts.

Table 5-1. Presentation of Device Status Images

Device status image

Condition

Device:

ﬁ

Good: No active alert.

Device:
Failed

©

Failed: At least one Failure Alert is active. Click the Troubleshoot
button to open a window with Active Alerts together with
recommended actions.

Device:

A, Investigate |

Maintenance: At least one Maintenance Alert is active (and no Failed
alerts). Click the Investigate button to open a window with Active
Alerts together with recommended actions.

Device:

@ Advisory

Advisory: At least one Advisory Alert is active (and no Failed or
Maintenance Alerts). Click the Investigate button to open a window
with Active Alerts together with recommended actions.
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Section 6 Service and Troubleshooting

SaAfEtY MBS SAGES . o vttt ettt e e e page 83
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Service and troubleshooting tools ...... ... ... i e page 93
Application challenges ... page 100
Power module replacement . ...t e page 106
Transmitter head replacement . ... ... page 108
Probe replacement . ...t page 109
S IVICE SUP PO o ettt et e et et page 110
6.1 Safety messages

Procedures and instructions in this section may require special precautions to ensure the safety of the
personnel performing the operations. Information that raises potential safety issues is indicated by a
warning symbol (A). Refer to the following safety messages before performing an operation preceded
by this symbol.

Failure to follow safe installation and servicing guidelines could result in death or serious

injury.

m Make sure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

m Use the equipment only as specified in this manual. Failure to do so may impair the protection
provided by the equipment.

Electrical shock can result in death or serious injury.

= Ground device on non-metallic tanks (e.g. fiberglass tanks) to prevent electrostatic charge
build-up.

= Single lead probes are sensitive for strong electromagnetic fields and therefore not suitable for
non-metallic tanks.

m Care must be taken during transportation of power module to prevent electrostatic charge
build-up.

m Device must be installed to ensure a minimum antenna separation distance of 8 in. (20 cm) from
all persons.

= Probes covered with plastic and/or with plastic discs may generate an ignition-capable level of
electrostatic charge under certain extreme conditions. Therefore, when the probe is used in a
potentially explosive atmosphere, appropriate measures must be taken to prevent electrostatic
discharge.
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Explosions could result in death or serious injury.

= Verify the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

= Installation of device in an explosive environment must be in accordance with appropriate local,
national and international standards, codes, and practices.

m Ensure device is installed in accordance with intrinsically safe or non-incendive field practices.

Process leaks could result in death or serious injury.

= Only qualified personnel should install the equipment.

= Install transmitter prior to process start-up.

= Install and tighten process connectors before applying pressure.
m Handle the transmitter carefully.

= Do not remove the transmitter while in operation.

= [f the process seal is damaged, gas could escape from the tank when removing the transmitter
head from the probe.

To ensure long life for your radar transmitter, and to comply with hazardous location installation
requirements, tighten covers on both sides of the electronics housing.

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution of components
etc., may also jeopardize safety and is under no circumstances allowed.

ACAUTION

Use caution when handling the Power Module. The Power Module may be damaged if dropped from
heights in excess of 20 ft. (6 m).

This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: This
device may not cause harmful interference. This device must accept any interference received, including
interference that may cause undesired operation. This device must be installed to ensure a minimum
antenna separation distance of 20 cm (8 in.) from all persons.

Alert messages

Device display alerts

The following active alert screens will show the device diagnostics depending on the state of the device.

If the device display shows ALERT PRESNT but none of the following screens appear, then go to the Active
Alerts screen in AMS Wireless Configurator or Field Communicator for further information.

For detailed information of the failure source and recommended actions, go to the Active Alerts screen in
AMS Wireless Configurator or Field Communicator, see “Alert messages in AMS Wireless Configurator
and Field Communicator” on page 86.

Service and Troubleshooting
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Figure 6-1. Active Alerts Screens

Bandwidth Limited Configuration Warning Configuration Failure Electronics Warning

The device has not yet The device has detected a The device has detected a There is a warning which
received all of the requested configuration error. configuration error. Critical should be addressed but
wireless bandwidth neededto ~ Non-critical operation of the operation of the device may should not affect the device
operate as configured. See device may be affected. be affected. output.

“Wireless network
troubleshooting” on page 92
for recommended actions.

Electronics Failure Radio Failure Sensor Warning Sensor Failure
Anelectronics errorthatcould  The wireless radio has A sensor attached to the A sensor attached to the
impact the device detected a failure or stopped transmitter is degraded. transmitter has failed, and
measurement reading has communicating. Readings from that sensor valid readings from that
occurred. may not be within accuracy sensor are no longer possible.

specifications.

Supply Voltage Low Supply Voltage Failure
The voltage is below the The supply voltage is too low
recommended operating and will affect device
range. Replace the Power operation. Replace the Power
Module, see “Power module Module, see “Power module
replacement” on page 106. replacement” on page 106.
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6.2.2

Communicator

Alert messages in AMS Wireless Configurator and Field

Table 6-1 to Table 6-4 shows list of alert messages that may be displayed in the AMS Wireless
Configurator and Field Communicator.

To view Active Alerts, select Service Tools > Alerts > Active Alerts.

Table 6-1. Failure Alerts (F:)

Message Description Recommended actions
Electronics Failure An electronics error that could impact the 1. Restart the device.
device measurement reading has occurred. 2. Restore the default settings and reconfigure device.
3. If the condition persists, replace the device.
Radio Failure The wireless radio has detected a failure or 1. Restart the device.
stopped communicating. 2. Ifthe condition persists, replace the device.

Critical Power Failure

The supply voltage is too low and will affect
Device Operation.

. Replace the Power Module, see “Power module

replacement” on page 106.

Probe Disconnected

The device cannot detect the probe.

2. Check that the probe connection is dry and clean.
3. Restart level measurements.
4. If the condition persists, replace the device and/or

. Check that the probe connection is properly

tightened.

the probe.

Electronics Temperature
Critical

The internal temperature of the device has
reached critical levels and the integrity of the
device electronics may be compromised.
Environmental temperature should not

. Verify that ambient temperature is within the

specified range. For more information about the
maximum ambient temperature, see “Temperature
limits” on page 117.

See Table 6-2 for a list of detailed
Configuration Errors that may be displayed.

exceed device specifications. 2. Remote mount the transmitter head away from the
process and environmental conditions.
3. Restart the device.
4. If the condition persists, replace the device.
Remote Housing Error The device has detected a problem associated | 1. Correct remote housing configuration to match
with the remote housing. connected remote housing cable.
2. Check remote housing cable.
Configuration Error The device has detected a configuration error. | 1. Click on the Details button for more information.
Reasons may be multiple. 2. Correct the parameter causing the configuration

error.
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Table 6-2. Configuration Error Details (D:)

Message

Description

Recommended actions

Lower Range Value or
Upper Range Value is out
of limits

The lower/upper range value is outside the
lower/upper sensor limits. This is outside the
range where the sensor works properly, hence
the measurement may be unreliable.

1. Check the lower and upper range values in relation
to the sensor limits.

Configured Measurement
Mode not Supported

The configured Measurement Mode does not
work since support has not been purchased.

1. Upgrade the device.

2. Change the Measurement Mode to match, refer to
“Measurement mode” on page 163.

Volume Configuration
Error

The volume cannot be calculated correctly
with the current configuration.

1. Check that the level-volume values in the strapping
table are entered in increasing order, refer to
“Strapping table” on page 171.

2. Check that the number of strapping points to use is
correct.

3. Check size measures in the Volume Setup.

Unsupported Probe and
Nozzle Configuration

Rigid Single Lead 0.5 in [ 13 mm probe is
configured in combination with 1.5 inch
Nozzle. This combination is invalid and results
in unreliable measurement.

1. Install a nozzle with a supported inner diameter and
re-configure transmitter.

Parameter Out of Limits

One or more of the configuration values, in a
set that belongs together, has been changed
and reduced the measurement range of the
device.

1. Check the configured values for Probe Length,
Vapor Dielectric Constant, and Upper Product
Dielectric Constant.

2. Restore default settings and reconfigure the device.

Low Low Level Alert
configuration is invalid

Low Low Level Alerts will not be raised as
expected because of invalid configuration.

1. Check entered limit and deadband valuesin
comparison with entered tank and probe
parameters such as probe length, tank height etc.

Low Level Alert
configuration is invalid

Low Level Alerts will not be raised as expected
because of invalid configuration.

1. Check entered limit and deadband valuesin
comparison with entered tank and probe
parameters such as probe length, tank height etc.

High Level Alert
configuration is invalid

High Level Alerts will not be raised as expected
because of invalid configuration.

1. Check entered limit and deadband values in
comparison with entered tank and probe
parameters such as probe length, tank height etc.

High High Level Alert
configuration is invalid

High High Level Alerts will not be raised as
expected because of invalid configuration.

1. Check entered limit and deadband valuesin
comparison with entered tank and probe
parameters such as probe length, tank height etc.

User Defined Alert
configuration is invalid

User Defined Alerts will not be raised as
expected because of invalid configuration.

1. Check entered limit and deadband values in relation
to the selected variable.

Signal Quality Alert
configuration is invalid

Signal Quality Alerts will not be raised as
expected because of invalid configuration.

1. Check entered limit and deadband values regarding
their range [0.1 - 10.0] and mutual relationship.

No user configuration
errors detected

No user configuration errors detected.
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Table 6-3. Maintenance Alerts (M:)

Message Description

Recommended actions

Supply Voltage Low The supply voltage is low and may affect
Device Operation.

1.

Replace the Power Module, see “Power module
replacement” on page 106.

Electronics Temperature The temperature of the electronics board 1. Verify that ambient temperature is within the
Out of Limits has exceeded the transmitter’s operating operating range.
range. 2. Restart the device.
3. Remote mount the transmitter head away from the
process and environmental conditions.
4. If the condition persists, replace the device.
Level Measurement Lost No valid Level reading. Reasons may be 1. Analyze the Echo Curve for reason and check device
multiple: configuration, especially thresholds, Near Zone,
= No valid surface echo peak in the Maximum Level Rate and settings on the Lost
measuring range. Measurement tab in the Alert Setup.
= Incorrect transmitter configuration. 2. Check d'evu:'e physical installation (for instance probe
contamination).
3. Restart level measurement.
4. Restore default settings and reconfigure the device.
5. If the condition persists, replace the device.
Interface Measurement No valid Interface reading. Reasons may be | 1. Analyze the Echo Curve for reason and check device
Lost multiple: configuration, especially thresholds, false echoes,
= No valid surface echo peak in the Near Zone, Maximum Level Rate and settings on the
measuring range. Lost Measurement tab in the Alert Setup.
® Incorrect transmitter configuration. 2. Check d-eV|c-e physical installation (for instance probe
contamination).
3. Restart measurement.
4. Restore the default settings and reconfigure device.
5. If the condition persists, replace the device.
Low Signal Quality The Signal Quality is below the defined alert | 1. Take action based on your intended use of this alert.
limit. 2. Clean the probe.
3. If no actions were necessary, consider to change the limit.
Capacity Denied The device has failed to acquire the wireless | 1. Obtaining the bandwidth may take some time
communication bandwidth necessary to depending on the configured update rates and other
support the configured update rates. devices in the network. Wait several minutes to see if
the error resolves itself.
2. There may be too many devices attached to the

WirelessHART® network, or the update rates may be
too fast. Try using a different network, or slowing
down the update rate on one or more devices.

PV Out of Limits The primary measurement is outside the
sensor limits and may be unreliable.

1. Bring the system to a safe state.

N

HwW

. Verify that the primary measurement is within

specified limits.

. Restart the device.
. If the condition persists, replace the device.

Non-PV Out of Limits One of the non-primary measurements is
outside the associated sensor limits and
may be unreliable.

N =

. Bring the system to a safe state.
. Verify that all non-primary measurements are within

specified limits.

. Restart the device.
. If the condition persists, replace the device
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Table 6-4. Advisory Alerts (A:)

Message

Description

Recommended actions

Database Memory
Warning

The device has failed to write to the database
memory at some time in the past. Any data
written during this time may have been lost.

1.

u A W N

If logging dynamic data is not needed, this advisory
alert can be safely ignored.

. Restart the device.

. Reconfirm all configuration items in the device.

. Restore default settings and reconfigure the device.
. If the condition persists, replace the device.

Non-Critical User Data
Warning

A user written parameter does not match
expected value.

A W N =

. Restart the device.

. Reconfirm all configuration items in the device.

. Restore default settings and reconfigure the device.
. If the condition persists, replace the device.

Volume Range Warning

The level measurement is outside the
configured volume range.

—_

. Check volume configuration.

Verification Mode Active

The device is in verification mode and is not
reporting actual information.

. If this behavior is not desired, stop verification

mode.

Button Stuck

The button on the Electronics Board is
detected as stuck in the active position.

w N =

. Check the buttons for obstructions.
. If the condition persists, restart the device.
. If the condition persists, replace the device.

HiHi Level Alert

The level is above the defined limit.

A W N =

. Bring the system to a safe state.

. Verify that the level is within specified limits.
. Reconfirm the level alert limit.

. If not needed, disable this alert.

Hi Level Alert

The level is above the defined limit.

A W N =

. Bring the system to a safe state.

. Verify that the level is within specified limits.
. Reconfirm the level alert limit.

. If not needed, disable this alert.

Lo Level Alert

The level is below the defined limit.

A W N =

. Bring the system to a safe state.

. Verify that the level is within specified limits.
. Reconfirm the level alert limit.

. If not needed, disable this alert.

LoLo Level Alert

The level is below the defined limit.

A W N =

. Bring the system to a safe state.

. Verify that the level is within specified limits.
. Reconfirm the level alert limit.

. If not needed, disable this alert.

User Defined Alert

The variable has surpassed the user defined
limit.

N —

. Bring the system to a safe state.
. Verify that the process variable is within user

specified limits.

. Reconfirm the user defined alarm limit.

4. If not needed, disable this alert.

Simulation Active

The device is in simulation mode and is not
reporting actual information.

. If this behavior is not desired, stop simulation

mode.

. If the condition persists, restart level

measurements.
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6.3

Troubleshooting guide

If there is a malfunction despite the absence of alerts, see Table 6.3.1 for information on possible causes

and recommended actions.

The troubleshooting guide contains the following symptoms:

m Incorrect level readings, see page 90.

6.3.1 Incorrect level readings

Incorrect or missing interface level reading, see page 91.
Power module troubleshooting, see page 92.

Device display troubleshooting, see page 92.

Wireless network troubleshooting, see page 92.

Symptom

Possible cause and recommended actions

The level readings do not correspond to a
reference measurement, for example a
handgauged value.

m Check the Tank Height parameter, refer to “Tank height” on

m Check Thresholds, refer to “Adjusting thresholds” on page 94.
m Run Verify Level, see “Verify level” on page 74.
m Check transmitter configuration. Run Basic Setup, refer to “Basic

page 162.

setup” on page 73.

There is no level reading.

m The tank is empty. No action is needed.
m Check Thresholds, refer to “Adjusting thresholds” on page 94.

Level spikes or level is suddenly reported
as full or empty.

m Check the Upper Product Dielectric Constant, see “Upper product
m The transmitter is configured with wrong Probe Type, refer to
m Check Thresholds, see “Adjusting thresholds” on page 94.

m The transmitter has locked on disturbing obstacles at top of the

m The surface is turbulent. Set the Performance Mode to High to get

dielectric constant” on page 163.

“Probe type” on page 162.

tank. See “Handling disturbances at the top of the tank” on
page 102 for recommended actions.

a stable measurement signal, refer to “Noise or weak surface
echoes” on page 106.

Level stuck in full.

m The tank s full. Check the product level.
m Check Thresholds, see “Adjusting thresholds” on page 94.
m The transmitter has locked on disturbing obstacles at top of the

m The transmitter is configured with wrong Probe Type, refer to

m The reference peak is not detected since it is weaker than the

tank. See “Handling disturbances at the top of the tank” on
page 102 for recommended actions.

“Probe type” on page 162.

Reference Threshold. Adjust Reference Threshold to an
appropriate value so that reference peak is not filtered out. Refer
to “Adjusting thresholds” on page 94.

90
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Symptom

Possible cause and recommended actions

Level stuck in measuring range.

m May be caused by a disturbing object in the tank. Read the Echo
Curve and adjust Thresholds, see “Adjusting thresholds” on
page 94.

m Check if the probe is bent and in contact with the tank wall. This
contact causes a false echo reading.

m Heavy coating or contamination on the probe. Clean the probe.

Level stuck in empty.

m Thresholds may be too high, see “Adjusting thresholds” on
page 94.

Level fluctuations (a couple of inches).

m There is too much disturbing noise in the tank (from foam,
splashing etc.). Set the Performance Mode to High to get a stable
measurement signal, refer to “Noise or weak surface echoes” on
page 106.

m There are rapid level changes in the tank. Select a faster Update
Rate, refer to “Configure update rate” on page 67.

m Thin oil layer on top of water that is sometimes detected,
sometimes not. Set the Peak Detection Method to Threshold
Intersection to improve the stability of level measurements in
such applications. Refer to “Resolving thin oil layers” on page 100.

6.3.2 Incorrect or missing interface level reading

Symptom

Possible cause and recommended actions

Incorrect Interface Level reading.

m The Upper Product Dielectric Constant is not correct, see “Upper
product dielectric constant” on page 163.

m Air gap is too big when the Measurement Mode is set to Interface
Level with Submerged Probe. Reduce air gap or switch the
Measurement Mode to Product Level and Interface Level.

Missing Interface Level reading (reported
as NaN).

m The Measurement Mode is set to Product Level. Set Measurement
Mode to Product Level and Interface Level, refer to “Measurement
mode” on page 163.

m The Interface Peak is difficult to detect, because the bottom
product has a low dielectric constant, or the signal is attenuated in
the upper product. Check Thresholds. For more information, see
“Example 2: Interface peak not found” on page 97.

There are two products in the tank, but
only the product surface or interface is
detected.

m The upper product is too thin to be detected. No action is needed.
See “Interface measurements” on page 119 for minimum
interface thickness for different probe types.

m Check Thresholds, see “Adjusting thresholds” on page 94.

There are two products in the tank, but
no readings are reported.

m Check Thresholds, see “Adjusting thresholds” on page 94.

There is only oil in the tank but the
transmitter reports water.

m Check Thresholds, see “Adjusting thresholds” on page 94.

m Make sure the Typical Interface Condition is set to Layer at the
bottom (thin) if you typically have a thin layer at the bottom, see
“Typical interface condition” on page 164.

There is only water in the tank but the
transmitter reports oil.

m Check Thresholds, see “Adjusting thresholds” on page 94.

m Make sure the Typical Interface Condition is set to Layer on Top
(Thin) if you typically have a thin layer at the top, see “Typical
interface condition” on page 164.

Service and Troubleshooting

91




Service and Troubleshooting

January 2018

Reference Manual
00809-0100-4308, Rev CB

6.3.3

6.3.4

6.3.5

92

Power module troubleshooting

Symptom

Possible cause and recommended actions

The Power Module seems to run out of
battery very fast.

m Consider Update Rate, refer to “Configure update rate” on
page 67. Selecting a fast update rate has an impact on Power
Module life.

m Consider Performance Mode, refer to “Performance mode” on
page 167. The Power Module life is reduced if Performance Mode
is set to High.

m Check that Power Mode is set to Normal, see “Power mode” on
page 167.

m Verify device is not installed in extreme temperatures.

m Verify that device is not a network pinch point.

Device display troubleshooting

Symptom

Possible cause and recommended actions

The device display is not functioning.

m Display Mode is set to Disabled. Set Display Mode to On Demand
or Periodic, refer to “Display mode” on page 165.

m Reseat the device display according to “Utilize the device display”
on page 56.

Wireless network troubleshooting

Symptom

Possible cause and recommended actions

The device is not joining the wireless
network.

m Verify Network ID and Join Key. The Network ID and Join Key in the
device must match the Network ID and Join Key of the Gateway,
refer to “Obtain network ID and join key” on page 67 and “Enter
network ID and join key” on page 68.

m Enable High Speed Operation on the Wireless Gateway.
m Check Power Module.

m Verify that Active Advertising has been enabled on the Wireless
Gateway.

m Verify device is within range of at least one other wireless device or
the Wireless Gateway, see “Network join details” on page 99.

m Verify device is configured to join. Send the “Join Now” command
to the device, see “Network join details” on page 99.

m Seethe Troubleshooting section in the Gateway Reference Manual
for more information.

Limited Bandwidth error

m Reduce the Update Rate on transmitter, refer to “Configure
update rate” on page 67.

m Increase communication paths by adding more wireless points.

m Check that device has been online for at least an hour.

m Check that device is not routing through a “limited” routing node.
m Create a new network with an additional Wireless Gateway.
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6.4

Service and troubleshooting tools

This section briefly describes tools and functions in the AMS Wireless Configurator and Field

Communicator which may be useful for service and troubleshooting of Rosemount™ 3308 Series

Transmitter.

6.4.1

Reading the echo curve

The AMS Wireless Configurator and Field Communicator have powerful tools for advanced troubleshoot-

ing. By using the Echo Curve function you get a view of the tank signal. Measurement problems can be
solved by studying the position and amplitude of the different peaks.

To read the echo curve:

1. Select Service Tools > Echo Tuning > Echo Curve.

2. AMS Wireless Configurator: In the dialog box, select Next > to start reading the echo curve. The

reading may take several minutes.

Field Communicator: Select Echo Curve Graph and follow the on-screen instructions. The reading may
take several minutes.

Figure 6-2. Echo Curve Plot in AMS Wireless Configurator
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Adjusting thresholds

Measurement with the Rosemount 3308 is based on the fact that the radar signal pulses are reflected by
the product surface and the interface between two liquids. Signal amplitude thresholds are used to
separate the measurement signal from disturbing echoes and noise.

By default, the amplitude thresholds are automatically adjusted to appropriate values in order to filter
out noise and other non-valid measurements from the measurement signal, as illustrated in Figure 6-3.
The configured Upper Product Dielectric Constant is used for setting the automatically calculated
amplitude thresholds. Normally no other threshold adjustment is needed. But if the transmitter still does
not track for example the product surface, it may be necessary to manually adjust the thresholds.

Figure 6-3. Threshold Principle
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A. The echo peakis below the threshold (dotted line) and is suppressed by the device.

B. This echo peak is interpreted as the product surface, since it is the first peak closest to device that is above the surface
threshold.

C. Threshold

The different amplitude thresholds used for the Rosemount 3308 Series Transmitter are described in
section “Thresholds” on page 176.

Note

Before changing the amplitude thresholds, check that the Upper Product Dielectric Constant parameter
is set as accurately as possible. The Upper Product Dielectric Constant is used for setting the
automatically calculated amplitude thresholds.
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Guidelines for setting the surface threshold

Before changing the Surface Threshold, make sure the product level is at least 20 in. (0.5 m) from the
lower side of the device flange.

m Set the Surface Threshold to about 1/3 of the weakest surface echo amplitude in the measuring range.

Surface echo

DE

Surface Threshold

NN

AMPLITU
o

About 1/3 of surface
echo amplitude

0 DISTANCE

m Surface Thresholds should never be set to values less than 4 Cnts.

m Make sure to include a 3 Cnts margin between the Surface Threshold and the surface echo amplitude
over the entire measuring range.

Surface echo

DE

Surface Threshold

NN

AMPLITU
o

0 DISTANCE

m The Surface Threshold should be at least 3 Cnts greater than the amplitude of disturbances.

Surface echo

Disturbance
Surface Threshold

AMPLITUDE
o

_fAt least 3 Cnts margin

S\

~——"

0 DISTANCE

Contact your local Emerson™ representative if the transmitter is still having difficulties to track the
product surface after applying the guidelines.
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Guidelines for setting the interface threshold

m The Interface Threshold should be approximately 50% of the interface signal amplitude.
m If possible, Interface Threshold should be higher than Surface Threshold.

Procedure for adjusting thresholds

To adjust the amplitude thresholds:

1. Read the Echo Curve.
a. Startthe Echo Curve reading, refer to “Reading the echo curve” on page 93.
b. View the Echo Curve plot and check the relation between amplitude threshold and
corresponding signal amplitude peak.
2. Adjust the Threshold.
a. Select Service Tools > Echo Tuning > Thresholds.
b. Under Threshold Control, select User Defined.
c. Ifusing Field Communicator, select Send. The Threshold values can now be changed.
d. Select desired Threshold to adjust, type the new value into the box, and then select Send. See
also “Guidelines for setting the surface threshold” on page 95.
Restore default thresholds
1. Select Service Tools > Echo Tuning > Thresholds.

2. Under Threshold Control, select Default (Automatic), and then select Send.
Example 1: Product surface peak not found

If the transmitter does not track the product surface correctly, it may be necessary to adjust the
threshold values. In Figure 6-4, the Surface Threshold is too high and as a result the product level will not
be detected. In a situation like this, the Surface Threshold has to be lowered so that the surface peak is
not filtered out.

Figure 6-4. Surface Threshold Is Too High
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A. Surface Threshold is above the Product Surface peak.
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If there are disturbing objects in the tank, the Surface Threshold must be carefully set to avoid locking on
the wrong amplitude peak. In Figure 6-5, the Surface Threshold is too low, and as a result the transmitter
has locked on a peak above the actual product surface. A disturbance was interpreted as the product
surface, since this was the first amplitude peak closest to device that went above Surface Threshold. The
actual product surface was interpreted as the interface or the probe end.

Figure 6-5. Surface Threshold Is Too Low
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By adjusting the Surface Threshold the product surface is properly detected as illustrated in Figure 6-6.

Figure 6-6. Echo Curve Plot after Surface Threshold Was Adjusted
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A. After Surface Threshold is adjusted the product surface is correctly detected.

Example 2: Interface peak not found

Ininterface applications where the bottom product has a relatively low dielectric constant (<40), orif the
signal is attenuated in the upper product, the amplitude of the reflected signal from the interface is
relatively low and difficult for the transmitter to detect. In such a case it may be possible to detect the
reflected signal from the interface if the Interface Threshold is adjusted.

Figure 6-7 illustrates a situation where the Interface Threshold is too high. The signal amplitude peak at
the interface between the upper and lower products is not detected in this case.
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Figure 6-7. Echo Curve Plot Indicating that the Interface Threshold for the Interface Peak Is Too
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By adjusting Interface Threshold, the peak at the interface between the upper and lower products is
detected as illustrated in Figure 6-8.

Figure 6-8. After Changing the Interface Threshold the Transmitter Detects the Interface
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A. Surface Threshold
B. AfterInterface Threshold is adjusted the interface is correctly detected.

Viewing measurement history

The Measurement History tool presents historical values and related device status that are stored in the
transmitter memory. The tool is useful for verifying that the transmitter works properly or to diagnose
any issues during a specific time interval.

1. Select Service Tools > Maintenance > Routine Maintenance.

2. Select Measurement History and follow the on-screen instructions.
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6.4.4

6.4.5

Reviewing network join status and details

Network join status

Wireless devices join the network through a four step process:
Step 1. Network Found

Step 2. Network Security Clearance Granted

Step 3. Network Bandwidth Allocated

Step 4. Network Join Complete

To view the Network Join Status of the device:
m Select Service Tools > Communications > Network Join Status.

Network join details

Obtain detailed information about the network join, and configure how the device attempts to join the
network.

= Select Service Tools > Communications > Join Details.

Table 6-5. Network Join Details

Term Description
Join Mode This mode configures how the device attempts to join the network. Settable
options are:

® Don't Attempt to Join
® Join Now

® Join on Powerup or Reset

Number of Available Defines how many wireless devices are within the communication range of this

Neighbors device. In a self-organizing network, the more neighbors a device has, the more
robust the network will be.

Number of Number of advertised packets received by the device from all networks within

Advertisements Heard range.

Number of Join Attempts Number of times the device has tried to join the network prior to being accepted.
Too many join attempts result in the device considering the join attempt as failed. If
this happens, re-check the Join Key and Network ID.

Locating the device

Use the Locate Device function to identify this device by showing a pattern on the device display, as
illustrated in Figure 6-9.

1. Select Service Tools > Maintenance > Routine Maintenance.

2. Select Locate Device and follow the on-screen instructions.
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6.4.7

6.5
6.5.1

100

Figure 6-9. Locate Device Pattern

Using the simulation mode

This function can be used to simulate measurements and alerts.
1. Select Service Tools > Simulate.

2. Select desired variable and follow the on-screen instructions.

Using the verification method

The Verification method is used to verify distance measurement with the Rosemount VeriCase.
1. Select Service Tools > Maintenance > Routine Maintenance.
2. Select Verification and follow the on-screen instructions.

Refer to the Rosemount VeriCase User Guide for instructions on how to use the mobile verification tool.

Application challenges

Resolving thin oil layers

Thin oil layer on top of water might cause jumpy surface readings. Because of the thin oil layer, the
transmitter varies between detecting oil and water. Sometimes the oil layer gets too thin to be detected.
See Figure 6-10.

Figure 6-10. Thin Oil Layer on Top of Water, Peak Detection Method Set to Peak Center
B E
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The surface readings in such applications will be stabilized by setting the Peak Detection Method to
Threshold Intersection. The point used for level measurement is then changed, see Figure 6-11. Note
that this configuration should only be performed by advanced users as it could cause issues if configured
incorrectly.

Figure 6-11. The Different Peak Detection Methods

/

A

A. Threshold Intersection: Surface detected at first intersection with Surface Threshold
B. Peak Center
C. Surface Threshold

To set the Peak Detection Method to Threshold Intersection:
1. Select Service Tools > Echo Tuning > Advanced.
2. Under Peak Detection Method, select Threshold Intersection, and then click Send.

3. Run Verify Level to compensate for any offset error (see Figure 6-12) introduced by the Threshold
Intersection method. See “Verify level” on page 74 for further instructions.

Figure 6-12. Thin Oil Layer on Top of Water, Peak Detection Method Set to Threshold Intersection

Surface detected at first intersection with Surface Threshold, even when there is an oil peak
Actual product surface is ignored

Surface Threshold

Offset error
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6.5.2 Handling disturbances at the top of the tank

Adjusting the near zone threshold

The Near Zone Threshold is used to filter out disturbing echoes and noises at the top of the tank. By
default, this threshold is automatically calculated by the device, and is sufficient in most conditions.

However, in the case of unfavorable conditions, you might need to manually set the Near Zone
Threshold. This may for example be the case if a Single Lead probe is mounted in a narrow nozzle, if the
end of the nozzle protrudes into the tank, or if there are disturbing obstacles in the Near Zone (referred
to as the region between 0-3.3 ft. (0-1 m) below the Upper Reference Point.

Figure 6-13. Near Zone Threshold
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A. Reference Peak D. Near Zone Threshold blocking the disturbance
B. Disturbance E. Surface Threshold
C. Product Surface Peak

Guidelines for setting the near zone threshold

= The Near Zone Threshold must be higher than the Surface Threshold to have an effect. The threshold
in the near zone is set to the highest value of the configured Near Zone Threshold and Surface
Threshold.

m The margin to waveform disturbances and noise must be at least 3 Cnts.
Procedure
To manually set the Near Zone Threshold function:

1. Read the Echo Curve.
a. Startthe Echo Curve reading, refer to “Reading the echo curve” on page 93.
b. View the Echo Curve plot to find out if there are disturbing echoes close to the tank top.
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2. Set the Near Zone Threshold.
a. Select Service Tools > Echo Tuning > Near Zone > Near Zone Threshold.
b. Under Threshold Control, select User Defined.

c. Ifusing Field Communicator, select Send. The Threshold and End Distance values can now be
changed.

Under Threshold, type the desired value into the box.
Under End Distance, type the desired value into the box. This value is the distance from Upper

Reference Point to point where the Near Zone Threshold ends.
Using the trim near zone function

The Trim Near Zone function is used to fine tune performance in the area close to the tank top. Normally
it is not necessary to use the function, but if you experience problems related to the nozzle, pipe, or
chamber installation, you may need to use this function.

Figure 6-14 describes the Trim Near Zone function and its effect on the echo curve. This effect is only
visible if measurement conditions so require.

Figure 6-14. Echo Curve before and after Trim Near Zone
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Note
Make sure the product level is below the Near Zone region (0-3.3 ft. (0-1 m) below the Upper Reference
Point) before performing the Trim Near Zone.

Note
The Trim Near Zone function should only be used for reducing impact from stationary disturbances. For
occasional disturbances, use the Near Zone Threshold.

To use the Trim Near Zone function:
1. Select Service Tools > Echo Tuning and click Near Zone.

2. Under Near Zone Compensation, select Trim Near Zone and follow the on-screen instructions.
Changing the upper null zone

Measurements are not performed within the Upper Null Zone (UNZ). The Upper Null Zone can be
extended to block out disturbing echoes close to the tank top, caused by for example a narrow nozzle
with rough walls, obstacles close to the probe, or a nozzle that protrudes into the tank. See Figure 6-16.
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Note
Desired measuring range must be below the Upper Null Zone.
Note
Before changing the Upper Null Zone, check entered limit and deadband values for the High Level Alerts.
High Level Alerts should not be placed in the Upper Null Zone.
To set the Upper Null Zone:
1. ldentify desired Upper Null Zone using the Echo Curve plot.
a. Startthe Echo Curve reading, refer to “Reading the echo curve” on page 93.
b. View the Echo Curve plot to find out if there are disturbing echoes close to the tank top.
2. Set the desired Upper Null Zone value.
a. Select Configure > Manual Setup > Level Setup > Probe > Advanced Probe Options.
b. Under Upper Null Zone, type the desired value into the box, and then select Send.
Figure 6-15. Upper Null Zone
A. Upper Reference Point
B. UpperNull Zone
C. Measurement Range
Figure 6-16. Upper Null Zone Is Extended to Block Out Disturbances at the Top of the Tank
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6.5.3 Interface measurements with fully submerged probes

The Measurement Mode Interface Level with Submerged Probe is used to handle interface
measurements when the product level is not visible, for example in a full chamber pipe as illustrated in
Figure 6-17. In this case the probe is fully submerged into the upper product, and only the interface level
is detected by the transmitter.

Even if the upper product level drops, it is ignored by the transmitter which continues to measure only
the interface level. If the product level drops, the air filled region in the upper part of the pipe will slightly
reduce the measurement accuracy of the interface level. To achieve high accuracy in this Measurement
Mode the probe must be fully submerged.

To set the Measurement Mode to Interface Level with Submerged Probe:
1. Select Configure > Manual Setup > Level Setup > Environment.

2. Under Measurement Mode, select Interface Level with Submerged Probe (Interface Only in Field
Communicator), and then select Send.

Note
Do not set Measurement Mode to Interface Level with Submerged Probe in “standard” applications
when both Product Level and Interface Level are measured.

Figure 6-17. Interface Level Measurements in a Full Chamber
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Note
Adjust Interface Threshold if the interface level pulse is not detected.
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6.5.4 Noise or weak surface echoes

In difficult applications where the surface echo peak is low compared to the noise, it is recommended to
set the Performance Mode to High Performance. A low surface peak compared to the noise might be
caused by a turbulent surface, foam, low dielectric constant, plastic tanks, and so on.(")

If the Performance Mode is set to High Performance, each update is based on an increased number of
measurements (radar sweeps), which gives improved accuracy and robustness, as well as decreased
noise in the output value. However, the battery life is significantly reduced (between 40-60 percent).

1. Select Service Tools > Echo Tuning > Advanced.

2. Under Performance Mode, select High Performance, and then select Send.

6.6 Power module replacement

Replace the power module with a new Black Power Module, SmartPower™ Solutions model number
701PBKKEF.

1. Replace the power module.

Keep cover tight

Dispose of in accordance with
Government regulations

2. In AMS Wireless Configurator or Field Communicator, run Install New Power Module setup.
a. Select Service Tools > Maintenance > Routine Maintenance.
b. Select Install New Power Module and follow the on-screen instructions.

1. The High Performance mode is not supported on all models.
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Handling considerations

The Black Power Module with the wireless unit contains two "C" size primary lithium/thionyl chloride
batteries. Each battery contains approximately 2.5 grams of lithium, for a total of five grams in each
Power Module. Under normal conditions, the battery materials are self-contained and are not reactive as
long as the batteries and the battery pack integrity are maintained. Care should be taken to prevent
thermal, electrical or mechanical damage. Contacts should be protected to prevent premature
discharge.

Use caution when handling the power module. It may be damaged if dropped from heights in excess of
20 ft. (6 m).

/\  Battery hazards remain when cells are discharged.
Environmental considerations

As with any battery, local environmental rules and regulations should be consulted for proper
management of spent batteries. If no specific requirements exist, recycling through a qualified recycleris
encouraged. Consult the Safety Data Sheet (SDS) for battery specific information.

Shipping considerations

The unit was shipped to you without the power module installed. Please remove the power module prior
to shipping.

Each Black Power Module contains two "C" size primary lithium batteries. Primary lithium batteries are
regulated in transportation by the U.S. Department of Transportation, and are also covered by
International Air Transport Association (IATA), International Civil Aviation Organization (ICAO), and
European Ground Transportation of Dangerous Goods (ARD). It is the responsibility of the shipper to
ensure compliance with these or any other local requirements. Please consult current regulations and
requirements before shipping.
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6.7 Transmitter head replacement

Figure 6-18. Transmitter Head Replacement

Flange version Threaded version

Put the protection ——~ _——8 Put the protection ——~ _——8
plug here! plug here!

—cC
A. Nut
B. Process Seal
C. Adapter

1. Loosen the nut that connects the transmitter head to the process seal.
2. Carefully lift the transmitter head.

3. Onthe probe, make sure that the upper surface of the process seal is clean and free from dust and
water. Wipe it clean with a dry and lint-free cloth.

4. Verify the spring-loaded pin at the center of the process seal is properly inserted. When inserted
properly only the plunger is seen above the edge inside the seal hole.

]

5. If the transmitter head is not mounted directly, attach the protection plug to the process seal to
protect the exposed parts from dust and water. If a protection plug is not available, then cover the
process seal with a plastic bag.

6. Rotate the new transmitter head so the device display faces the desired direction.
7. Tighten the nut. Max torque is 30 Lbft (40 Nm).

8. Configure the transmitter, refer to Section 4: Configuration.
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6.8 Probe replacement

Figure 6-19. Probe Replacement

Flange version Threaded version

D D
A. Transmitter head
B. Nut
C. Process seal
D. Probe

—_

. Loosen the nut.

2. Remove the transmitter head from the old probe. Make sure to protect the transmitter head bottom
from dust and water.

3. Onthe new probe, make sure that the protection plug is removed and the upper surface of the
Process Seal is clean. Also make sure that the spring-loaded pin at the center of the Process Seal is
properly inserted.

4. Mount the transmitter head on the new probe.
5. Tighten the nut. Max torque is 30 Lbft (40 Nm).

6. If the new probe is not of the same type as the old one, update the transmitter configuration by
setting the Probe Type parameter to the appropriate value.
a. Select Configure > Manual Setup > Level Setup > Probe.
b. Under Probe Type, select desired Probe Type.

7. Measure the Probe Length and enter the measured value.
a. Select Configure > Manual Setup > Level Setup > Probe.
b. Under Probe Length, enter the measured Probe Length value.

8. Run Verify Level to check your level measurement, refer to “Verify level” on page 74.
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6.9
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Service support

To expedite the return process outside of the United States, contact the nearest Emerson representative.

Within the United States, call the Emerson Instrument and Valve Response Center using the
1-800-654-RSMT (7768) toll-free number. This center, available 24 hours a day, will assist you with any
needed information or materials.

The center will ask for product model and serial numbers, and will provide a Return Material
Authorization (RMA) number. The center will also ask for the process material to which the product was
last exposed.

ACAUTION

Individuals who handle products exposed to a hazardous substance can avoid injury if they are informed
of and understand the hazard. Returned products must include a copy of the required Safety Data Sheet
(SDS) for each substance.

Emerson Instrument and Valve Response Center representatives will explain the additional information
and procedures necessary to return goods exposed to hazardous substances.

NOTICE

Shipping considerations for wireless products.
The unit was shipped to you without the Power Module installed. Please remove the Power Module prior
to shipping the unit.

Each Power Module contains two "C" size primary lithium/thionyl chloride batteries. Primary lithium
batteries (charged or discharged) are regulated during transportation by the U.S. Department of
Transportation. They are also covered by IATA (International Air Transport Association), ICAO
(International Civil Aviation Organization), and ARD (European Ground Transportation of Dangerous
Goods). Itis the responsibility of the shipper to ensure compliance with these or any other local
requirements. Consult current regulations and requirements before shipping.

Service and Troubleshooting



Reference Manual
00809-0100-4308, Rev CB

Specifications and Reference Data
January 2018

Appendix A

Specifications and Reference Data

Performance specifications

Functional specifications ................
Physical specifications ..................

Ordering information

Spare parts and accessories .............
Dimensional drawings ..................

A.1 Performance specifications
A.1.1 General

Reference conditions

m Probe: Flexible single lead

= Vessel: 4-in. pipe

m Measurement target: Water

m Temperature: 68 to 77 °F (20 to 25 °C)
m Relative humidity: 30-80%

Reference accuracy(!)

» High performance (profile code U):
+0.12in. (+3 mm), when distance <33 ft. (10 m)
+0.03% of measured distance, when distance >33 ft. (10 m)

m Standard (profile code S):

Accuracy

+0.98in.
(25 mm)

+0.25in. !
(6 mm) I
0 1

I
I
I
I
I
T 1
0 33ft.(10m) 56 ft. (17 m)

Measuring distance

Ambient temperature effect

m High performance (profile code U): +0.08 in. (+2 mm)/10 K

m Standard (profile code S): <0.1% of measured distance per
10K

1. Referto the IEC 60770-1 standard for a definition of radar specific
performance parameters and if applicable corresponding test procedure.

Specifications and Reference Data

Electromagnetic interference effect(2)

m External antenna (WK1 option): < £0.25 in. (+6 mm)
m Remote (WN1 option): <+0.2in. (5 mm)

Power module battery life(3)

m High performance: 5 years at one minute update rate
m Standard: 9 years at one minute update rate

A.1.2 Environment

Vibration resistance

No effect when tested per the requirements of IEC60770-1
(1999): High Vibration Level - field or pipeline (10-60 Hz
0.21 mm displacement peak amplitude [ 60-2000 Hz 3g).

Electromagnetic compatibility

m Meets EN61326-1:2013, EN 61326-2-3:2013, and
NE21:2012 if installed in metallic vessels or still pipes.

m For optimal single lead probe performance in
non-metallic tanks, the probe must be mounted with a
metal flange, or screwed in to a metal sheet (d > 14
in./350 mm) if a threaded version is used. See “Installation
in non-metallic tanks and open-air applications” on
page 19 for more information.

Pressure Equipment Directive (PED)

Complies with 2014/68/EU article 4.3

2. Deviation through electromagnetic interference according to EN 61326.

3. Reference conditions are 70 °F (21 °C), and routing data for three additional
network devices.
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Radio approvals

m Radio Equipment Directive (RED) 2014/53/EU
m Part 15 of the FCC Rules
m Industry Canada RSS 211
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A.1.3 Interface measuring range

The maximum allowable upper product
thickness/measuring range is primarily determined by the
dielectric constants of the two liquids.

Typical applications include interfaces between oil/oil-like
and water/water-like liquids, with a low (<3) dielectric
constant for the upper product and a high (>20) dielectric
constant for the lower product. For such applications, the
maximum measuring range is limited by the length of the
coaxial and rigid single lead probes.

For flexible probes, the maximum measuring range is
reduced by the maximum upper product thickness,
according to the diagram below. However, characteristics
may vary between the different applications.

Figure A-1. Maximum Upper Product Thickness for
Flexible Probes

39.4(12)

Lower product
dielectric constant
80
S —T)
——20

----10

32.8(10)

26.2(8)

19.7 (6) 4

13.1(4)

Maximum upper product thickness, ft. (m)

6.6(2) o \

0 T T T T T T T T T T
1 2 3 4 5 6 7 8 9 10 11

Upper product dielectric constant

o Example: With an upper product
dielectric constant of 2, and a

25 ft. lower product dielectric constant
] (7 m) of 20, the maximum upper
DC?2 product thickness is 25 ft. (7 m).
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Table A-1. Measuring Range and Minimum Dielectric Constant

Probe type

Maximum measuring range

Minimum dielectric constant(1(2)

Flexible single lead

55.8 ft. (17 m)

2.0, when distance <32.8 ft. (10 m)
10, when distance > 32.8 ft. (10 m)

Segmented rigid single lead

Rigid single lead probe (0.3-in./8 mm) 9.8 ft. (3 m) 2.0
Rigid single lead probe (0.5-in./13 mm) 19.7 ft. (6 m) 2.0
32.8ft. (10 m) 2.0

Flexible twin lead

55.8 ft. (17 m)

2.0, when distance <32.8 ft. (10 m)
10, when distance >32.8 ft. (10 m)

Coaxial

19.7 ft. (6 m)

2.0

1. Minimum Dielectric Constant may be lower than 2.0 if one or more of the following conditions apply:

- Probe is installed in stilling well or chamber.
- Maximum measuring range is not utilized.

- Noise Threshold is manually adjusted to a lower level.
2. For temperatures above 140 °F (60 °C) manual adjustment of noise threshold may be required for products with low dielectric constant at or close to maximum measuring

range.

Table A-2. Maximum Recommended Viscosity and Contamination/Build-up

Probe type Maximum viscosity Contamination/build-up
Single lead 8000 cP(M) Build-up allowed
Twin lead 1500 cP Thin build-up allowed, but no bridging
Coaxial 500 cP Not recommended
1. Consult your local Emerson™ representative in the case of agitation/turbulence and high viscous products.
2. For viscous or sticky applications, it is not recommended to use centering discs mounted along the probe.
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A.1.4 Accuracy over measuring range

The measuring range depends on probe type, dielectric
constant of the product and installation environment, and is
limited by the Blind Zones at the very top and bottom of the
probe. In the Blind Zones, the accuracy exceeds +1.18 in.
(30 mm), and measurements may not be possible.
Measurements close to the Blind Zones will have reduced
accuracy.

The following conditions will impact the Blind Zones:

m If the single lead probes or twin probes are installed in a
nozzle, the nozzle height shall be added to the specified
Upper Blind Zone.

m The measuring range for the PTFE covered flexible single
lead probe includes the weight when measuring on a high
dielectric media.

Figure A-2, Figure A-3, Figure A-4, and Figure A-5 illustrate
the accuracy over measuring range at reference condition
using the Trim Near Zone function, with alternating probe
types and varying dielectric constant of the product.

Reduced accuracy

7? Reduced accuracy

71 Lower Blind Zone

Note

Measurements may not be possible in the Blind Zones, and
measurements close to the Blind Zones will have reduced
accuracy. Therefore, the alarm points should be configured
outside these zones.

Figure A-2. Accuracy over Measuring Range for Flexible Single Lead Probe

High performance (profile code U)

Water (DC = 80)

£0.12in. £1.18in.
(3mm) (30mm)

__________ ———F+—> Accuracy

0il (DC=2.2)

+0.12in. £1.18in.
(3mm) (30 mm)

3.5in. (9 cm) +
5.9in.(15cm) 4 /
. 13.0in. (33 cm) +
14.6in. (37 cm) +
1 1
1 1
1 1
0.4in.(1cm)
\
3.2in. (8 cm) \ (2821:1:)
3.2in.(8cm)
Blind Zone

———+——> Accuracy

Standard (profile code S)

Water (DC = 80)

+0.25in. £1.18in.
(6mm) (30 mm)

———+——> Accuracy

3.2in. (8 cm) / 43in. (11 cm) +
9.8in.(25cm) + 10.6in. (27 cm) + /

0il (DC=2.2)

+0.25in. £1.18in.
(6 mm) (30 mm)

—+—t

2in.(5cm)

5.1in. (13 cm) (11 cm)

N

4.3in. i
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Figure A-3. Accuracy over Measuring Range for Rigid Single Lead/|Segmented Rigid Single Probes

High performance (profile code U)

Standard (profile code S)

Water (DC = 80) Qil (DC=2.2) Water (DC = 80) Qil (DC=2.2)
£0.12in. £1.18in. +0.12in. £1.18in. +0.25in. £1.18in. +0.25in. £1.18in.
(3mm) (30 mm) (3mm) (30mm) (6 mm) (30 mm) (6mm) (30 mm)
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. 5.7in. . 4.3in.
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Blind Zone

Figure A-4. Accuracy over Measuring Range for Flexible Twin Lead Probe

High performance (profile code U) Standard (profile code S)

Water (DC = 80) Qil (DC=2.2) Water (DC = 80) Qil (DC=2.2)

+0.12in. +1.181in. +0.12in. +1.18in. +0.25in. £1.18in. +0.25in. +1.18in.

(3mm) (30 mm) (3mm) (30mm) (6 mm) (30 mm) (6 mm) (30 mm)
,,,,,,,,,, ———}——» Accuracy ———+——> Accuracy ———F—— Accuracy ——f—
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Figure A-5. Accuracy over Measuring Range for Coaxial Probe

High performance (profile code U)

Water (DC = 80)

+0.12in. +1.18in.

0il (DC=2.2)

+0.12in. £1.18in.
(3mm) (30mm) (3mm) (30 mm)

Standard (profile code S)

Water (DC = 80)

+0.25in. £1.18in.
(6mm) (30 mm)

0il (DC=2.2)

+0.25in. £1.18in.
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- 1 1 1 1
1 1 1 1
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1.2in.(3cm) \ 2in.(5cm) \
U — \
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A.2 Functional specifications  Humidity limits

A.2.1 General

Field of application

Liquids and semi-liquids level or liquid/liquid interfaces

m 3308Axx1... for level or submerged probe interface
measurement

m 3308Axx2... for level and interface measurement
Measurement principle

Time Domain Reflectometry (TDR)

(See “Theory of operation” on page 3 for a description of
how it works)

Microwave output power

Nominal 10 pw, Max <20 mW
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0 to 100% relative humidity

A.2.2 Wireless

Output

IEC 62591 (WirelessHART®) 2.4 GHz
Transmit rate

User selectable, 4 seconds to 60 minutes
Frequency range

2400 - 2483.5 MHz

Radio frequency output from antenna

= External antenna (WK option): < 10 mW (+10dBm) EIRP
= Remote (WN option): <40mW (16dBm) EIRP

Specifications and Reference Data



Reference Manual
00809-0100-4308, Rev CB

Specifications and Reference Data
January 2018

Modulation type

QPSK/iEEE 802.15.4 [EC 62591 (WirelessHART)
Number of channels

15

Channel spacing

5 MHz

Emission designation

G1D

A.2.3 Display and configuration
LCD display

m Toggles between selected output variables
m Shows diagnostic information (alerts)
m Display updates at each wireless update

Table A-3. Output Variables

Figure A-6. Device Display

Output units

m Level, Interface, and Distance: ft, inch, m, cm, or mm

m Volume: ft3, inch3, US gals, Imp gals, barrels, yd3, m3, or
liters

m Temperature: °F, °C

Specifications and Reference Data

LCD display | PV, SV, TV, QV
Level v v
Distance v v
Surface Signal Strength N/A v
Total Volume v v
Interface Level() v v
Interface Distance(") v v
Interface Signal Strength(") N/A v
Upper Product Thickness® 4 v
Electronics Temperature v v
Signal Quality v v
Supply Voltage v v(2)
% of Range v v
1. E?ggg'os/xm, Interface measurement is only available for fully submerged

2. Notavailable as primary variable.
3. Only available with 3308Axx2.

HART diagnostics

Signal Quality Metrics - Diagnostics package that monitors
the relations between surface, noise and threshold. The
function can be used to detect abnormal conditions in the
process such as probe contamination or sudden loss of
signal strength. Signal Quality is available as Output Variable
and it comes with user configurable alerts through AMS
Wireless Configurator or Field Communicator.

A.2.4 Temperature limits

Ambient and storage temperature
limits

Verify that the operating atmosphere of the transmitter is
consistent with the appropriate hazardous locations
certifications, see Appendix B: Product Certifications.

Table A-4. Ambient Temperature Limits

Operating limit

Storage limit

(-40 to 85 °C)

i : -40t0 175°F -40t0 185°F
With LCD DISP|ay (_40 to 80 oC)(‘]) (_40 t0 85 °C)
Without LCD Display | 40 t0 185°F -40t0 185 °F

(-40 to 85 °C)

1. LCDdisplay may not be readable and device display updates will be slower at
temperatures below -4 °F (-20 °C).
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A.2.5 Process temperature and
pressure rating

Figure A-7 gives the maximum process temperature
(measured at the lower part of the flange or threaded
connection) and pressure rating.

Final rating depends on flange, material of construction, and
O-ring selection.

Figure A-7. Max. Rating, Standard Tank Connections

Pressure psig (bar)

580 (40)
---- PTFE covered probe and
flange (model code 7)
232(16) - --mrmrmrmm oo
1401 Temperature °F (°C)
"1 302
(40) (150)

Table A-5. Temperature Ranges for Standard Tank Seals
with Different O-ring Materials

Duplex 2205 (UNS S31803) flanges according to ASME
B16.5 Table 2-2.8:

m Max. 302 °F/580 psig (150 °C/40 bar)
EN

EN 1.4404 according to EN 1092-1 material group 13EO:
= Max. 302 °F/580 psig (150 °C/40 bar)

Alloy C-276 (UNS N10276) flanges according to EN 1092-1
material group 12EOQ:

= Max. 302 °F/580 psig (150 °C/40 bar)

Duplex 2205 (EN 1.4462) flanges according to EN 1092-1
material group 16EOQ:

m Max. 580 psig (40 Bar), -22 °F (-30 °C) up to max 302 °F
(150 °C)™M

Jis

316L SST Flanges according to |IS B2220 material group 2.3:
= Max. 302 °F/580 psig (150 °C/40 bar)

Fisherand Masoneilan™

316L SST Flanges according to ASME B16.5 Table 2-2.3:

Note

Always check the chemical compatibility of the O-ring
material with your application. If the O-ring material is not
compatible with its chemical environment, the O-ring may
eventually malfunction.

A.2.6 Flange rating
ASME

316L SST flanges according to ASME B16.5 Table 2-2.3:
= Max. 302 °F/580 psig (150 °C/40 bar)

Alloy C-276 (UNSN10276) flanges according to ASMEB16.5
Table 2-3.8:

= Max. 302 °F/580 psig (150 °C/40 bar)
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O-ring material Temperature °F (°C) in air m Max. 302 °F/580 psig (150 °C/40 bar)
Minimum Maximum Table A-6. Tri Clamp Rating
Viton® Fluoroelastomer 5(-15) 302 (150) Size Maximum pressure (bar)(")
Ethylene Propylene (EPDM) | -40 (-40) 266 (130) 1%-in. (37.5 mm) 16
® .
Kalrez® 6375 14(-10) 302 (150) 2-in. (50 mm) 16
Perfluoroelastomer
3-in. (75 mm) 10
Nitrile Butadiene (NBR) -31(-35) 230(110)
4-in. (100 mm) 10

1. Thefinal rating depends on the clamp and gasket.

A.2.7 Plate design

Certain models of flanged alloy and PTFE covered probes

have a tank connection design with a protective flange plate
of the same material as the probe and with a backing flange
in 316L/EN 1.4404. The protective flange plate prevents the
backing flange from being exposed to the tank atmosphere.

Flange rating according to SST backing flange ASME B16.5
Table 2-2.3, EN 1092-1 material group 13E0, and |IS B2220
material group 2.3.

PTFE protective plate:
m Max. 302 °F/232 psig (150 °C/16 Bar)

1. Minimum temperature limit due to EN13445-2.
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Alloy C-276 and Alloy 400 protective plate:
= Max. 302 °F/580 psig (150 °C/40 Bar)

A.2.8 Interface measurements

The Rosemount™ 3308 Series is well suited for interface
measurements, including applications where the probe is
fully submerged in the liquid.

Figure A-8. Interface Level Measurement

¢

Product Level

Interface Level

Interface Measurement Interface Measurement with
fully submerged probe

If interface is to be measured, follow these criteria:

m The dielectric constant of the upper product should be
known and should not vary. The AMS Wireless
Configurator and Field Communicator have a built-in
Dielectric Constant Guide to assist users in determining
the dielectric constant of the upper product.

m The dielectric constant of the upper product must have a
lower dielectric constant than the lower product to have a
distinct reflection.

= The difference between the dielectric constants for the
two products must be larger than 10.

= Maximum dielectric constant for the upper productis 10
for the coaxial probe, and 5 for the single lead and flexible
twin lead probes.

= Minimum detectable upper product thicknessis 4 in. (10
cm) when the upper product is oil (DC=2.2) and the lower
product is water (DC=80).

For guidelines on emulsion situations, consult your local
Emerson representative.

For additional information, see the Guided Wave Radar
Interface Measurement Technical Note.

Specifications and Reference Data
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A.2.9 Conditions used for flange strength calculations

Table A-7. 316 SST or Process Connection with Strength Calculations

Standard | Bolting material Gasket Flange material Hub material

Soft (1a) with min. thickness

ASME Stainless steel SA193 B8M Class 2 :
1.6 mm Stainless steel A182 Gr. F316L gﬁas'flsf]?tee' SA479M
Nwith | and EN 10222-5-1.4404
EN, IS EN 1515-1/-2 group 13€0, A4-70 | 2°TL(EN 1514-T) with min. EN 10272-1.4404
thickness 1.6 mm

Table A-8. Alloy C-276

Standard | Bolting material Gasket Flange material Hub material
ASME ?ogtﬂa)with min. thickness | sg462 Gr. N10276 (solution
UNSN10276 annealed condition) or SB574 Gr. N10276

Soft (EN 1514-1) with min. SB575 Gr. N10276 (solution

EN, JIS thickness 1.6 mm annealed condition)

Table A-9. Duplex 2205

Standard | Bolting material Gasket Flange material Hub material

ASME A193B7 or A320 L7 Soft (1a) with min. thickness | Duplex stainless steel Stainless steel SAA7IM
1.6 mm SA/A182F51 and

S31803 and
Soft (EN 1514-1) with i EN10222-5-1.4462 EN. JIs Bumax 88 EN
® ort -1)withmin. | or SA/A240 Gr. $31803 and ’
FL 5 sumax 88 thickness 1.6 mm EN10028-7-1.4462 10272-1.4462
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A.3 Physical specifications

A.3.1 Material selection

Emerson provides a variety of Rosemount products with
various product options and configurations including
materials of construction that can be expected to perform
wellin a wide range of applications. The Rosemount product
information presented is intended as a guide for the
purchaser to make an appropriate selection for the
application. It is the purchaser’s sole responsibility to make
a careful analysis of all process parameters (such as all
chemical components, temperature, pressure, flow rate,
abrasives, contaminants, etc.), when specifying product,
materials, options and components for the particular
application. Emerson is not in a position to evaluate or
guarantee the compatibility of the process fluid or other
process parameters with the product, options,
configuration or materials of construction selected.

A.3.2 Tank connection

The tank connection consists of a tank seal, a flange, Tri
Clamp, or NPT or BSPP (G) threads. See “Dimensional
drawings” on page 139.

Certain models of flanged alloy and PTFE covered probes
have a tank connection design with a protective plate of the
same material as the probe (see Figure A-9). This is to
prevent the 316L/EN 1.4404 SST flange from being exposed
to the tank atmosphere.

Figure A-9. Probe and Protective Plate

Alloy probe and
protective plate

PTFE covered probe
and protective plate

Protective plate

A.3.3 Housing and enclosure

Ingress protection

IP66/67 and NEMA® 4X

Specifications and Reference Data

A.3.4 Flange dimensions
Follows ASMEB16.5, |ISB2220, and EN 1092-1 standards for

blind flanges. For Proprietary Fisher and Masoneilan flanges,
see “Proprietary Flanges” on page 146.

A.3.5 Probes

Probe versions

Flexible single lead, rigid single lead, segmented rigid single
lead, flexible twin lead, and coaxial.

Total probe length

This is defined from the Upper Reference Point to the end of
the probe (weight included, if applicable).

Figure A-10. Total Probe Length
NPT

BSPP (G)

Flange TriClamp

Upper
Reference

Total Probe Length

Select the probe length according to the required
measuring range (the probe must be hung and fully
extended through the entire distance where level readings
are desired).

Cut-to-fit probes
All probes can be cut in field except for the PTFE covered

probe.

However, there are some restrictions for the coaxial probe:
Probes over 4.1 ft. (1.25 m) can be cut up to 2 ft. (0.6 m).
Shorter probes can be cut to the minimum length of 1.3 ft.
(0.4 m).
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Table A-10. Minimum and Maximum Probe Length

Probe type Probe length

Flexible single lead 3.3t055.8ft.(1to 17 m)

Rigid single lead (0.3-in./8 mm) | 1.3t09.8ft.(0.4to3 m)

Rigid single lead (0.5-in./13 mm) | 1.3t0 19.7 ft. (0.4 to 6 m)

Segmented rigid single lead 1.3t032.8ft. (0.4to 10 m)

Flexible twin lead 3.3t055.8ft.(1to 17 m)

(
(
(
(

Coaxial 1.3t019.7 ft. (0.4 to 6 m)

Probe angle
0 to 90 degrees from vertical axis

Tensile strength

m Flexible single lead SST: 2698 Ib (12 kN)

m Flexible single lead Alloy C-276: 1798 Ib (8 kN)
= Flexible single lead Alloy 400: 1124 1b (5 kN)

m Flexible single lead Duplex 2205: 1349 Ib (6 kN)
m Flexible twin lead: 2023 Ib (9 kN)

Collapse load

Flexible single lead SST: 3597 Ib (16 kN)
Flexible single lead Alloy C-276: 2023 Ib (9 kN)
Flexible single lead Alloy 400: 1349 Ib (6 kN)
Flexible single lead Duplex 2205: 1574 Ib (7 kN)

Sideway capacity

= Rigid single lead/segmented rigid single lead:
m 4.4 ft. |bf, 0.44 1b at 9.8 ft. (6 Nm, 0.2 kg at 3 m)
m Coaxial: 73.7 ft. Ibf, 3.7 Ibat 19.7 ft. (100 Nm, 1.67 kg at 6 m)
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A.3.6 Material exposed to tank
atmosphere

Material of

construction code Material

316 SST(, 316L SST (EN 1.4404), PTFE,
PFA, and O-ring materials

Alloy C-276 (UNS N10276), PTFE, PFA,

1

2 and O-ring materials

3 Alloy 400 (UNS N04400), PTFE, PFA, and
O-ring materials

7 PTFE (1 mm PTFE cover)

8 PTFE, 316L SST (EN 1.4404), and O-ring
materials

i Alloy C-276 (UNS N10276), PTFE, PFA,

and O-ring materials

Duplex 2205 (UNS S31803/EN 1.4462),
D Duplex 2507 (UNSS32750/EN 1.4410),
PTFE, PFA, and O-ring materials

1. Forflexible single/twin lead probes only.

A.3.7 Weight

Table A-11. Flange and Probes

Item Weight

Flange

Depends on flange size

Flexible single lead probe

0.05 Ib/ft (0.07 kg/m)

Rigid single lead probe
(0.3-in./8 mm)

0.27 Ib/ft (0.4 kg/m)

Rigid single lead probe
(0.5-in./13 mm)

0.71 Ib/ft (1.06 kg/m)

Segmented rigid single lead
probe

0.71 Ib/ft (1.06 kg/m)

Flexible twin lead probe

0.09 Ib/ft (0.14 kg/m)

Coaxial probe

0.67 Ib/ft (1 kg/m)
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Table A-12. End Weight

Item Weight

SST probe: 0.88 Ib (0.40 kg)

Small weight (code W1)
PTFE covered probe: 2.20 Ib (1 kg)

Short weight (code W2) 0.88 1b (0.40 kg)

Heavy weight (code W3) 2.431b (1.10 kg)

Flexible twin lead probe 1.31b(0.60 kg)

A.3.8 End weight and anchoring
options

There are in total four weight and anchoring options for
flexible single lead probes. See Figure A-11 on page 139 for
dimensions.

Small weight (code W1)

A small weight is recommended for narrow tank openings
less than 1.5 in. (38 mm). Required weight option for PTFE
covered probes.

Short weight (code W2)

A short weight is available for the single flexible stainless
steel probe. It is recommended for maximized measuring
ranges with measurements close to the probe end.

Heavy weight (code W3)

A heavy weight is the recommended choice for most
applications.

Chuck (code W4)

To tie probe end to tank bottom.
A.3.9 Engineered solutions

When standard model codes are not sufficient to fulfill
requirements, please consult the factory to explore possible
Engineered Solutions. This is typically, but not exclusively,
related to the choice of wetted materials or the design of a
process connection. These Engineered Solutions are part of
the expanded offerings and may be subject to additional
delivery lead time. For ordering, factory will supply a special
P-labeled numeric option code that should be added at the
end of the standard model string.
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A.4 Ordering information

Specification and selection of product materials, options, or components must be made by the purchaser of the equipment.
See page 121 for more information on Material Selection.

Table A-13. Rosemount 3308 Series Level and|or Interface Measurements in Liquids Ordering Information

The starred offerings (x) represent the most common options and should be selected for best delivery. The non-starred offerings
are subject to additional delivery lead time.

Model | Product description

3308A | Guided Wave Radar Level Transmitter *

Profile Reference accuracy

ume) High Performance +0.121in. (£3 mm)

S Standard +0.25in. (+6 mm)

Signal output (see page 116 for details)

X ‘ Wireless *

Measurement type (see page 119)

2 Level and Interface Transmitter *

1 Level or Interface Transmitter (Interface available for fully submerged probe)

Housing

D1 Wireless Dual Compartment Housing, Aluminum (with plugged %:-14 NPT conduits)

E1 Wireless Dual Compartment Housing, Stainless steel (with plugged ¥5-14 NPT conduits)

Hazardous locations certifications (see Appendix B: Product Certifications)

I ATEX Intrinsic Safety *

12 INMETRO Intrinsic Safety *

13 NEPSI Intrinsic Safety *

14 TIIS Intrinsic Safety *

15 FM Intrinsically Safe *

16 Canadian Intrinsically Safe *

17 IECEX Intrinsic Safety *

IM Technical Regulations Customs Union (EAC) Intrinsic Safety *

KD ATEX and Canadian Intrinsic Safety

KE FM and Canadian Intrinsically Safe

KF ATEX and FM Intrinsic Safety

NA No Hazardous Locations Certifications

Operating temperature and pressure (see page 118)

S - 15 psig (-1bar) to 580 psig (40 bar) @ 302 °F (150 °C) *
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Table A-13. Rosemount 3308 Series Level and|or Interface Measurements in Liquids Ordering Information

The starred offerings (x) represent the most common options and should be selected for best delivery. The non-starred offerings
are subject to additional delivery lead time.

Material of construction; process connection/probe Probe type

1 316L SST (EN 1.4404) All *

2 Alloy C-276 (UNS N10276). With plate design if flanged version. 3A, 3B, 4A, 4B, and 5A

3 Alloy 400 (UNS N04400). With plate design if flanged version. 3A, 3B, 4A, 4B, and 5A

7 PTFE covered probe and flange. With plate design. 4A and 5A

8 PTFE covered probe 4A and 5A

H Alloy C-276 (UNS N10276) process connection, flange, and probe 3A, 3B, 4A, 4B, and 5A

D Duplex 2205 (UNS S31803) process connection, flange, and probe 4B and 5A

Sealing O-ring material (see page 118)

\% Viton Fluoroelastomer *

E Ethylene Propylene (EPDM) *

K Kalrez 6375 Perfluoroelastomer *

B Nitrile Butadiene (NBR) *

Process connection size (see Table A-14 and Table A-15 on page 129 for availability) | Process connection type

5 1V5-in. Thread/Tri Clamp *

2 2-in./[DN50/50A NPT Thread/Flange/Tri Clamp | *

3 3-in./DN80/80A Flange/Tri Clamp *

4 4-in./[DN100/100A Flange/Tri Clamp *

P Proprietary Flanges Proprietary Flange *

1 1-in. Thread

6 6-in./DN150/150A Flange

8 8-in./DN200/200A Flange

Process connection rating (see Table A-14 and Table A-15 on page 129 for availability)

NN For use with non-flange process connection type *

ASME rating

AA ASME B16.5 Class 150 Flange *

AB ASME B16.5 Class 300 Flange *

EN rating

DA EN1092-1 PN16 Flange

DB EN1092-1 PN40 Flange

JIS rating

JA JISB2220 10K Flange

B JIS B2220 20K Flange

Proprietary

PF Proprietary Flange *
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Table A-13. Rosemount 3308 Series Level and|or Interface Measurements in Liquids Ordering Information

The starred offerings (x) represent the most common options and should be selected for best delivery. The non-starred offerings
are subject to additional delivery lead time.

Process connection type (see Table A-14 and Table A-15 on page 129 for availability)

Threads

N NPT thread

@ BSPP (G) thread

Flange faces

F Flat Face (FF) Flange, available for EN flanges

R Raised Face (RF) Flange, available for ASME and JIS flanges

Proprietary flanges (see page 146 for dimensions)

M Masoneilan-Proprietary, 316 SST Torque Tube Flange, 316L

P Fisher-Proprietary, 316 SST, (for 249B and 259B cages) Torque Tube Flange, 316L

Q Fisher-Proprietary, 316 SST, (for 249C cages) Torque Tube Flange, 316L

Tri Clamp

C Tri Clamp

Probe Type Process connection type Probe lengths
Coaxial, perforated. For level and interface . Min.: 1ft.4in. (0.4 m)

3B measurement. Flange/1-, 1%-, 2-in. Thread Max.: 19 ft. 8in. (6 m) *

in.: i 3)

4A Rigid Single Lead (d=0.3"/8 mm) Flange/1-, 1%-, 2-in. Thread/Tri Clamp m;@(g‘}tt Ton{rfo(':f nT)) *

4B Rigid Single Lead (d=0.5"/13 mm) Flange/1%5-, 2-in. ThreadTri Clamp m:( 11 gt'ft“ ';i'n(o('g n”:)) *
Flexible Single Lead (d=0.16"/4mm). Refer to . . . Min.: 3 ft. 4 in. (1 m)®

A page 128 to specify weight or chuck. Flange/1-, 1%4-, 2-in. ThreadTri Clamp |\ " o5y g, (17 m) *

2A Flexible Twin Lead with weight Flange/1V2-, 2-in. Thread mla[:(égtf? é)ni.n“(;n7)m)

3A¢) Coaxial (for level measurement) Flange/1-, 1¥-, 2-in. Thread mlar:( 11 gtft4 éni'n(o('grr:))

4S Segmented Rigid Single Lead (d=0.5"/13mm) Flange/1V5-, 2-in. Thread mlar;y;tf: Igni'n(o('fomn)])

Probe length units (see page 121 for total probe length)

E English (feet, inches)

M Metric (meters, centimeters)

Probe length (feet/meters)

XXX ‘ 0-55 feet or 0-17 meters *

Probe length (inches|centimeters)

XX ‘ 0-11 inches or 0-99 Centimeters *
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Table A-13. Rosemount 3308 Series Level and|or Interface Measurements in Liquids Ordering Information

The starred offerings (x) represent the most common options and should be selected for best delivery. The non-starred offerings
are subject to additional delivery lead time.

Update rate, operating frequency and protocol

WA3 User Configurable Update Rate, 2.4 GHz, IEC 62591 (WirelessHART) *
Omnidirectional wireless antenna and SmartPower™ solutions (see page 116 for functional specification)
WK1 External Antenna, Adapter for Intrinsically Safe Black Power Module (Power Module Sold Separately) *
WN1 High Gain, Remote Antenna (see page 145 for dimensions), Adapter for Intrinsically Safe Black Power Module (Power "
Module Sold Separately)
Note: Black Power Module must be shipped separately; order Model 701 PBKKF (part number 00753-9220-0001).
Options (include with selected model number)
Display
M5 ‘ LCD Display (see page 117) *
Hydrostatic testing
P1 ‘ Hydrostatic Testing, including certificate *
Factory configuration
Al ‘ Factory Configuration per Configuration Data Sheet *
Special quality assurance
Q4 ‘ Calibration Data Certificate *
Material traceability certification
Q8 ‘ Material Traceability Certification per EN 10204 3.1 *
Welding procedure qualification/specification
Q66 Welding Procedure Qualification Record Documentation
Q67 Welder Performance Qualification Record
Q68 Welding Procedure Specification
Special certifications
QG | GOST Certification
Material certification
Q15(©) ‘ NACE® material recommendation per NACE MR0175/ISO 15156 *
Installation options
LS Long Stud for Flexible Single Lead Probes, 25 cm (10 in.) (for use in tall nozzles) *
BR Mounting Bracket for 1%-in. NPT Process Connection (see page 144)
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Table A-13. Rosemount 3308 Series Level and|or Interface Measurements in Liquids Ordering Information

Thes

tarred offerings (x) represent the most common options and should be selected for best delivery. The non-starred offerings

are subject to additional delivery lead time.

Weight and anchoring options for flexible single probes (see page 123 for dimensions)

W1 Small Weight (for narrow tank openings less than 2 in. (50 mm)) (Required for PTFE covered probes)
W3 Heavy Weight (for most applications)

w4 Chuck (to tie probe end to tank bottom)

W2 Short Weight (when measuring close to the probe end)

Weight assembly options for flexible single probes

Wu

Weight or chuck not mounted on the probe *

Extended product warranty

WR3 3-year limited warranty

WR5 5-year limited warranty

Plantweb™ diagnostic functionality

DA1

‘ HART® Diagnostics (see page 117) *

Centering disc (see page 28 for dimensions and size recommendation)(?)

S2() 2-in. Centering disc *
S36) 3-in. Centering disc *
S4(8) 4-in. Centering disc *
P2 2-in. Centering disc PTFE *
P3 3-in. Centering disc PTFE *
P4 4-in. Centering disc PTFE *
S6(0) 6-in. Centering disc
S8(8) 8-in. Centering disc

P6 6-in. Centering disc PTFE

P8 8-in. Centering disc PTFE

Assemble/consolidate to chamber (see page 20)
XC ‘ Consolidate to Chamber *
Engineered solutions (see page 123)
Pxxx Engineered Solutions beyond standard model codes. (Consult factory for details)

1. TheRosemount 3308A with profile code U has two performance modes: Standard and High Performance (default). The performance mode may be reconfigured in field.
2. Available with hazardous locations certifications 11, 15, 16, and 17.

3. Minimum probe lengthis 4 ft. 11 in. (1.5 m) for PTFE covered probes (Material of Construction codes 7 and 8).

4. Requires model 3308Axx1.

5. Certificate includes all metallic pressure retaining wetted parts.

6. Available for Probe Type 3A, 3B, 4A, 4B, 4S, and PTFE-coated 5A.

7. Available for SST, Alloy C-276, Alloy 400, and Duplex 2205 probes, types 2A, 4A, 4B, 4S, and 5A. Not available with PTFE covered probes (Material of Construction codes

©
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7 and 8).
Centering disc in same material as probe material of construction.
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Table A-14. Availability of Process Connections - Material of Construction Codes 1, 2, 3,7,and 8
(Type vs. Size and Rating)
Process connection size Process connection rating
Thread|TriClamp | ASME B16.5 flanges EN1092-1 flanges JIS B2220 flanges Proprietary
Class 150 | Class300 = PN16 PN40 10K 20K flanges®

1-in. G, N® N/A N/A N/A N/A N/A N/A N/A
1%-in. C@, NG, GO N/A N/A N/A N/A N/A N/A N/A
2-in./DN50/50A @, N R R F F R R N/A
3-in./DN80/80A c@ R R F F R R N/A
4-in./[DN100/100A c@ R R F F R R N/A
6-in./DN150/150A N/A R R F F R R N/A
8-in./DN200/200A N/A R R F F R R N/A
Proprietary flanges N/A N/A N/A N/A N/A N/A N/A M, P, Q

1. Only available with material of construction codes 1, 7, and 8.

2. Only available with material of construction codes 1 and 8.

Only available with material of construction codes 1, 2, 3, and 8.
C=Tri Clamp (process connection type code C)
F = Flat Face (process connection type code F)

G = BSPP (G) thread (process connection type code G)

M = Masoneilan (process connection type code M)
N = NPT thread (process connection type code N)
P = Fisher 249B/259B (process connection type code P)
Q = Fisher 249C (process connection type code Q)
R = Raised Face (process connection type code R)

Table A-15. Availability of Process Connections - Material of Construction Codes H and D (Type vs. Size and Rating)

Process connection size Process connection rating
Thread|TriClamp | ASME B16.5 flanges EN1092-1 flanges JIS B2220 flanges Proprietary
Class150 | Class300 | PN16 PN40 10K 20K flanges
1-in. N/A N/A N/A N/A N/A N/A N/A N/A
1%-in. G,N N/A N/A N/A N/A N/A N/A N/A
2-in./DN50/50A N/A R R N/A N/A N/A N/A N/A
3-in./DN80/80A N/A R R N/A N/A N/A N/A N/A
4-in./DN100/100A N/A R R N/A N/A N/A N/A N/A
6-in./DN150/150A N/A RO N/A N/A N/A N/A N/A N/A
8-in./DN200/200A N/A N/A N/A N/A N/A N/A N/A N/A
Proprietary flanges N/A N/A N/A N/A N/A N/A N/A N/A
1. Only available with material of construction code H.
G =BSPP (G) thread (process connection type code G)
N = NPT thread (process connection type code N)
R = Raised Face (process connection type code R)
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A.5 Spare parts and accessories

Table A-16. Rosemount 3308 Series Spare Parts List - Transmitter Head

Model | Product description

3308A | Guided Wave Radar Level Transmitter

Profile Reference accuracy
um@) High Performance +0.12in. (3 mm)

S Standard +0.25in. (+6 mm)

Signal output (see page 116 for details)

X

‘ Wireless

Measurement type (see page 119)

2 Level and Interface Transmitter

1 Level or Interface Transmitter (Interface available for fully submerged probe)
Housing

D1 Wireless Dual Compartment Housing, Aluminum (with plugged ¥3-14 NPT conduits)
E1 Wireless Dual Compartment Housing, Stainless steel (with plugged ¥:-14 NPT conduits)
Product certifications (see Appendix B: Product Certifications)

I ATEX Intrinsic Safety

12 INMETRO Intrinsic Safety

13 NEPSI Intrinsic Safety

14 TIIS Intrinsic Safety

15 FM Intrinsically Safe

16 Canadian Intrinsically Safe

17 IECEx Intrinsic Safety

IM Technical Regulations Customs Union (EAC) Intrinsic Safety

KD ATEX and Canadian Intrinsic Safety

KE FM and Canadian Intrinsically Safe

KF ATEX and FM Intrinsic Safety

NA No Hazardous Locations Certifications

Operating temperature and pressure

N

‘ Not Applicable

Material of construction; process connection [ probe

0

‘ Not Applicable

Sealing O-ring material

N

‘ Not Applicable
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Table A-16. Rosemount 3308 Series Spare Parts List - Transmitter Head

Process connection size

N ‘ Not Applicable

Process connection rating

NN ‘ Not Applicable

Process connection type

0 ‘ Not Applicable
Probe type
ON ‘ Not Applicable

Probe length units

N ‘ Not Applicable

Probe length (feet/meters)

000 ‘ Not Applicable

Probe length (inches/centimeters)

00 ‘ Not Applicable

Update rate, operating frequency and protocol

WA3 ‘ User Configurable Update Rate, 2.4 GHz, IEC 62591 (WirelessHART)

Omnidirectional wireless antenna and SmartPower solutions (see page 116 for functional specification)

WK1 External Antenna, Adapter for Intrinsically Safe Black Power Module (Power Module Sold Separately)

High Gain, Remote Antenna (see page 145 for dimensions), Adapter for Intrinsically Safe Black Power Module (Power Module
Sold Separately)

Note: Black Power Module must be shipped separately; order Model 701 PBKKF (part number 00753-9220-0001).

WNI1

Options (include with selected model number)

Display

M5 ‘ LCD Display (see page 117)

Factory configuration

cl ‘ Factory Configuration per Configuration Data Sheet

Special quality assurance

Q4 ‘ Calibration Data Certificate

Special certifications

QG ‘ GOST Certification
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Table A-16. Rosemount 3308 Series Spare Parts List - Transmitter Head

Extended product warranty

WR3 3-year limited warranty

WR5 5-year limited warranty

Plantweb diagnostic functionality

DA1 ‘ HART Diagnostics (see page 117)

Engineered solutions (see page 123)

Pxxx

Engineered Solutions beyond standard model codes. (Consult factory for details)

1. TheRosemount 3308A with profile code U has two performance modes: Standard and High Performance (default). The performance mode may be reconfigured in field.

2. Available with hazardous locations certifications 11, 15, 16, and 17.

Table A-17. Rosemount 3308 Series Spare Parts List - Probe

Model | Product description

3308A Guided Wave Radar Level Transmitter

Profile

S ‘ Standard

Signal output

N ‘ Not Applicable

Measurement type

9 ‘ Spare Process Seal and Probe

Housing

NO ‘ Not Applicable

Product certifications

NA ‘ Not Applicable

Operating temperature and pressure (see page 118)

S ‘ - 15 psig (-1bar) to 580 psig (40 bar) @ 302 °F (150 °C)
Material of construction; process connection [ probe Probe type
1 316L SST (EN 1.4404) All

Alloy C-276 (UNS N10276). With plate design if flanged version.

3A, 3B, 4A, 4B, and 5A

Alloy 400 (UNS N04400). With plate design if flanged version.

3A, 3B, 4A, 4B, and 5A

2

3

7 PTFE covered probe and flange. With plate design. 4A and 5A

8 PTFE covered probe 4A and 5A

H Alloy C-276 (UNS N10276) process connection, flange, and probe 3A, 3B, 4A, 4B, and 5A
D Duplex 2205 (UNS S31803) process connection, flange, and probe 4B and 5A

Sealing O-ring material (see Table A-5 on page 118)

\Y Viton Fluoroelastomer

132

Specifications and Reference Data




Reference Manual Specifications and Reference Data
January 2018

00809-0100-4308, Rev CB

Table A-17. Rosemount 3308 Series Spare Parts List - Probe

E Ethylene Propylene (EPDM)

K Kalrez 6375 Perfluoroelastomer

B Nitrile Butadiene (NBR)

Process connection size (see Table A-14 on page 129 for availability) Process connection type
5 1V5-in. Thread/Tri Clamp

2 2-in./DN50/50A NPT Thread/Flange/Tri Clamp
3 3-in./DN80/80A Flange/Tri Clamp

4 4-in./DN100/100A Flange/Tri Clamp

P Proprietary Flanges Proprietary Flange

1 1-in. Thread

6 6-in./DN150/150A Flange

8 8-in./DN200/200A Flange

Process connection rating (see Table A-14 on page 129 for availability)

NN For use with non-flange process connection type
ASME rating

AA ASME B16.5 Class 150 Flange
AB ASME B16.5 Class 300 Flange
EN rating

DA EN1092-1 PN16 Flange

DB EN1092-1 PN40 Flange

JIS rating

A JIS B2220 10K Flange

1B JISB2220 20K Flange
Proprietary

PF Proprietary Flange

Process connection type (see Table A-14 on page 129 and Table A-15 on page 129 for availability)

Threads

N NPT thread

@ BSPP (G) thread

Flange faces

F Flat Face (FF) Flange, available for EN flanges

R Raised Face (RF) Flange, available for ASME and IS flanges

Proprietary flanges (see page 146 for dimensions)

M Masoneilan-Proprietary, 316 SST Torque Tube Flange, 316L

P Fisher-Proprietary, 316 SST, (for 249B and 259B cages) Torque Tube Flange, 316L
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Table A-17. Rosemount 3308 Series Spare Parts List - Probe

Q ‘ Fisher-Proprietary, 316 SST, (for 249C cages) Torque Tube Flange, 316L

Tri Clamp

C ‘ Tri Clamp

Probe type Process connection type Probe lengths
Coaxial, perforated. For level and interface 11 o Min.: 1ft.4in. (0.4 m)

3B measurement. Flange/1-, 1%-, 2-in. Thread Max.: 19 ft. 8 in. (6 m)

e . . Min.: 1ft. 4in. (0.4 m)("
= " - 115 D-
4A Rigid Single Lead (d=0.3"/8 mm) Flange/1-, 1%-, 2-in. Thread/Tri Clamp Max.: 9 ft. 101in. (3 m)
4B Rigid Single Lead (d=0.5"/13 mm) Flange/1%-, 2-in. Thread/Tri Clamp | Min-1ft: 4in. (0.4m)

Max.: 19 ft. 8 in. (6 m)

Flexible Single Lead (d=0.16"/4mm). Refer to Min.: 3 ft. 4in. (1 m)®

A page 135 to specify weight or chuck. Flange/1-, 1%4-, 2-in. Thread|Tri Clamp |\ " 55 g, (17 m)
2A Flexible Twin Lead with weight Flange/1%:-, 2-in. Thread mlar;(?é;tf: igni'n(,](;n7)m)
3AQ) Coaxial (for level measurement) Flange/1-, 1%-, 2-in. Thread mlal:(z ;tft4 |8nm(0(g nn:))
4S Segmented Rigid Single Lead (d=0.5"/13mm) Flange/1%5-, 2-in. Thread Min.: 1 ft. 4in. (0.4 m)

Max.: 32 ft. 9in. (10 m)

Probe length units (see page 121 for total probe length)

E English (feet, inches)

M Metric (meters, centimeters)

Probe length (feet/meters)

XXX ‘ 0-55 feet or 0-17 meters

Probe length (inches|centimeters)

XX ‘ 0-11 inches or 0-99 Centimeters

Options (include with selected model number)

Hydrostatic testing

P1 ‘ Hydrostatic Testing, including certificate

Material traceability certification

Q80 ‘ Material Traceability Certification per EN 10204 3.1

Welding procedure qualification | specification

Q66 Welding Procedure Qualification Record Documentation

Q67 Welder Performance Qualification Record

Q68 Welding Procedure Specification

Installation options

LS Long Stud for Flexible Single Lead Probes, 25 cm (10 in.) (for use in tall nozzles)
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Table A-17. Rosemount 3308 Series Spare Parts List - Probe
BR Mounting Bracket for 1%5-in. NPT Process Connection (see page 144)
Weight and anchoring options for flexible single probes (see page 123 for dimensions)
W1 Small Weight (for narrow tank openings less than 2 in. (50 mm)) (Required for PTFE covered probes)
W3 Heavy Weight (for most applications)
W4 Chuck (to tie probe end to tank bottom)
W2 Short Weight (when measuring close to the probe end)
Weight assembly options for flexible single probes
WU Weight or chuck not mounted on the probe
Extended product warranty
WR3 3-year limited warranty
WR5 5-year limited warranty
Centering disc (see page 28 for dimensions and size recommendation)(?)
520 2-in. Centering disc
S30) 3-in. Centering disc
540) 4-in. Centering disc
P2 2-in. Centering disc PTFE
P3 3-in. Centering disc PTFE
P4 4-in. Centering disc PTFE
S60) 6-in. Centering disc
S80) 8-in. Centering disc
P6 6-in. Centering disc PTFE
P8 8-in. Centering disc PTFE
Assemble/consolidate to chamber (see page 20)
XC ‘ Consolidate to Chamber
Engineered solutions (see page 123)
Pxxx Engineered Solutions beyond standard model codes. (Consult factory for details)
; : ?QZLTE_T nfgzt:;;%%? Xi;ﬁ ft. 111n. (1.5 m) for PTFE covered probes (Material of Construction codes 7 and 8).
3. Certificate includes all metallic pressure retaining wetted parts.
4. Available for probe types 2A, 4A, 4B, and 5A. Not available with PTFE covered probes (Material of Construction codes 7 and 8).
5. Centering disc in same material as probe material of construction.
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Table A-18. Accessories Ordering Information

The starred offerings (%) represent the most common options and should be selected for best delivery. The non-starred offerings are subject to
additional delivery lead time.

Centering discs for rigid single lead probe (d=0.3"|8 mm)(1)(2) Outer diameter
03300-1655-0001 Kit, 2-in. Centering Disc, SST 1.8in. (45 mm) *
03300-1655-0006 Kit, 2-in. Centering Disc, PTFE 1.8in. (45 mm) *
03300-1655-0002 Kit, 3-in. Centering Disc, SST 2.7in. (68 mm) *
03300-1655-0007 Kit, 3-in. Centering Disc, PTFE 2.7in. (68 mm) *
03300-1655-0003 Kit, 4-in. Centering Disc, SST 3.6in.(92 mm) *
03300-1655-0008 Kit, 4-in. Centering Disc, PTFE 3.6in.(92 mm) *
03300-1655-0004 Kit, 6-in. Centering Disc, SST 5.55in. (141 mm)
03300-1655-0009 Kit, 6-in. Centering Disc, PTFE 5.55in. (141 mm)
03300-1655-0005 Kit, 8-in. Centering Disc, SST 7.40in. (188 mm)
03300-1655-0010 Kit, 8-in. Centering Disc, PTFE 7.40in. (188 mm)
Centering discs for rigid single lead probe (d=0.5"/13 mm)(1)(2) Outer diameter
03300-1655-0301 Kit, 2-in. Centering Disc, SST 1.8in. (45 mm) *
03300-1655-0306 Kit, 2-in. Centering Disc, PTFE 1.8in. (45 mm) *
03300-1655-0302 Kit, 3-in. Centering Disc, SST 2.7in. (68 mm) *
03300-1655-0307 Kit, 3-in. Centering Disc, PTFE 2.7in. (68 mm) *
03300-1655-0303 Kit, 4-in. Centering Disc, SST 3.6in.(92 mm) *
03300-1655-0308 Kit, 4-in. Centering Disc, PTFE 3.6in.(92 mm) *
03300-1655-0304 Kit, 6-in. Centering Disc, SST 5.55in. (141 mm)
03300-1655-0309 Kit, 6-in. Centering Disc, PTFE 5.55in. (141 mm)
03300-1655-0305 Kit, 8-in. Centering Disc, SST 7.40in. (188 mm)
03300-1655-0310 Kit, 8-in. Centering Disc, PTFE 7.40in. (188 mm)
Centering discs for flexible single[twin lead probes(")() Outer diameter
03300-1655-1001 Kit, 2-in. Centering disc, SST 1.8in. (45 mm) *
03300-1655-1006 Kit, 2-in. Centering disc, PTFE 1.8in. (45 mm) *
03300-1655-1002 Kit, 3-in. Centering disc, SST 2.7in. (68 mm) *
03300-1655-1007 Kit, 3-in. Centering disc, PTFE 2.7in. (68 mm) *
03300-1655-1003 Kit, 4-in. Centering disc, SST 3.6in.(92 mm) *
03300-1655-1008 Kit, 4-in. Centering disc, PTFE 3.6in.(92 mm) *
03300-1655-1004 Kit, 6-in. Centering disc, SST 5.55in. (141 mm)
03300-1655-1009 Kit, 6-in. Centering disc, PTFE 5.55in. (141 mm)
03300-1655-1005 Kit, 8-in. Centering disc, SST, 7.40in. (188 mm)
03300-1655-1010 Kit, 8-in. Centering disc, PTFE 7.40in. (188 mm)
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Table A-18. Accessories Ordering Information

The starred offerings (%) represent the most common options and should be selected for best delivery. The non-starred offerings are subject to

additional delivery lead time.

Centering discs for mounting between segments (probe type 4S only)

Outer diameter

03300-1656-1002 2-in. Centering Disc (1 pc), PTFE, Segmented Rigid Single Lead 1.8in. (45 mm)
03300-1656-1003 3-in. Centering Disc (1 pc), PTFE, Segmented Rigid Single Lead 2.7in. (68 mm)
03300-1656-1004 3.6in.(92 mm)

03300-1656-1006

6-in. Centering Disc (1 pc), PTFE, Segmented Rigid Single Lead

5.55in. (141 mm)

03300-1656-1008

).
).
4-in. Centering Disc (1 pc), PTFE, Segmented Rigid Single Lead
).
).

8-in. Centering Disc (1 pc), PTFE, Segmented Rigid Single Lead

7.40in. (188 mm)

03300-1656-3002 2-in. Centering Disc (3 pcs), PTFE, Segmented Rigid Single Lead 1.8in. (45 mm)
03300-1656-3003 3-in. Centering Disc (3 pcs), PTFE, Segmented Rigid Single Lead 2.7in. (68 mm)
03300-1656-3004 3.6in.(92 mm)

03300-1656-3006

6-in. Centering Disc (3 pcs), PTFE, Segmented Rigid Single Lead

5.55in. (141 mm)

03300-1656-3008

8-in. Centering Disc (3 pcs), PTFE, Segmented Rigid Single Lead

7.40in. (188 mm)

03300-1656-5002 2-in. Centering Disc (5 pcs), PTFE, Segmented Rigid Single Lead 1.8in. (45 mm)
03300-1656-5003 3-in. Centering Disc (5 pcs), PTFE, Segmented Rigid Single Lead 2.7in. (68 mm)
03300-1656-5004 4-in. Centering Disc (5 pcs), PTFE, Segmented Rigid Single Lead 3.6in.(92 mm)

03300-1656-5006

6-in. Centering Disc (5 pcs), PTFE, Segmented Rigid Single Lead

5.55in. (141 mm)

03300-1656-5008

(
(
(
(
(
(
(
4-in. Centering Disc (3 pcs), PTFE, Segmented Rigid Single Lead
(
(
(
(
(
(
(

).
).
).
).
).
).
).
).
).
).

8-in. Centering Disc (5 pcs), PTFE, Segmented Rigid Single Lead

7.40in. (188 mm)

Segmented rigid single le

ad probe spare part kit

03300-0050-0001

15.2-in./385 mm Segment for Top connection (1 pc)

03300-0050-0002

31.5-in

03300-0050-0003

/
/800 mm Segment (1 pc)
31.5-in./800 mm Segment (3 pcs)

03300-0050-0004

03300-0050-0005

(

(
31.5-in./800 mm Segment (5 pcs)
31.5-in./800 mm Segment (12 pcs)

Vented flanges(®)

03300-1812-0092 Fisher 249B/259B(4)
03300-1812-0093 Fisher 249C
03300-1812-0091 Masoneilan

Flushing connection rings

DP0002-2111-56

2-in. ANSI, V4-in. NPT connection

DP0002-3111-56

3-in. ANSI, V4-in. NPT connection

DP0002-4111-56

4-in. ANSI, Va-in. NPT connection

DP0002-5111-56

DN50, V4-in. NPT. connection

DP0002-8111-56

DN8O, V4-in. NPT. connection
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Table A-18. Accessories Ordering Information

The starred offerings (%) represent the most common options and should be selected for best delivery. The non-starred offerings are subject to

additional delivery lead time.

Other

03300-7004-0001 MACTek® VIATOR® HART Modem and cables (RS232 connection) *
03300-7004-0002 MACTek VIATOR HART Modem and cables (USB connection) *
1. If a centering disc is required for a flanged probe, the centering disc can be ordered with options Sx or Px on page 128 in the model code. If a centering disc is required for

athreaded connection or as a spare part, it should be ordered using the item numbers listed in this table. Refer to Table 3-5 for centering disc size recommendation for

different pipe schedules.

2. To order a centering disc in a different material, consult the factory.
1%-in. NPT threaded connection is required.

For pressure and temperature rating, see “Fisher™and Masoneilan™” on page 118.
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A.6 Dimensional drawings
Figure A-11. Flexible Single Lead Probe
2.8(71.3) ‘ 3.9(100.2)
|
External antenna —
(option WK1)
NPT 1-in., s52
12(297:2) NPT 1%2-in., s52
NPT 2-in., s60
3.4(86) | | Thread sealing
7|
A ‘ . A Wz
H (Nozzle height) =l =
i H<4(100)+D oz
< | 9
/ | @ D (Nozzle diameter) N !
i Recommended: D >4 (100) i —
i Minimum: D=1.5 (38)(") T
‘i‘ @ 0.16 (4): SST probe !
| (@ 0.28 (7): PTFE covered probe Weight for PTFE ! Min. 8 (200)
L §(1576r]:) Min. 4 (100) if smooth metallic wall. covered probe !
| Min. 16 (400) if disturbing objects or (option W1) \
i rugged metallic wall. i
i Heavy weight i 0
i (option W3) | ==
| ) o Chuck o | .
& S((I;()Etovl;/av\?;)t S (option W4) Chamber/pipe
! i
. \ P ° 17.1 # The probe must be
Small weight —| = : .
. 435) in the center of the
(option W1) | (
w o probe/chamber
1(26) 1
©0.9(22 Min. @ 2 (50
(22) 0T (255 ?0.88 (22.5) _Min. ©22(50)
Tri Clamp PTFE covered probe and
7.8(198) connection protective plate
43(110)
e SE——
\ Protective plate
o 12(297.2)
C__ V7=
- BSPP (G) 1-in., s52
BSPP (G) 17%5-in., s60 Alloy probe and
protective plate
A
2.4(62)
0.6 (15)

A
E j 4(100): Standard length
i 10 (250): Long stud (option LS)
Y

Protective plate

1.The Trim Near Zone (TNZ) function may be necessary or an Upper Null Zone (UNZ) setup may be required to mask the nozzle.

Dimensions are in inches (millimeters).
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Figure A-12. Rigid Single Lead Probe

External antenna ——
(option WK1)

2.8(71.3)

> > <

3.9(100.2)

12(297.2)

L<10ft. (3m)
for@0.31(8)

L<20ft. (6 m)
for@0.51(13)

% Nozzle height (H)
yH<4(100)+D

@ D (Nozzle diameter)
Recommended: D >4 (100)

rugged metallic wall.

|
|
! Minimum: D=1.5 (38) for probe type 4A(")
\
|
|

Min. 0.2 (5)

12(297.2)

BSPP (G) 1-in., 552
/ BSPP(G) 11in., 560

3.4 (86)1

Y

2.4(62)

D=2 (50) for probe type 4B(1)

Min. 4 (100) if smooth metallic wall.
Min. 16 (400) if disturbing objects or

?0.31(8)or@0.51(13): SST probe
@ 0.47 (12): PTFE covered probe

Min. @ 2 (50)

1.9(47)

NPT 1-in., s52
NPT 1%2-in., s52
NPT 2-in., s60

Thread sealing

Min. 8 (200)

Chamber/pipe

%
\
|
|
|
|
|
|
|
|
|
|
I

.~ The probe must be

in the center of the
probe/chamber

> <

Tri Clamp
connection

PTFE covered probe and
protective plate

\ Protective plate

Alloy probe and
protective plate

Protective plate

1.The Trim Near Zone (TNZ) function may be necessary or an Upper Null Zone (UNZ) setup may be required to mask the nozzle.

Dimensions are in inches (millimeters).
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Figure A-13. Segmented Rigid Single Lead Probe

2.8(71.3) 3.9(100.2)
External antenna —
(option WK1)
12(297.2) NPT 1%2-in., s52
/ NPT 2-in., s60
3 7 3.4(86) [ Thread sealing
?WTM Jo.e (15)
) % @ Nozzle height (H) | — ] | \
\ ] H<4(100)+D 35 | 7 A
7 | %2 |
|t @ D (Nozzle diameter) N A= 15.2(385)
w Recommended: D > 4 (100) A
‘ Minimum: D=2 (50)(") Y
| A
| | .
! Min. 8 (200
L<33ft. | | in-8(200)
10m ! I
( ) Min. 4 (100) if smooth metallic wall. ‘
i Min. 16 (400) if disturbing objects or |
i rugged metallic wall. ! szi 31.5(800)
: ©0.51(13) |
‘ | Chamber/pipe
1 m The probe must be
in the center of the ui
| probe/chamber
Min. 0.2 (5) Min. @ 2 (50)

Optional:
PTFE centering disc \ u

2.4 (62)7

Optional:
Bottom centering disc (SST or PTFE) 7_

1. The Trim Near Zone (TNZ) function may be necessary or an Upper Null Zone (UNZ) setup may be required to mask the nozzle.

Dimensions are in inches (millimeters).
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Figure A-14. Coaxial Probe

2.8(71.3) 3.9(100.2)

External antenna ——

(option WK1)
12(297.2) NPT 1-in., s52
NPT 1%-in., s52
NPT 2-in., s60
34 (86)I I Thread sealing
: s
% | @ N ﬂ |
\ . ez !
| < )]
% ! Nozzle diameter N !
| Min.01.2(30) | ——
‘ ! S
| \
i \ ‘ Min. 8 (200)
L<20ft. Min. 0 | Metallic contact with |
(6m) to ta:'?k. wall i nozzle or tank allowed i
t ="
‘ pZZzzzza
| |
\ .
21.1(28) || : N Chamber/pipe
| |
i , i
, \ / /
Min. 0.2 (5) Min. @ 1.3 (32)

Alloy probe and

BSPP (G) 1-in., s52 protective plate

BSPP (G) 1%-in., s60

2.4 (62)7

Protective plate

Dimensions are in inches (millimeters).
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Figure A-15. Flexible Twin Lead Probe

2.8(71.3) 3.9(100.2)
External antenna —
(option WK1)
12(299.5)
NPT 1%-in., s52
————————— / NPT 2-in., s60
3.5(88) % Thread sealing
= - | |
A . A 7
% E | @ Nozzle height (H) NS
i ) H<4(100)+D I
/ X =
@ D (Nozzle diameter) Corrorr
Recommended: D >4 (100) T
u Minimum: D=2 (50)(") i
L <56 ft. = Chamber/pipe = Min. 8 (200)
(17 m) ?0.16 (4)
~<~—@0.16 (4)
TT I 777772
Min. 4 (100) if smooth metallic wall. - )
Min. 16 (400) if disturbing objects or
rugged metallic wall. W
A
3.5(90)
Y Y y
Min. 0.2 (5) 01.4(35)
- Min. @3 (75)
C__
BSPP (G) 1%-in., s60
\
A
n| ~
T
Oq —

1.The Trim Near Zone (TNZ) function may be necessary or an Upper Null Zone (UNZ) setup may be required to mask the nozzle.

Dimensions are in inches (millimeters).
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Figure A-16. Mounting Bracket (Option Code BR)

Pipe mounting Pipe mounting
(vertical pipe) (horizontal pipe)

Pipe diameter, @
max 2.5 in. (64 mm) 5
e
-HE—1
[p NN |
| 5.2
(133)
Wall mounting Hole pattern for wall mounting

=30

Dimensions are in inches (millimeters).
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Figure A-17. High Gain, Remote Antenna (Option Code WN1)
= -
(" Mounting bracket h
0.53(13.5)  2.75(69.9)
Antenna —- YA _ 0.50(12.7)
20.2(513)
422(107.2) | 2.75(69.9)
A
’ N
©0.41(10.4)
3.80(96.5)
Mounting bracket
- & _11 .05(26.7)
I \
2.50 (63.5) ©0.66 (16.7)
Ground connection \_ )
point
. . N 25ft. (7.6 m) Ve N
RF lightning arrestor / cable U-bolt
~— ©20.31(7.9) _[_——T——_—] J—
2.43(61.7) u
Minimum drip loop /
@123000 -
O 7 2.40(61.0) |
|
5/16-18 UNC-2A /
thread, 2PLS 4.04(102.7)
Antenna \ )
Mounting bracket
( U-bolt
Dimensions are in inches (millimeters).
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Figure A-18. Proprietary Flanges

Raised face
B

|

e

Recessed face

B

ANNANNNNNN

‘m

B,

Dimensions are in inches (millimeters).

D: Outside diameter

B;: Flange thickness with gasket surface

B,: Flange thickness without gasket surface

F=B;-B,: Gasket surface thickness

G: Gasket surface diameter
# Bolts: Number of bolts

K: Bolt hole circle diameter

Note

Dimensions may be used to aid in the identification of installed flanges. It is not intended for manufacturing use.

Table A-19. Dimensions of Proprietary Flanges

Special flanges(") D B, B, F G # Bolts K

Fisher 249B/259B() | 9.00(228.6) | 1.50(38.2) | 1.25(31.8) | 0.25(6.4) | 5.23(132.8) 8 7.25(184.2)
Fisher 249C(3) 5.69(144.5) | 0.94(23.8) | 1.13(28.6) | -0.19(-4.8) | 3.37(85.7) 8 4.75(120.65)
Masoneilan( 7.51(191.0) | 1.54(39.0) | 1.30(33.0) | 0.24(6.0) | 4.02(102.0) 8 5.87 (149.0)

1. These flanges are also available in a vented version.

2. Flange with raised face.
3. Flange with recessed face.
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Appendix B Product Certifications
SOty IS AGES v vttt ettt ettt e e e page 147
European Union directive information ...t page 148
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Ordinary location certification for FM approvals .......... ... page 148
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Other certifications . ... ..ot e e e e page 150
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B.1 Safety messages

Procedures and instructions in this section may require special precautions to ensure the safety of the personnel performing the
operations. Information that raises potential safety issues is indicated by a warning symbol (A\). Refer to the following safety messages

before performing an operation preceded by this symbol.

AWARNING

Failure to follow safe installation and servicing guidelines could result in death or serious injury.

= Make sure the transmitter is installed by qualified personnel and in accordance with applicable code of practice.
m  Use the equipment only as specified in this manual. Failure to do so may impair the protection provided by the

equipment.
Explosions could result in death or serious injury.

= Verify that the operating environment of the gauge is consistent with the appropriate hazardous locations

certifications.

= Installation of device in an explosive environment must be in accordance with appropriate local, national and

international standards, codes, and practices.

s Ensure device is installed in accordance with intrinsically safe or non-incendive field practices.
Electrical shock can result in death or serious injury.

= Ground device on non-metallic tanks (e.q. fiberglass tanks) to prevent electrostatic charge build-up.

u Sinile lead probes are sensitive for strong electromagnetic fields and therefore not suitable for non-metallic
s.

tan

m  Care must be taken during transportation of power module to prevent electrostatic charge build-up.

s Device must be installed to ensure a minimum antenna separation distance of 8 in. (20 cm) from all persons.
= Probes covered with plastic and/or with plastic discs may generate an ignition-capable level of electrostatic

charge under certain extreme conditions. Therefore, when the probe is used in a potentially explosive

atmosphere, appropriate measures must be taken to prevent electrostatic discharge.
Process leaks could result in death or serious injury.
= Handle the transmitter carefully.

= Ifthe process seal is damaged, gas could escape from the tank when removing the transmitter head from the

probe.
= Only qualified personnel should install the equipment.

Product Certifications
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B.2 European Union directive
information

The EU Declaration of Conformity for all applicable European
directives for this product can be found in the 3308A Product
Certifications document. The most current revision is available at
Emerson.com/Rosemount.

B.3 Telecommunication compliance

All wireless devices require certification to ensure that they adhere
to regulations regarding the use of the RF spectrum. Nearly every
country requires this type of product certification. Emerson™ is
working with governmental agencies around the world to supply
fully compliant products and remove the risk of violating country
directives or laws governing wireless device usage.

B.4 FCCandIC

This device complies with Part 15 of the FCC Rules. Operation is
subject to the following conditions: This device may not cause
harmful interference and this device must accept any interference,
including any interference that may cause undesired operation of
the device. This device must be installed to ensure a minimum
antenna separation distance of 20 cm from all persons.

This radio transmitter has been approved by Industry Canada to
operate with the antenna types listed below with the maximum
permissible gain indicated. Antenna types not included in this list,
having a gain greater than the maximum gain indicated for that
type, are strictly prohibited for use with this device.

Antenna model option | Antenna type Maxgain
(dBi)

WK1 Integral Omni-directional 2

WN1 Remote Omni-directional | 8

This device complies with Industry Canada license-exempt RSS
standard(s). Operation is subject to the following two conditions:
(1) This device may not cause interference, and (2) this device must
accept any interference, including any interference that may cause
undesired operation of the device.

ACAUTION

Changes or modifications to the equipment not expressly
approved by Emerson could void the user’s authority to
operate the equipment.

148

Cet appareil est conforme ala norme RSS Industrie Canada exempt
de licence. Son fonctionnement est soumis aux deux conditions
suivantes: (1) cet appareil ne doit pas provoquer d’interférences et
(2) cet appareil doit accepter toute interférence, y compris les
interferences pouvant causer un mauvais fonctionnement du
dispositif.

ACAUTION

Les changements ou les modifications apportés a
I'équipement qui n'est pas expressément approuvé par
Emerson pourraient annuler 'autorité de |'utilisateur a utiliser
cet équipement.

B.5 Ordinary location certification for
FM approvals

As standard, the transmitter has been examined and tested to
determine that the design meets basic electrical, mechanical, and
fire protection requirements by FM Approvals, a nationally
recognized testing laboratory (NRTL) as accredited by the Federal
Occupational Safety and Health Administration (OSHA).

B.6 Hazardous locations certificates
B.6.1 U.S.A.

I5 U.S.Alntrinsically Safe
Certificate: FM17US0014X

Standards: FM Class 3600 - 2011, FM Class 3610 — 2015, FM
Class 3810 - 2005, NEMA® 250 - 2003, ANSI/ISA
60079-0:2013, ANSI/UL 60079-11:2014,
ANSI/ISA 60529:2004, ANSI/ISA61010-1:2004

Markings: ISCLI,DIV1,GPA,B, C,D:
ISCLIZone 0, AExia lIC T4 Ga;
T4Ta=-55t0+70°C
Type 4X; IP66; IP67
WHEN INSTALLED PER ROSEMOUNT DRAWING
03308-1010 (See Figure B-1 on page 151)

Special Conditions of Certification:

1. The Model 3308 transmitter housing contains aluminum;
protect the enclosure to avoid a potential risk of ignition due
to impact or friction.

2. The surface resistivity of the polymeric antenna is greater

than 1GQ. To avoid electrostatic charge buildup, it must not
be rubbed or cleaned with solvents or a dry cloth.

3. For use only with the Emerson Process Management Model
701PBKKF SmartPower™ Option or the Computational
Systems, Inc Model MHM-89004 battery module.

4. Only the Emerson Process Management 375 or 475 Field
Communicator is approved for use with this transmitter.

Product Certifications
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5.

The maximum permitted operating temperature of the
Rosemount™ 3308A transmitter is 70 °C. To avoid the effects
of process temperature and other thermal effects care shall
be taken to ensure that the “Electronics Temperature” does
not exceed 70 °C.

B.6.2 Canada

16

Canada Intrinsically Safe

Certificate: FM17CA0007X

Standards: CSA Std. C22.2 No. 61010-1:2004, CSA Std. 22.2
No. 94-M91, CAN/CSA-C22.2 NO. 60079-0:15,
CAN/CSA-C22.2 NO. 60079-11:14, C22.2 No.
60529:2016

INTRINSICALLY SAFE Ex ia
CLASSI,GPA,B,C,D;

CLASS |, Zone 0, Exia IC T4 Ga;

TEMP CODE T4 (-55 °C <Ta< +70 °C)

Type 4X; IP66; IP67

WHEN INSTALLED PER ROSEMOUNT DRAWING
03308-1010. (See Figure B-1 on page 151)

Markings:

Special Conditions of Certification:

1.

The Model 3308 transmitter housing contains aluminum;
protect the enclosure to avoid a potential risk of ignition due
to impact or friction.

The surface resistivity of the polymeric antenna is greater
than 1GQ. To avoid electrostatic charge buildup, it must not
be rubbed or cleaned with solvents or a dry cloth.

For use with the Emerson Process Management 701PBKKF
SmartPower Option or the Computational Systems, Inc
Model MHM-89004 battery module only.

Only the Emerson Process Management 375 or 475 Field
Communicator is approved for use with this transmitter.

The maximum permitted operating temperature of the
Rosemount 3308A transmitter is 70 °C. To avoid the effects
of process temperature and other thermal effects care shall
be taken to ensure that the “Electronics Temperature” does
not exceed 70 °C.

B.6.3 Europe

n

ATEX Intrinsic Safe
Certificate: FM 12ATEX0072X

Standards: EN 60079-0:2012+A11:2013, EN
60079-11:2012; EN 60529:1991+A2:2013

Markings: @ Category Il 1 G, ExiallCT4 Ga
(-55°C<Ta<+70°C);

c€1180
C € 2460

Special Conditions of Certification:

1.

The Model 3308 transmitter housing contains aluminum;
protect the enclosure to avoid a potential risk of ignition due
to impact or friction.

Product Certifications

. The surface resistivity of the polymeric antenna is greater

than 1GQ. To avoid electrostatic charge buildup, it must not
be rubbed or cleaned with solvents or a dry cloth.

. For use only with the ATEX certified (Baseefal1ATEX0042X)

Emerson Process Management Model 701PBKKF
SmartPower Option or the ATEX certified (SIRA
15ATEX2332X) Computational Systems, Inc Model
MHM-89004 battery Module.

. Only an ATEX certified (BVSO3ATEXE347, BVSO9ATEXE023)

Emerson Process Management 375 or 475 Field
Communicator is approved for use with this transmitter.

. The maximum permitted operating temperature of the

Rosemount 3308A transmitter is 70 °C. To avoid the effects
of process temperature and other thermal effects care shall
be taken to ensure that the “Electronics Temperature” does
not exceed 70 °C.

B.6.4 International

17

IECEX Intrinsic Safety

Certificate: IECEX FMG 12.0029X

Standards: IEC 60079-0: 2011, IEC 60079-11:2011
Markings: ExiallC T4 Ga (-55°C<Ta<+70 °C)

Special Conditions of Certification:

1.

The Model 3308 transmitter housing contains aluminum;
protect the enclosure to avoid a potential risk of ignition due
to impact or friction.

. The surface resistivity of the polymeric antenna is greater

than 1GQ. To avoid electrostatic charge buildup, it must not
be rubbed or cleaned with solvents or a dry cloth.

. For use with only the an IECEx certified (IECEx FMG

12.0029X) Emerson Process Management Model 701PBKKF
SmartPower Option or the IECEx certified (IECEx CSA
15.0045X) Computational Systems, Inc Model MHM-89004
battery pack.

. Only the Emerson Process Management 375 or 475 Field

Communicator is approved for use with this transmitter.

. The maximum permitted operating temperature of the

Rosemount 3308A transmitter is 70 °C. To avoid the effects
of process temperature and other thermal effects care shall
be taken to ensure that the “Electronics Temperature” does
not exceed 70 °C.

B.6.5 Brazil

12

INMETRO Intrinsic Safety
Certificate: UL-BR 13.0463X

Standards: ABNT NBR IEC 60079-0:2008 + Errata 1:2011,
ABNT NBR IEC 60079-11:2009, ABNT NBR IEC
60079-26:2008

Markings: ExiallC T4 Ga (-55 °C <Tymp< +70 °C)
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Special Conditions of Certification:

1. The Model 3308 transmitter housing contains aluminium;
protect the enclosure to avoid a potential risk of ignition due
to impact or friction.

2. The surface resistivity of the polymeric antenna is greater
than 1GQ. To avoid electrostatic charge buildup, it must not
be rubbed or cleaned with solvents or a dry cloth.

3. For use with the Emerson Process Management 701PB
SmartPower Option only.

4. Only the Emerson Process Management 375 or 475 Field
Communicator is approved for use with this transmitter.

5. The maximum permitted operating temperature of the
Rosemount 3308A transmitter is 70 °C. To avoid the effects
of process temperature and other thermal effects care shall
be taken to ensure that the “Electronics Temperature” does
not exceed 70 °C.

B.6.6 China
13 NEPSIIntrinsic Safety

Certificate: GY]13.1443X

Standards: GB 3836.1-2010, GB 3836.4-2010,
GB 3836.20-2010

Markings: ExiallCT4 Ga(-55°C~+70°C)
Special Conditions of Certification:
See certificate for details.
B.6.7 Japan
14 TIIS Intrinsic Safety

Certificate: TC20746
Markings: ExiallCT4-20°C ~+60 °C

Special Conditions of Certification:
See certificate for details.

B.6.8 EAC - Belarus, Kazakhstan, Russia

IM  Technical Regulations Customs Union (EAC) Intrinsic Safety
Certificate:RU C-US.Gb05.B.00530
Markings: OExia llCT4 Ga X (-55°C<Ta<+70°C)

Special Conditions of Certification:

See certificate for details.

150

B.6.9 Taiwan
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Combinations

KD ATEX and Canadian Intrinsic Safety
KE FM and Canadian Intrinsically Safe
KF  ATEX and FM Intrinsic Safety
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B.7 Other certifications

U1  Overfill protection
Certificate: Z-65.16-536

TUV-tested and approved by DIBt for overfill protection
according to the German WHG regulations

B.8 Approval drawings

This section contains Factory Mutual installation drawings. The
installation guidelines must be followed to maintain certified
ratings for installed transmitters.

This section contains the following drawings:

m Rosemount drawing 03308-1010:
Installation Drawing 3308 FM Intrinsic Safety
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Figure B-1. Installation Drawing 3308 FM & CSA Intrinsic Safety
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Appendix C  High Gain Remote Antenna Option

Sl Y MBS AGES . . vttt ettt e e e e page 153

Functional and physical specifications ..ot page 154

Review installation considerations ......... ...t e page 154

Transient/lightning considerations . ...t e page 155

Install the high gainremote antenna ..ottt et page 156
C.1 Safety messages

Procedures and instructions in this section may require special precautions to ensure the safety of the
personnel performing the operations. Information that raises potential safety issues is indicated by a

warning symbol (A). Refer to the following safety messages before performing an operation preceded
by this symbol.

= The remote antenna option must be professionally installed using the instructions provided in this
section. Failure to follow these installation instructions could invalidate the spectrum regulations
and subject the end user to corrective action.

= When installing remote mount antennas for the wireless field device, always use established safety
procedures to avoid falling or contact with high-power electrical lines.

= Install remote antenna components for the wireless field device in compliance with local and national
electrical codes and use best practices for lightning protection.

m Before installing consult with the local area electrical inspector, electrical officer, and work area
supervisor.

= The wireless field device remote antenna option is specifically engineered to provide installation
flexibility while optimizing wireless performance and local spectrum approvals.

= To maintain wireless performance and avoid non-compliance with spectrum regulations, do not
change the length of cable or the antenna type.

= [f the supplied remote mount antenna kit is not installed per these instructions, Emerson™ is not
responsible for wireless performance or non-compliance with spectrum requlations.

m Be aware of overhead electrical power lines.
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C.2 Functional and physical specifications
C.2.1 General
= Weight: 1.01b (0.4 kqg)
= Ratings: NEMA® 4X, and IP66/67
= Vibration: 3g Max vibration
C.2.2 Wireless
= Output: WirelessHART® 2.4 GHz
= Communication range: 2/3 mile (3,300 feet) (1.0 km) with L.O.S.
» Radio frequency power output from High Gain, Remote (WN option) antenna: Maximum of 40mW
(16dBm) EIRP
C.2.3 Coaxial cable
m Coaxial length: 25 feet (7.6 meters) with Type N Connections
m Coaxial material: Heavy duty, low loss LMR400 cable
= Minimum coaxial bend diameter: 1.0 ft. (0.3 meter)
C.2.4 RF Lightning Arrestor
= Type: In-line lightning arrestor
m Electrical connection: Lightning arrestor must be grounded per local electrical codes and regulations.
C.2.5 Mounting bracket
= Horizontal or vertical mast accommodation
m Supported mast diameter: 1.0-2.5 inch (2.5-6.4 cm)
= Aluminum bracket
= Nickel/Zinc plated mounting U-bolts
C.2.6 Antenna
= Remote mount Omni directional Antenna
m Fiberglass & Aluminum construction
= 8 Db Gain
m Meets MIL-STD-810G (Method 510.5, Procedure I and 1)
C3 Review installation considerations
C.3.1 Antenna mounting
Mount antenna vertically (+5°)
C.3.2 Antenna height
Mount antenna 14 feet (4.3 meters) above infrastructure with clear line of sight.
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C.3.3

C.3.4

C.3.5

Cc4
C.4.1

C.4.2

Affix coaxial cable

Ensure that coaxial cable is securely affixed to the mast to avoid excessive cable movement.

Install coaxial drip loop

Ensure a drip loop is installed not closer than 1 foot (0.3 meters) from the transmitter. It may also be
convenient to affix the drip loop to the lower portion of the mast ensuring that condensation or
rainwater will flow away from the coaxial connections.

Figure C-1. Coaxial Drip Loop

Apply coaxial sealant moisture protection

Utilize the coaxial sealant that is included in the high gain remote mounting kit package. Follow included
instructions for application on the coaxial connection.

Transient[lightning considerations

Gateway transient protection

When installing, consider including transient | lightning protection (not provided) on interface
connections (Ethernet, Modbus®, and Coaxial connections) to other equipment.

RF lightning arrestor ground connection

Ensure grounding connection is made on the RF lightning arrestor ground connection point (see
Figure C-2).

Figure C-2. Ground Connection Point
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C.5 Install the high gain remote antenna

1. Mount the transmitter following best practice mounting procedures as outlined in Section 3:
Installation.

2. Connect the RF lightning arrestor to the device and tighten.

4. Fasten the mounting bracket on the mast. Tighten the nuts loosely first to allow adjustment of the
mounting bracket position in Step 5.

(D)
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5. Unwind the coaxial cable and connect the cable to both the antenna and the lightning arrestor
connected to the transmitter, leaving one loop minimum for a drip loop. Ensure the drip loop is lower
than the device, allowing water to flow away from the device.

==}

6. Apply the coaxial sealant around each of the coaxial connections and at the RF lightning arrestor,
making sure the RF connections are completely sealed.

7. Tighten the mounting bracket to the mast. Make sure that antenna is pointed in a vertical direction.

8. Ensure the mounting mast and lightning arrestor are grounded according to local/national electrical
code (see Figure C-2).
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AppendixD  Configuration Parameters
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D.1 Safety messages

Procedures and instructions in this section may require special precautions to ensure the safety of the
personnel performing the operations. Information that raises potential safety issues is indicated by a

warning symbol (A). Refer to the following safety messages before performing an operation preceded
by this symbol.

Failure to follow safe installation and servicing guidelines could result in death or serious injury.

= Use the equipment only as specified in this manual. Failure to do so may impair the protection
provided by the equipment.

Explosions could result in death or serious injury.

= Verify that the operating environment of the gauge is consistent with the appropriate hazardous
locations certifications.

= Installation of device in an explosive environment must be in accordance with appropriate local,
national and international standards, codes, and practices.

= Ensure device is installed in accordance with intrinsically safe or non-incendive field practices.

Electrical shock can result in death or serious injury.
= Ground device on non-metallic tanks (e.g. fiberglass tanks) to prevent electrostatic charge build-up.
= Care must be taken during transportation of power module to prevent electrostatic charge build-up.

m Device must be installed to ensure a minimum antenna separation distance of 8 in. (20 cm) from all
persons.

Process leaks could result in death or serious injury.
= Handle the transmitter carefully.

m [f the process seal is damaged, gas could escape from the tank when removing the transmitter head
from the probe.

= Only qualified personnel should install the equipment.
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Menu overview of the Device Descriptor (DD)

The menu tree in Figure D-1 is applicable for both the DD in AMS Wireless Configurator and the Field
Communicator.

Figure D-1. Menu Tree

Overview ‘ Device Status ‘
‘ Communication Status ‘
‘ Primary Purpose Variables ‘
‘ Update Rate ‘
‘ Join Network ‘
‘ Device Information ‘
Configure Guided Setup Initial Setup Basic Setup
Verify Level
Wireless Setup Join Device to Network
Configure Update Rate
Optional Setup Volume Setup
Display Setup
Echo Tuning
Check Level Response
Manual Setup Device Setup Wireless
Device Display
Units
HART
Security

Device Information

Power

Level Setup

Probe

Geometry

Environment

Volume

Alert Setup

‘ Signal Quality Alert

‘ High Level Alerts

‘ Low Level Alerts

‘ User Defined Alert

‘ Lost Measurement

Service Tools

Alerts

Variables

‘ Mapped Variables

‘ Process

‘ Device

‘ Signal Quality

Trends

‘ Level

‘ Distance

‘ Total Volume

‘ Signal Quality

‘ Data History

Communications

Maintenance

Routine Maintenance

Measurement History

Locate Device

Install New Power Module

Verification
Reset/Restore Restart Measurement
Restart Device
Restore Default Settings
Echo Tuning ‘ Thresholds ‘
‘ Near Zone ‘
‘ Echo Curve ‘
‘ Advanced ‘
Simulate ‘
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D.3 Configuration parameters

This section presents a brief introduction to all configuration parameters.

The Rosemount™ 3308 Series Transmitter can be configured for level, volume, interface level, interface
distance measurements, and interface thickness.

The Rosemount 3308 Series Transmitter can be pre-configured according to the ordering specifications
in the Configuration Data Sheet.

D.3.1 Guided setup

Basic setup

The basic transmitter configuration includes setting the tank geometry parameters. For interface
measurements the dielectric constant of the top liquid must also be given. For some applications with
heavy vapor, the Vapor Dielectric Constant must be given as well.

Figure D-2. Tank Geometry

__________________________ C
E
A-rcmm e
B _______
_______________________________________ _ . F
A. Product Level D. Probe Length
B. Interface Level E. Tank Height
C. Upper Reference Point F.  Zero Reference Point

The Upper Reference Point is located at the underside of the threaded adapter, transmitter flange, or Tri
Clamp, as illustrated in, as illustrated in Figure D-3 on page 162.
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Figure D-3. Upper Reference Point
NPT BSPP(G) Flange TriClamp
-A
B
A. Upper Reference Point
B. Probe Length
Probe type
The transmitter is designed to optimize measurement performance for each probe type. The transmitter
automatically makes an initial calibration based on the type of probe that is used. (This parameter is
pre-configured at factory and only needs to be set if the probe is changed to another type, or if you have
installed a spare transmitter)
Select the type of probe that is mounted to the transmitter. Select User Defined probe if your probe can
not be found in the list or if you have done modifications to a standard probe.
Probe length
The probe length is the distance between the Upper Reference Point and the end of the probe, see Figure
D-3 on page 162. If a weight is used at the end of the probe it shall be included.
This parameter is pre-configured at factory. The probe length must be changed if the probe is shortened,
or if you have ordered a spare transmitter head.
Tank height
The Tank Height is the distance from the Upper Reference Point to the bottom of the tank (Zero
Reference Point). See Figure D-2 on page 161.
The transmitter measures the distance to the product surface and subtracts this value from the Tank
Height to determine the level.
When setting the Tank Height, keep in mind that this value is used for all level measurements performed
by the Rosemount 3308 Series Transmitter. The Tank Height must be set in linear (level) units, such as
feet or meters, regardless of primary variable assignment.
Mounting type
Select option best describing how device is mounted on the tank.
Inner diameter, pipe/chamber[nozzle
Select the inner diameter for the pipe, chamber or nozzle in which the probe is mounted.
162 Configuration Parameters



Reference Manual Configuration Parameters
00809-0100-4308, Rev CB January 2018

Nozzle height

The distance between the Upper Reference Point (normally the lower side of the device flange) and the
end of the nozzle. Note that nozzle may extend into the tank (which should be included in the height).

Measurement mode

Select the Measurement Mode to use in the device. Some modes require software options to be enabled
in the device. You can upgrade the device to enable more software options.

Interface Level with Submerged Probe is used for applications where the probe is fully immersed in liquid. In
this mode the transmitterignores the upper product level. See “Interface measurements with fully
submerged probes” on page 105 for more information.

Note
Only use Interface Level with Submerged Probe for applications where interface is measured for a fully
immersed probe.

Upper product media
Approximate DC value selected from list based on tank content.
Upper product dielectric constant

Enter the Upper Product Dielectric Constant (DC) as accurately as possible. This value is used for setting
the automatically calculated amplitude thresholds. In addition the dielectric constant of the upper
product is essential for calculating the interface level and the upper product thickness. The default value
for the Upper Product Dielectric Constant is 2.

For level measurements, the Upper Product Dielectric Constant parameter corresponds to the dielectric
constant of the product in the tank.

If the dielectric constant of the lower product is significantly smaller than the dielectric constant of
water, you may need to make special adjustments. The dielectric constant of water is 80. See section
“Example 2: Interface peak not found” on page 97 for further information.

In case the dielectric constant is unknown, then use the Dielectric Constant Guide embedded in the AMS
Wireless Configurator as help when configuring the DC.

The AMS Wireless Configurator includes a Dielectric Chart which lists the dielectric constants of a range
of products. AMS Wireless Configurator also includes a tool which allows you to calculate dielectric
constants based on measurements of the Upper Product Thickness.

1. Select Configure > Manual Setup > Level Setup > Environment.
2. Select Dielectric Constant Guide and follow the on-screen instructions.
Maximum product level rate

Fastest rate that may occur in the monitored process to (partially) fill or empty this tank. Will be used to
calculate the maximum level change between updates. Note that product level rate may be higher
during upset conditions.

Note

If the tank is filling or emptying at a high rate, set a faster Update Rate to make sure there is enough
safety margin in the system for High/Low Alerts.

Run Check Level Response to make sure that configured Update Rate is sufficient for the application,
refer to section “Optional setup” on page 73.
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Tank material
Select material of construction of the tank.
Typical interface condition

The typical interface condition in the tank. Select one of the following conditions:
Table D-1. Typical Interface Conditions

Option Description

Unknown or Other condition The typical interface condition is unknown, or varies in such a way that no
typical interface condition can be stated.

Layer on top (thin) The interface thickness is typically thin compared to the bottom layer. The
tank mostly contains the bottom product.

Layer at the bottom (thin) The interface thickness is typically thick compared to the bottom layer. The
tank mostly contains the upper product.

Manual setup - Device

Wireless network
Network ID

Identification number that tells the device which network it belongs to. Obtained from the network
administrator.

Join key

A kind of password that the device uses to join the network. Obtained from the network administrator.
All sections must contain the same number of characters.

Broadcast information

Message content

Which content (HART command) to broadcast for a message.
Message variables

Which variables that are included in the content.

Trigger mode

How message will be triggered.

Trigger level

At which level message will be triggered.

First and trigger variable

The 1st variable contained within message which also will be used to trigger a broadcast.
Triggered update rate

This defines how often the broadcast message is sent to the gateway after a user defined trigger level
threshold has been crossed. Faster update rates have an impact on the total communications traffic on
the network, and power module life.
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Default update rate

This defines how often the broadcast message is sent to the gateway. Faster update rates have an impact
on the total communications traffic on the network, and power module life.

Device display
Display mode

The display can be configured to different display modes: Disabled, On Demand, or Periodic.
Table D-2. Display Modes

Option Description
Disabled The display is always turned off.
On Demand The display is by default turned off. Selected variable screens will only appearin the end of the

diagnostic button screen sequence, refer to “Diagnostic button screen sequence” on page 78.

Periodic The display shows selected variable screens in a periodic sequence. A new screen will appear
on each wireless update.

Display variables

As default, the level variable will be displayed. If more than one variable is configured, the display will
toggle between the values of the chosen variables.

Units

The units for length, volume, and temperature are selectable. After appropriate units have been
selected, all configuration parameters and transmitter variables will be expressed in these units.

Length unit

Used unit for Level and Interface Level values.

Volume unit

Used unit for Volume values.

Temperature unit

Used unit for Electronics Temperature value.

HART - Variable mapping

Primary variable

Primary dynamic variable in the HART protocol which will be assigned as a variable from the device.
Secondary variable

Second dynamic variable in the HART protocol which will be assigned as a variable from the device.
Third variable

Third (Tertiary) dynamic variable in the HART protocol which will be assigned as a variable from the
device.

Fourth variable

Fourth (Quaternary) dynamic variable in the HART protocol which will be assigned as a variable from the
device.
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HART - Percent of range
Upper range value
Value for Primary Variable (PV) corresponding to 100% range.
Lower range value
Value for Primary Variable (PV) corresponding to 0% range.
Upper sensor limit
The upper boundary for the range over which the sensor works properly.
Lower sensor limit
The lower boundary for the range over which the sensor works properly.
HART - Data collection
Measurement and status log
Alternatives for data collection in the device.
HART - Variable history
Configure data history
Data History is a series of 12 data points stored in the transmitter. To enable Data History trending select
either to enable single data point trending (recommended) or enable filtered trending.
If Data History is enabled, select which Device Variable to store, and then type the time between each
sample into the Sample Interval box (4 to 7200 seconds).
Security
Write protection
The device configuration can be write protected.
Over the air upgrade
Wireless upgrade of radio software is possible.
HART lock status
The state of HART write lock in the device.
Device information
Tag
Identifier for the device (max 8 characters) used by host systems. It is recommended to enter both a
short and a long tag (they may be the same).
Long tag
Identifier for the device (max 32 characters) used by host systems. It is recommended to enter both a
short and a long tag (they may be the same).
Descriptor
User's own description. Not required for operation of the device and can be left out if desired.
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Message

User's own information. Not required for operation of the device and can be left out if desired.

Date

User's own information. Manufacturing date by default. Not required for operation of the device and can

be left out if desired.
Power

Performance mode

There are two performance modes: Standard and High Performance.(")

Table D-3. Performance Modes

Option

Description

Standard

The standard performance mode is suitable for most applications, and gives a long
battery life.

High performance

The high performance mode is selectable only for transmitters with profile code U. Each
update is based on an increased number of measurements (radar sweeps), which gives
improved accuracy and robustness, as well as decreased noise in the output value.

This mode also improves performance in difficult applications (e.g. foam, turbulent
surface, low dielectric constant) but reduces battery life.

Power mode

Configures the device to take periodic measurements to conserve battery life, or to take continuous

measurements.

Note

Always On mode is only recommended for devices connected to line power.

Power source

Optimizes the device to make use of the power source to which it is attached.

1. Inearlier versions, the performance modes are called High (Short battery life) and Normal (Long battery life).
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D.3.3 Manual setup - Level
Probe
Weight type
Type of weight at the end of the probe. Only applicable to the flexible single lead probe type.
Table D-4. Weight Types
Type Option code | Description
Unknown Default
Small W1
5.5in (140 mm)
0.9in (22 mm)
Short w2 g1 t2in (50 mm)
(5_1>.5 in (38 mm)
Heavy W3 -
5.5in (140 mm)
©1.5in(38mm)
Chuck (anchored) w4
Upper null zone
Defines how close to the device's Upper Reference Point a level value is accepted. You can extend Upper
Null Zone to block out disturbing echoes close to the tank top. View the Echo Curve to find out if there
are disturbing echoes close to the tank top.
This parameter should only be changed if there are measurement problems in the upper part of the tank.
Such problems may occur if there are disturbing objects close to the probe. By setting the Upper Null
Zone, the measuring range is reduced. See “Changing the upper null zone” on page 103 for further
information.
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Note
Measurements are not performed within the Upper Null Zone. and level alerts located in the Upper Null
Zone will not be triggered. Always configure your level alerts below the Upper Null Zone.

For narrow nozzles it may be necessary to increase the Upper Null Zone (UNZ) in order to reduce the
measuring range in the upper part of the tank.

Figure D-4. Upper Null Zone

A. UNZ
B. Nozzle height

By setting the UNZ equal to the nozzle height, the impact on the measurement due to interfering echoes
from the nozzle will be reduced.

See also section “Handling disturbances at the top of the tank” on page 102. Amplitude Threshold
adjustments may also be needed in this case.

Probe angle (only applicable to rigid probes)

Defines the angle compared to the plumb line at which the device with probe is mounted (0 means that
probe is mounted vertically).

Enter the angle between the probe and the vertical line. Do not change this value if the transmitter is
mounted with the probe along the vertical line (which is normally the case).
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Figure D-5. Probe Angle (a)

Remote housing

If the transmitter head is mounted apart from the probe, the length of cable between probe and remote
housing must be configured.

User defined probe settings

Parameters for user defined probe.

Note
These settings should only be modified for customized probes. The settings are typically provided by
factory.

Geometry

Calibration offset

Difference between surface distance measured by device and the same distance measured by e.g.
handgauging with a measurement tape. A positive Calibration Offset value will increase the presented
Level value.

Show level below probe end as zero

When this setting is selected and the product surface is at or below the probe end, the level
measurement output will be zero.

Note
Only applicable for negative probe end peak.
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Environment

Vapor dielectric constant
Enter the dielectric constant (DC) for the vapor gas in the tank. For normal air the vapor DCis close to 1.

In some applications there is heavy vapor above the product surface having a significant influence on the
level measurement. In such cases the vapor dielectric can be entered to compensate for this effect.

The default value is equal to 1 which corresponds to the dielectric constant of air. Normally this value
does not need to be changed since the effect on measurement performance is very small for most
vapors.

Max upper product thickness

Configure the maximum possible thickness for the upper product in this tank. This is the maximum
thickness the device will expect for this tank.

Volume

Calculation method

Select method for volume calculation based on tank shape or a strapping table. Strapping table requires
entering level-volume pairs in a table.

Diameter (L1)
The diameter of the tank.
Length (L2)

The length (or height if the tank is shaped as a vertical cylinder) of the tank, measured between tank
ends.

Strapping table

Use a strapping table if a standard tank type does not provide sufficient accuracy. Use most of the
strapping points in regions where the tank shape is non-linear. A maximum of 20 points can be added to
the strapping table.

If tank type Strapping Table was chosen, enter how many entries you will use and the actual level and
volume points. The strapping points must be entered such that the first point corresponds to the lowest
level, and the last point corresponds to the topmost level of the tank.
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Figure D-6. Strapping Points

C

A. Actual tank bottom may look like this.
B. Using only three strapping points results in a level-to-volume profile that is more angular than the actual shape.
C. Using six of the points at the bottom of the tank yields a level-to-volume profile that is similar to the actual tank bottom.

Alert setup
Signal quality alert

Signal Quality is the product surface echo amplitude compared to the surface threshold and noise. The
Signal Quality spans from 0 to 10. A low value means that there is a risk for the noise peak to be mistaken
for the product surface peak.

Build up on the probe and different surface conditions are factors that can result in a low Signal Quality
value. By setting an alert, the Signal Quality value can be used to schedule maintenance to clean the
probe.

Note
The Signal Quality depends on probe type and application conditions, as well as the condition of the
probe. Even if the probe is clean, Signal Quality may not be a 10.

Suitable alert limits vary from application to application. Appropriate value can be determined by
logging Signal Quality over time and viewing maximum/minimum values. The Signal Quality Alert limit
should be at least 1, but a better guideline is 2-3.
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Figure D-7. Signal Quality Alert
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Limit
The Signal Quality value that will trigger the alert.
Deadband
An area of the Signal Quality range where no action occurs to prevent alert from activating/deactivating
too quickly.

High[low level alerts

High/Low Level Alerts are triggered when the level goes outside the user defined Limits. There are four
standard Level Alerts. Hi Level Alert and Hi-Hi Level Alert are used for rising levels, and Lo Level Alert and
Lo-Lo Level Alert are used for falling levels. See Figure D-8 and Figure D-9 for more information.

Limit

The level value that will trigger the alert.

Note
Alert Limit values must be outside the Upper Null Zone, the Blind zones, and areas close to the Blind
Zones with reduced accuracy.

Deadband

An area of the Level range where no action occurs to prevent alert from activating/deactivating too
quickly.

Configuration Parameters 173



Configuration Parameters

January 2018

Reference Manual
00809-0100-4308, Rev CB

174

Figure D-8. High Level Alerts for Rising Levels
- Alert ON —_—

— | imit

> B - Deadband
|
|
|

TIME

LEVEL

A. Thealertis active when the level value rises above the alert limit.
B. The alert turns off when the value falls below the deadband.

Figure D-9. Low Level Alerts for Falling Levels
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A. The alertis active when the level value falls below the alert limit.
B. The alert turns off when the value rises above the deadband.

User defined alert

Variable
The variable selected for the alert.

Alert direction

Whether the alert will be triggered above or below the variable's value.

Limit

The variable value that will trigger the alert.

Note

Alert Limit values must be outside the Upper Null Zone, the Blind zones, and areas close to the Blind

Zones with reduced accuracy.

Deadband

An area of a variable's range where no action occurs to prevent alert from activating/deactivating too

quickly.
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Lost measurement

Lost measurement behavior

Configure level value to report if measurement is lost unexpectedly. Choose one of the following actions:
Table D-5. Lost Measurement Behavior Options

Option Description
Alarm (NaN Value/Bad Status) If the measurement is lost, the level value will report:
“Not a Number / Bad Status”.
Output Full Tank If the measurement is lost, the level value will correspond to full tank.
Output Empty Tank If the measurement is lost, the level value will correspond to empty tank.

Number of measurements to hold level

The number of measurements the device will hold the current level if level measurement has been lost.
Then it will output level according to Lost Measurement Behavior, if still lost.

For an application where problems with lost measurement due to noise or weak surface echoes are
experienced, this parameter value could typically be increased.

The Hold Time value presents for how long the device will hold the current level. The time the current
level will be held is calculated out of a combination of both Number of Measurements to Hold Level and
the Update Rate.

Note
Make sure you have enough safety margin in your system to manage a delayed condition.
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D.3.5 Echo Tuning
Thresholds

Figure D-10. Thresholds
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Threshold control

Thresholds can be automatically calculated by device or manually set by user. This setting is valid for all
thresholds on the Thresholds tab (Surface, Interface Reference, and Probe End Thresholds).

Surface threshold

Threshold to filter out noise in the echo curve for detection of the Surface. Noise below the threshold is
suppressed. The first echo peak closest to the device that crosses and is above the Surface Threshold is
the surface echo.

Interface threshold

Threshold to filter out noise in the echo curve for detection of the Interface. The first echo peak after the
surface echo that crosses and is above the Interface Threshold is the interface echo.

Reference threshold

Threshold to filter out noise in the echo curve for detection of the Reference peak. The reference peak is
a strong negative echo very close to the device.

Probe end threshold

Threshold to filter out noise in the echo curve for detection of the Probe End peak. The probe end peak is
afairly strong positive or negative echo (depending on probe type) that is present at the probe end when
tank is empty.
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Near zone threshold

Threshold control
The Near Zone Threshold can be automatically calculated by device or manually set by user.

Threshold

Threshold to filter out noise in a zone near the device. Noise below the threshold is suppressed. This
threshold replaces the Surface threshold in the zone where it is applicable.

Distance

Distance from Upper Reference Point (normally the lower side of device flange) to point where the near
zone threshold ends.

Near zone trimming

Trim near zone
Select to activate trimming.

The Trim Near Zone method is used to fine tune performance in the area close to the tank top. This
function is normally not used. Trim Near Zone is typically used if there are problems related to the nozzle.
For more information see section “Using the trim near zone function” on page 103.

Near zone has been trimmed
Indicates if the Trim Near Zone method has been used for this device.

Advanced

Peak detection method

Select which peak detection to use for level measurements. For further information on when to use the
peak detection method, see section “Resolving thin oil layers” on page 100.

Table D-6. Peak Detection Methods

Option Description

Surface detected at the first amplitude peak closest to device detected above the
Peak Center

Surface Threshold.
Threshold Intersection Surface detected at first intersection with Surface Threshold.

Figure D-11. Peak Detection Method
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Near zone compensation
Improves measurement performance in the zone close to the device by compensating for probe
dependent echo signature or recorded echo signature.
If Near Zone Compensation is disabled, neither the probe dependent compensation nor the
compensation due to Trim Near Zone will be used by the device.
Echo search window
Select window mode to use for the echo tracking function. Value typically provided by manufacturer.
Window size
Window size used by echo tracking function. Window Size can only be changed when the Eco Search
Window mode is set to User Defined. Value typically provided by manufacturer.
Gain factor index
Controls the hardware amplification of the waveform. Value typically provided by manufacturer.
Calibration scale factor
Microwave propagation factor to use. Value typically provided by manufacturer.
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Appendix E

E.1

Alert Message Mapping

Alert messages and descriptions

This appendix outlines the most important alerts in the HART® command 48 Additional Status Field for
the Rosemount™ 3308 Series. The information in this section can to be used by DeltaV™ for alert
monitoring, and in the Emerson™ 1420 Wireless Gateway for Additional Status mapping in Modbus®,
OPC, etc. A complete list of Additional Status bits is available in the Wireless Gateway.

Table E-1 displays the device variable, variable mapping indexes, and default mapping.

Table E-2 to Table E-4 shows a list of the most important alert messages that may be displayed in the
AMS Wireless Configurator and Field Communicator together with the location of the Alert in the HART
command 48 Additional Status field. For recommended actions, refer to “Alert messages in AMS
Wireless Configurator and Field Communicator” on page 86.

To view Active Alerts, select Service Tools > Alerts > Active Alerts.
Table E-1. Device Variables

Index | Device variable Description Default mapping
(user configurable)
Measured supply voltage used to determine the
0 Supply Voltage health of the power module. QV (Quaternary)
1 Electronics Temperature | The current temperature at the electronics. TV (Tertiary)
5 Level The current level measurement value (from the PV (Primary)
zero level reference point to the product surface). y
3 Distance Distance from the upper reference point to the SV (Secondary)
product surface.
4 Total Volume The volume of the product at the current level.
Distance between the upper reference point and
5 Interface Distance the interface between the upper and lower
product.
The current interface level value (from the zero
6 Interface Level ) :
level reference point to the interface).
7 Amplitude Peak 1 Amplitude of the reference peak (see page 4).
3 Amplitude Peak 2 Amplitude of the product surface peak (see '
page 4). Optional
9 Amplitude Peak 3 Amplitude of the interface or probe end peak
(see page 4)
10 Upper Product Thickness | Thickness of the upper product.
. . The quality of product surface echo signal
(M
12 Signal Quality compared to surface threshold and noise.
Margin between product surface echo signal and
13 Surface/Noise Margin(") noise. Zero indicates a low margin and 10 a high
margin.

1. Requires option code DA1 (HART Diagnostics).
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Table E-2. Failure Alerts (F:)
Message Additional status!") | Description
An electronics error that could impact the
Electronics Failure Byte 8::Bit 6 device measurement reading has
occurred.
Radio Failure Bvte 1-Bit 6 The wireless radio has detected a failure
yte 1= or stopped communicating.
. . The supply voltage is too low and will
Supply Voltage Failure Byte 6::Bit 2 affect device operation.
Probe Disconnected Byte 4::Bit 6 The device cannot detect the probe.
The internal temperature of the device
has reached critical levels and the
Electronics Temperature Critical Byte 1::Bit 3 integrity ofthe de\{lce electronics may be
compromised. Environmental
temperature should not exceed device
specifications.
The device has detected a configuration
error. Reasons may be multiple. See Table
Configuration Error Byte 2::Bit 6 6-2 on page 87 for a list of detailed
Configuration Errors that may be
displayed.
1. Location of the Alert in the HART command 48 Additional Status field.
Table E-3. Maintenance Alerts (M:)
Message Additional status!’) | Description
o The supply voltage is low and may affect
Supply Voltage Low Byte 8::Bit 4 Device Operation.
The temperature of the electronics board
Electronics Temperature Out of Limits Byte 1::Bit 2 has exceeded the transmitter’s operating
range.
No valid Level reading. Reasons may be
multiple:
Level Measurement Lost Byte 3::Bit 1 m No valid surface echo peakin the
measuring range.
m Incorrect transmitter configuration.
Sirmulation Active Bvte 8:Bit 0 The device is in simulation mode and is
yre e not reporting actual information.
. . o The Signal Quality is below the defined
Low Signal Quality Byte 5::Bit 0 alert limit.
No valid Interface reading. Reasons may
be multiple:
Interface Measurement Lost Byte 3::Bit 0 m No valid surface echo peakin the
measuring range.
m Incorrect transmitter configuration.
The device has failed to require all of the
Capacity Denied Byte 12::Bit 0 necessary wireless bandwidth to
broadcast at the configured rate(s).
1. Location of the Alert in the HART command 48 Additional Status field.
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Table E-4. Advisory Alerts (A:)
Message Additional status!") | Description

Alert Message Mapping

The device has failed to write to the
database memory at some time in the

Database Memory Warning Byte 0::Bit 2 past. Any data written during this time
may have been lost.

Non-Critical User Data Warning Byte 2::Bit 1 Auser written parameter does not match
expected value.

Volume Range Warning Byte 4::Bit 7 The !evel measurement is outside the
configured volume range.

Verification Mode Active Byte 4::Bit4 The devn:g 1N verlﬂ'catlon mpde andis
not reporting actual information.

. The button on the Electronics Board is

Button Stuck Byte 1::Bit 5 detected as stuck in the active position.

HiHi Level Alert Byte 5::Bit 4 The level is above the defined limit.

Hi Level Alert Byte 5::Bit 5 The level is above the defined limit.

Lo Level Alert Byte 5::Bit 6 The level is below the defined limit.

LoLo Level Alert Byte 5::Bit 7 The level is below the defined limit.

User Defined Alert Byte 5::Bit 3 The variable has surpassed the user

defined limit.

1. Location of the Alert in the HART command 48 Additional Status field.
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